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Chapter 1 

Getting Started 

About this manual 

What you need 

What is DeskMate? 

Installing Quicken from the DeskMate Desktop 

Installing Quicken alone 

Using Quicken and the DeskMate environment 

Exiting Quicken 

About Quicken’s pull-down menus 

Getting help 

This chapter tells you how to start using Quicken, what equipment you 
need, and how to start-and stop-the program. It tells you how to use 
Quicken with a hard disk system and with a floppy disk system. 

In addition, this chapter introduces you to the DeskMate system, and tells 
you how Quicken works with it; it describes Quicken’s help screens, which 
give you valuable information about Quicken’s features, functions, and 
options at the touch of a key or by using the mouse. 

When you’re finished with this chapter, you’ll be ready to set up your first 
account and start writing checks and adding transactions to Quicken’s 
Check Register. 
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Chapter 1. Getting Started 

About this manual 
Quicken is easy to use and we’ve tried to make this manual just as easy to 
follow. Take a moment to look over the organization of the Table of 
Contents. The Appendices list Quicken’s most-asked questions and 
answers-technical information that might get in the way of explaining 
how to operate the program-and a glossary of terms you can refer to as 
you read. 

Three quick rules sum up how to use the instructions in this manual: 

1. 

2. 

Steps that begin with numbers you must follow in order. 

Steps that begin with a bullet ( 0 )  are optional. Perform them, if you 
wish, when you come to them. Bullets also denote lists that have no 
particular order-the list of equipment in the next section, for example. 

The remainder of the text explains major concepts or offers tips on 
getting the most from Quicken. 

3. 

Simple? Let’s get started! 

What you need 
In addition to the Quicken program disks provided, you will need the 
following: 

Tandy 1000 SL with 384K RAM or IBM (PC, XT, AT, PS/2), Tandy, or 
compatible computer with at least 512K RAM and one or more 3 1/2- 
inch or 5 1 /4-inch floppy disk drives or a hard disk. 

Any monitor: black and white graphics, monochrome text, or color. 
(Monochrome monitors require a Hercules or compatible graphics 
card.) 

Any printer except those requiring “thermal” paper. Any dot-matrix, 
fully formed character (daisywheel), or laser printer will work fine. 

DOS 2.0 or later. 

Blank, formatted disks for making a backup copy of Quicken. If you 
are using a floppy system, you will also need blank, formatted disks 
for your accounts. 

Quicken checks (required only for check-printing operations). 
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Chapter 1. Getting Started 

What is DeskMate? 
DeskMate is software from Tandy that uses a graphical user-interface to 
provide a visual, simple, and intuitive way for you to work with your 
computer. The DeskMate software creates a friendly, graphics-oriented 
environment where you can see exactly what your choices are, and pick 
them right from the screen using pull-down menus and on-screen push- 
buttons. It comes with several easy-to-use applications programs that you 
can use to keep records, do word-processing, or play games, all without 
ever leaving the DeskMate environment. Once you learn how to use 
DeskMate, you’ll know how to use any of the DeskMate applications since 
they all use the same DeskMate interface with the same ”look and feel.” 

Quicken and many other top-selling programs are specially designed to 
use this same DeskMate user-interface. If you already have DeskMate, you 
already know how to use Quicken, because Quicken looks and works just 
like DeskMate. If you don’t have DeskMate, we think you’ll agree that the 
DeskMate user-interface is exceptionally easy to learn and use. 

Before you can start using Quicken, you need to install it in order to set 
Quicken to work with your hardware. If you already have DeskMate 
(version 3.0 or higher), follow the instructions in the section “Installing 
Quicken from the DeskMate Desktop.” If you do not have DeskMate, 
follow the instructions in the section ”Installing Quicken Alone.” Either 
way you’ll be up and running fast. 

Installing Quicken from the DeskMate Desktop 
Follow these directions if you already have the DeskMate program from 
Tandy (version 3.0 or higher). These steps work for either floppy disk or 
hard disk users. If you’re using floppy disks, these steps create a working 
copy of Quicken on a floppy; if you’re using a hard disk, these steps install 
Quicken in a directory called \DESK. (You may choose a different direc- 
tory name during the installation process, if you like.) Installing is also 
required to set Quicken to work with your hardware. 

1. Start DeskMate following the instructions in your Tandy DeskMate 
manual. If you’re working with floppy disks, make sure you have at 
least one blank, formatted disk handy. 
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Chapter 1. Getting Started 

2. Insert Quicken Program Disk 1 in drive A. (Note that the 3 1/2-inch 
Quicken disk is both Program Disk 1 and Program Disk 2.) Important: 
If you are a floppy user, make sure the current directory (displayed at 
the top middle of the Desktop screen) is A:\. If it is not, change the 
current directory to A:\ by choosing Change from the Directory 
Menu. Type A:\ in the Path field and press (Enter]. 

3. At the DeskMate Desktop, choose Install from the Desktop Menu. If 
there is room on your Desktop for a Quicken Menu, the Display 
Menu dialog box will appear. To create a Quicken Menu, press the 
on-screen OK pushbutton or press lEnterl on the keyboard. Position 
the window where you want it on the Desktop using , , m, or 

and press m. If you do not want to create a Quicken Menu, 
press the on-screen Cancel pushbutton. 

Note: If you get the message ”Could not find new application on 
floppy disk,” it’s because DeskMate thinks Quicken has already been 
installed. (This can occur even if you only started installing Quicken 
and then abandoned the procedure in the middle.) Before you can 
proceed with installing Quicken, you must delete Quicken from 
DeskMate’s list of installed programs. To do so, follow these steps: 

a. Press the on-screen OK pushbutton at the “Could not find new 
application on floppy d i s k  message dialog box. DeskMate 
returns you to the DeskMate Desktop. 

b. Exit DeskMate, and then restart. When you return to the 
DeskMate Desktop, choose Delete from the Desktop Menu. The 
Delete Menu dialog box appears. 

Click on the list box arrows with the mouse, or use and to 
highlight Quicken. When Quicken is highlighted, press ml to 
delete it. 

c. 

4. Follow the instructions that appear on the screen for creating a 
working copy of Quicken. 

If you’re a hard disk user, the Install program asks if you want the 
Billminder program installed on your hard disk. Billminder is a simple 
program that compares today’s date as set in your computer with the 
date of any checks in your account. Every time you turn on your 
computer, Billminder will remind you if you have any checks 
scheduled to be printed. 

If you’re a floppy disk user, Install will ask you for a blank disk which 
it will use to create a working copy of Quicken. After Install is com- 
plete, leave that working disk in drive A. 
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5. To run Quicken, at the DeskMate Desktop choose Run from the File 
Menu. Type Q in the Program Name field, then press m) or push 
the on-screen OK pushbutton by clicking on it with the mouse. In a 
few moments the Quicken New User message will display, which tells 
you how to set up a new account. 

Installing Quicken alone 
Follow these directions if you do not have the DeskMate program from 
Tandy. These steps work for either floppy disk or hard disk users. If 
you’re using floppy disks, these steps create a working copy of Quicken on 
one or two floppies (depending on the capacity of your diskettes); if you’re 
using a hard disk, these steps install Quicken in a directory called \DESK. 
(You may choose a different directory name during the installation proc- 
ess, if you like.) Installing is also required to set Quicken to work with 
your hardware. 

1. Insert Quicken Program Disk 2 into drive A. (Note that the 3 1 /2-inch 
Quicken disk is both Program Disk 1 and Program Disk 2.) If you’re 
using floppy disks, have at least two blank, formatted disks handy. 

2. At the DOS A> prompt, type INSTALL and press lw. 
3. Follow the instructions that appear on the screen to copy Quicken onto 

your hard disk or to create a working copy of Quicken on floppies. If 
you’re installing Quicken onto floppy disks, the program tells you how 
many formatted floppies it requires for the working copy, and tells you 
how to label them. 

If you’re a hard disk user, the Install program asks if you want the 
Billminder program installed on your hard disk. Billminder is a simple 
program that compares today’s date as set in your computer with the 
date of any checks in your account. Every time you turn on your 
computer, Billminder reminds you if you have any checks scheduled 
to be printed. 

To run Quicken that has been installed onto floppy disks, insert 
Working Disk 1 (if using 3 1 /2-inch disks or high capacity 5 1 /4-inch 
disks, there is only one working disk) into drive A. At the DOS A> 
prompt, type Q and press FJ. In a few moments, the Quicken 
New User message will appear, telling you how to set up a new 
account. 

To run Quicken that has been installed onto a hard disk, simply type Q at 
the DOS prompt (usually C>) and press m. In a few moments, the 
Quicken New User message will appear, telling you how to set up a new 
account. 

4. 

5. 
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Additional hard disk information 
When Quicken installs itself onto your hard disk, it creates a subdirectory 
called \DESK and copies all its files there. Quicken also keeps your 
records in this directory. For more hard disk information, see Appendix 
C, Technical Information. 

You can keep your records in a different directory from the Quicken 
program’s directory or even keep your records on floppy disks, if you 
prefer. To change where Quicken looks for your bank account records, see 
Chapter 13, Account Activities. 

Using Quicken and the DeskMate environment 
Take a few moments here to familiarize yourself with some concepts and 
terms that we’ll be using throughout this manual. 

Key mouse terms 
If you’re going to use a mouse, you should understand these four terms. 

Click: Quickly press and release the left mouse button. 

Double-Click: Click the left mouse button twice in rapid succession. 
If you double-click and nothing happens, you may be clicking too 
slowly, causing Quicken to interpret it as two single clicks. 

Point: Move the mouse to position the pointer on the screen. 

Drag: Hold down the left mouse button while moving the mouse. 
There are two mouse buttons on a Tandy mouse (others may have 
three buttons). The button farthest to the left is always the one to use. 

Key Quicken operations and terms 
All parts of the Quicken program have the same look and feel. For ex- 
ample, wherever Quicken presents you with a set of on-screen buttons, 
you can “press” one by pointing to it and clicking with the mouse, or by 
using to move the cursor to the button you want and by pressing 
-1 or JEnterJ to “press“ it. 

Throughout this manual, you’ll see phrases similar to ”press the on-screen 
OK pushbutton.” In this case, if you’re using a mouse, point to the OK 
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button and click; if you’re using the keyboard, press lTabl to move the 
cursor to the on-screen button and press lSpacebar1 or 1-1. These two 
actions have identical results. Figure 1-1 illustrates some of Quicken’s 
buttons. 

Fields (where typing 
cursor appears to show 
you where to type). 

Buttons. 

On-screen 
push buttons. 

Mouse pointer. 

Ending Balance: $2,467,76 

Figure 1-1. Quicken’s on-screen pushbuttons. 

Whether you’re using a keyboard or mouse, here is a list of general 
Quicken operations you’ll need to know. 

Select: Select means to indicate something on the screen to Quicken. 
For example, you can select a filename from a list. With the mouse, 
you point and click to select. With the keyboard, you press m, m, m, , or until Quicken has highlighted or underlined the object 
you want to select. 

Pull down a menu: Quicken’s menus are listed in boxes across the top 
of the screen. Select a menu name. Press the left mouse button and 
hold it down. 

If you don’t have a mouse, use the keyboard by pressing the corre- 
sponding function key (F2 through F10). Quicken extends the menu 
you have selected (you have ”pulled it down”). To close the menu 
without choosing a menu command, press m. 
Choose a menu command: Pull down the menu and select the com- 
mand you want to use. With the mouse, drag the pointer along the 
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extended menu until you come to the command you want (the com- 
mands in the menu highlight as the mouse pointer moves across 
them). Then release the mouse button. 

With the keyboard, use and to highlight the command you 
want; then press to choose the command. Or you can type the 
first letter or character of the menu command and the highlight will 
move to the first menu command that starts with that letter. Pressing 
the letter again will move through other items that begin with the 
same letter. 

Note: If you pull down the menu using the keyboard, you cannot 
select the commands with the mouse. You must use the keyboard to 
complete or cancel the command. 

Operate a dialog box: A dialog box usually comprises a set of on- 
screen buttons you can push and fields into which you can enter text to 
control various Quicken options. Figure 1-2 illustrates a dialog box. 

Left Margin: 
Checkbox. \ Printed l ine  width: 

Printed l i n e s  per page: 
Total l i n e s  per page: 

0 Pause 
Group of 

buttons. \ 
0 Send control sequence 

Characters per inch: 
Gie a12 ~ 1 6 ~ 7  

-m=m= 
On-screen 
pushbuttons. 

Figure 1-2. Operating a dialog box. 

Press the on-screen OK pushbutton: The on-screen OK pushbutton 
executes a command or makes changes you have indicated by filling in 
a dialog box. OK tells Quicken, “Go ahead and do it.” You can 
”press” the on-screen OK pushbutton by pressing JTabJ until Quicken 
highlights OK, and then pressinp -1 or m, or, if the 
cursor is not on another pushbutton, by pressing m] even without 
highlighting OK. In this case F l  is the equivalent of pressing OK. 
Of course, you can also press the on-screen OK pushbutton by point- 
ing and clicking with the mouse. 
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Press the on-screen Cancel pushbutton: The on-screen Cancel push- 
button halts a command or makes Quicken ignore the changes you 
have made to a dialog box. Cancel tells Quicken, “Stop! I didn’t mean 
it.” You can ”press” the on-screen Cancel pushbutton by pressing 
lTabl until Quicken highlights Cancel and then pressing -1 or m, or by pressing (Escl even without highlighting the pushbutton. 
(Escl is always the equivalent of pressing Cancel. You can also press 
the on-screen Cancel pushbutton by pointing and clicking with the 
mouse. 

Select a button from a group of buttons: Groups of buttons are used 
to select exactly one choice from among several. To select a button in a 
group of buttons, press 
the group you want. Then use m, , m, or 
cursor beneath the specific button within the group you want to push, 
and press m. The button you selected will be visually “de- 
pressed” on the screen, and whichever button was previously selected 
will be unselected or ”raised,” so that you can never have two buttons 
within the same group selected simultaneously. 

You can also push a button by pointing to it and clicking the left 
mouse button. 

until Quicken highlights any button in 
to position the 

Placing a check in a checkbox: You can check or uncheck a checkbox 
by pressing until the cursor underlines the box and then pressing 
[-I. You can also check a checkbox by pointing to it and 
clicking the left mouse button. Pressing or clicking again will uncheck 
it. 

Use the scroll bar: The scroll bar is used to quickly navigate through 
lists of items. The scroll bar always represents the length of the list it 
scrolls. You must use the mouse to operate a scroll bar. 

The little box that moves up and down within the scroll bar (called the 
”elevator”) represents the part of the scroll that currently appears on 
screen. Drag the elevator to change the part of the scroll that Quicken 
displays. Click the arrows at either end of the scroll bar to scroll up or 
down one item at a time. Click the area between the elevator and the 
arrows to move in that direction one page at a time. Figure 1-3 illus- 
trates a scroll bar. 
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I 

Click in gray area above elevator to scroll up one page. Scroll-up arrow (move up list). 
\ / 

Elevator (what is 

Scroll-down arrow 
Imnua A n u r n  l i d \  - 

Scroll bar (total 
length of list). 

, Click in gray area below 
elevator (not shown 
here because elevator 
is at bottom) to scroll 
down one page. 

Figure 1-3. Scroll bar. 

Exiting Quicken 
When you wish to exit Quicken, close any dialog boxes that the program 
may be displaying (you can press the on-screen Cancel pushbutton). . From the File Menu, choose Exit. After confirming that you really 

want to leave Quicken, Quicken returns you to the DeskMate Desktop 
or DOS, whichever you started from. 

Alternatively, to exit Quicken and start a new program, choose Run from 
the File Menu. Quicken will ask you for the name of the new program 
you want to use. 

About Quicken's pull-down menus 
When you first use Quicken, it has no account information to display. 
Chapter 2, Beginning to Use Quicken, shows you how to set up bank ac- 
counts. 

Across the top of the screen are Quicken's menu selections, as shown in 
Figure 1-4. 
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Current Balance: $2,588,80 Ending Balance: $2,467,76 

Figure 1-4. Quicken’s Write Checks Screen and pull-down menus. 

The six pull-down menus are: 

File F2 Account Activities including New, Open, Copy, and Rename; 
Page Setup, Printing, Other Settings, Run and Exit. 

Edit F3: Cut, Copy, Paste, and Clear, and deleting and splitting 
transactions. 

Search F4: Locate specific transactions by date, payee, memo, etc. 

Quick Entry F5: Recall and memorize recurring transactions, set up 
@Categories (transaction categories), create automatic groups of 
regular transactions, and execute them. 

Activities F6  Write checks, work with the Check Register, reconcile 
your account, produce reports, and order supplies. 

Messages F9: Menu where you receive messages from Quicken and 
other DeskMate programs. 

Tandy F10 DeskMate accessories. 

The following chapters describe in detail each of Quicken’s many useful 
functions. 
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Getting help 
is Quicken’s help key. It is found, along with the other function keys, 

at the top or on the left of your keyboard. If you’re ever unsure of what to 
do next, press (F1J for help. Quicken‘s help is “context-sensitive”; what 
you’re doing when you ask for help determines the immediate help that 
Quicken offers. 

Instructions, concise information, or both, appear in a help window that 
overlaps part of the screen. Some help messages are too long to fit in the 
help window. If this is the case, press or [mi as needed to see the 
entire message. 

After you’ve obtained the help you need, press m. Quicken returns you 
to whatever you were doing before you asked for help. If there is no on- 
screen help available for your particular question, consult the index to this 
manual. 
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0 0 Chapter Beginning * to Use 
DCI Quicken 

Setting up a bank account 
~ ~ ~~~~ 

Using Quicken’s pull-down menus 

Important keys on the keyboard 

This chapter shows you how to set up a bank account so that you can start 
using Quicken. It also shows you how to use Quicken’s pull-down menus 
and explains how some important keys on the keyboard work. 

In Quicken, the term ”account” refers to a bank account-hecking, money 
market, or savings (for information on using Quicken for cash and credit 
cards, see Chapter 15, Home Uses of Quicken). When you set up an account, 
Quicken creates space for it on the disk and stores all the account records 
in this space. You can set up as many bank accounts as you want. 
Quicken maintains separate records for all of your bank accounts. 

If you’re a floppy disk user, it’s best to save your account data on a 
separate data disk, not on your Quicken program disk. Be sure to have a 
blank, formatted floppy disk on hand for this purpose before you begin. 

Setting up a bank account 
Setting up a bank account with Quicken is easy. If you are using a floppy 
disk system, format a blank floppy disk for your bank account data before 
starting Quicken. If you don’t know how to format a disk, see your DOS 
manual for instructions. 
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To set up a new bank account: 

1. Choose New from the File Menu. Quicken displays its Set Up Bank 
Account dialog box, as in Figure 2-1. If you are unsure how to do this, 
see “Using Quicken’s pull-down menus” on page 2-3. 

I I Name for this bank account: n 
(8 character DOS filename) 

Opening Balance: I m=mm 

Figure 2-1. Set Up Bank Account dialog box. 

2. Type in a name for the account you are setting up. If you make a 
mistake, press -1 to erase characters to the left of the cursor. 
For more information on ways of using the keyboard and mouse, see 
Chapter 1. 

You can name your account anything you want. You might want to 
use your own name, your bank‘s name, or a descriptive name such as 
CHECK1. If you’re setting up an account just for practice, you could 
name it PRACTICE and then delete it from your records later on. The 
name must follow the rules for a DOS filename (without an extension). 
That is, it can be up to eight characters long and can include letters, 
numbers, and certain other characters (such as a hyphen or a number 
sign). Press 

Press 
ing Balance field with the mouse. 

3. Type in an opening balance, or balance forward, for the account. The 
opening balance is the dollar amount you have in the bank account 
according to your most recent bank statement. If you don’t know the 

(Help) for the complete rules on DOS filenames. 

to move to the Opening Balance field, or click the Open- 
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opening balance of the account, don’t worry. Just type in a zero or 
your best guess. You can change the amount later on in Quicken’s 
Check Register. 

When you have typed in all the account information as you want it, 
press the on-screen OK pushbutton. If you have a mouse, you can 
push the OK pushbutton by clicking on it. If you do not have a mouse, 
you can press the OK pushbutton by pressing lEnter1 or by pressing 

to move the cursor to the OK pushbutton and then pressing the 
space bar. For more information about pressing buttons and using the 
mouse and the keyboard, see Chapter 1. 

After you press the on-screen OK pushbutton, Quicken sets up the 
new account and displays its Check Register. The only transactions in 
the Check Register will be the Opening Balance transaction and a 
blank transaction at the end of the Check Register used for adding new 
transactions. 

4. 

5. 

You probably have some transactions that have not cleared the bank as 
of your most recent statement, you’ll want to add them to Quicken’s 
Check Register. For more information on adding transactions to the 
Check Register, see Chapter 5, Using the Check Register. 

Using Quicken’s pull-down menus 
Once you have set up an account, you’ll be ready to start using Quicken. 
When you use Quicken, you’ll begin at the Check Register. The features, 
functions, and options that you use are listed on ”pull-down menus.” 
Follow the steps below to learn how the pull-down menus work. Make 
sure you have first read Chapter 1 on the differences between working 
with the keyboard and working with a mouse. 

Quicken tip: You’ll notice that ”accelerator keys” appear to the right of 
many menu commands. You can execute those commands without first 
displaying a menu by pressing the appropriate accelerator key. An 
accelerator key is typically a 

the other key indicated. Once you become familiar with Quicken, you’ll 
find that accelerator keys are the quickest way to use many of its features. 

or m key combination. To use a 
or m key combination, hold down or while you press 
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To choose Write Checks from the Activities Menu: 

1. Make sure you have set up at least one bank account. For help, see the 
preceding section, ”Setting up a bank account.” 

From the Activities Menu, choose Write Checks. 

With u mouse, click the menu name and drag down the menu to select 
Write Checks. Then release the mouse button. The Write Checks 
screen appears. 

Without u mouse, you can press 

highlight a choice inside a displayed menu by pressing its initial letter: 

choice with the same initial letter, Quicken selects them top-down. 
After highlighting Write Checks, press lEnterl to choose it. The Write 
Checks screen appears. 

Note: If you pull down a menu using a function key, you must use the 
keyboard to select the command you want, not the mouse. To cancel a 
displayed menu, press m. 
When you display any of Quicken’s pull-down menus by pressing its 
function key, you can see any other menu by pressing 
pressing other function keys. You do not need to first cancel the 
displayed menu. The Activities Menu is displayed in Figure 2-2. 

2. 

to display the menu. Use and 
to highlight a choice inside a displayed menu. You can also 

to highlight Write Checks, for example. If there is more than one 

or H I  or by 

(lccept] 

Current Balance: $2,588,88 Ending Balance: $2,467,76 

Figure 2-2. Activities Menu, extended. 
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3. From the Activities Menu, choose Check Register. The Check Regis- 
ter appears. 

4. Press m+m,  the Write Checks accelerator key combination, to 
return to the Write Checks screen. 

Important keys on the keyboard 
Here is a list of Quicken’s most frequently used keys. You don’t need to 
memorize the list. However, looking it over before you begin will save you 
time and make learning Quicken even easier. 

Description 

The Help key. If you’re ever unsure of what to do, press (Help). 
Instructions or concise information appears in the Help window. Some 
help messages may be too long to fit in the window. In this case, press lm or ml as needed to see the entire message. 

(Escl The Escape key enables you to ”escape from” or cancel whatever you are 
doing and return to the previous activity or screen. This key is the 
equivalent of the Cancel button in dialog boxes that have Cancel buttons. 

Arrow keys. Use arrow keys to highlight menu commands and to move 
the cursor. Each time you press an arrow key, the highlight bar or the 
cursor moves in the direction the arrow points. If a menu choice is not 
currently available (it is grayed out), the highlight bar skips over it. 

The Enter key. Use this key to tell Quicken that it’s okay to continue, as, 
for example, when you select from menus, or when you have finished 
filling out a check that you want to record. 

Use 
lshiftldxl to move the cursor to the previous field or button on the 
screen. 

ImzImEl 

pq 

pJ to move the cursor to the next field or button on the screen. Use 
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Writing Checks 

The Write Checks screen 

Filling out the check 

Correcting mistakes 

Recording the check 
~ 

Reviewing checks you’ve written 

Changing checks you’ve written 

Deleting checks 

More features 

Having Quicken prepare your checks is a great convenience. Few banking 
tasks are more satisfying than receiving a stack of finished checks from 
your printer, ready for your signature. 

Writing checks is just one way in which Quicken automates your finances. 
Later chapters show how Quicken writes checks for you and enters entire 
groups of transactions. 

Writing checks with Quicken is easy because the check-writing screen 
looks just like the paper check you’re used to filling out. This chapter tells 
you how to write checks, how to record checks in the Check Register, and 
how to review the checks you’ve written. When you have finished, you‘ll 
be ready to move on to the next chapter, where you’ll learn how to print 
your Quicken checks. 

Quicken tip: Use Quicken’s Write Checks screen only to write checks that 
you are going to print with Quicken. For other transactions-such as 
checks you have already written by hand, bank fees, deposits, electronic 
transfers, and so on-use the Check Register, described in Chapter 5. 
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The Write Checks screen 
When you're ready to begin, select Write Checks from the Activities 
Menu. The Write Checks screen appears (Figure 3-1). 

The Write Checks screen displays a blank check. This is where you type 
the information for each check you want Quicken to print. The screen 
looks like the illustration below. Before you continue, take a moment to 
study its features. 

Type the payee The date always The name of the bank Type the amount. Quicken 
exactly as you want appears in account you're using. automatically spells out the 
the name to appear monthldaylyear 
on the check. \ for m at. 

\ 
amount on the next line. 

\ I 
Type the payee's 
name and address if 

Press the on-screen Accept pushbutton when the Quicken calculates your new 
check appears as you want it. Quicken records it and 
presents a new blank check for you to fill out. 

Figure 3-1. Write Checks screen. 

ending balance every time you 
record a check. 
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Filling out the check 
Filling out a blank check on the Screen is much like filling out a paper 
check. You start with the date, then type in the name of the payee, the 
amount of the check, and so on. Each time you fill in a field, press m . 
The cursor moves to the next field. You can also move around the check 
by clicking any field with the mouse. 

These are the fields that appear on each check: 

Date: The date appears in month/day/year format. Each time you start 
Quicken, the date starts out as today’s date (your computer’s system date); 
after you‘ve written a check, the date that appears is the date of the last 
check you wrote. You can leave the date as it is or change it. 

If the date is correct: 

Press a to move the cursor to the Pay to the Order of field, or click 
it with the mouse. 

To change the date: 

If you’ve just displayed the Write Checks screen, or tabbed to the date, 
it’s already highlighted. If not, drag the mouse to highlight the charac- 
ters you want to change. As you press your first key, Quicken deletes 
all of the highlighted characters and replaces them with what you type 
in. 

Or 

Use the arrow keys to move the cursor to the right of the first digit you 
want to replace. Use -1 to delete characters and type new 
ones. Quicken always inserts characters, rather than typing over them. 

When you’ve made the change, press or click the next field with 
the mouse. 

Quicken tip: The easiest way to change any date in Quicken is to place the 
cursor in the Date field and press 
one day at a time; moves it backward. Hold down 
watch the days fly by. 

or . moves the date forward 
or and 

Pay to the 
Order of: 

The Payee is the person or business to whom you are writing the 
check. Type in the name of the payee and press (Tabl . The cursor moves to 
the Amount field. Or, you can always click the next field with the mouse. 

Quicken User Manual 3-3 



Chapter 3. Writing Checks 

Amount: Type in the amount in numerals. Quicken ignores any dollar sign or 
commas you may type and places them in the field automatically. When 
the field is first selected, the cursor is at the left of the decimal point. As 
you type the amount, the digits are inserted and pushed to the left. When 
you type a decimal point, the cursor moves to the right of the decimal 
point in the field and then inserts the cents digits. When you leave the 
field, Quicken immediately spells out the amount on the next line. Press 
m to move the cursor to the first line of the Address field. 

Note: The maximum amount for any single transaction is $9,999,999.99. 

Address: You need not type in a name and address unless you want to mail your 
printed checks in Quicken’s window envelopes. To skip the address 
section, press to move the cursor down to the Memo field. 

To type an address: 

Type in the payee’s name, address, city, state, and zip code. The address 
can be up to five lines long. Press to move from one line to the next 
(or click on the line). When the address is complete, press m as many 
times as needed to move the cursor down to the Memo field, or click it 
with the mouse. 

Quicken tip: To save time, you can have Quicken copy the payee‘s name 
into the address section for you. To do this, press the ditto key 
first line of the address section (you need not press the shift key). Quicken 
copies the payee to the first line of the address and the cursor moves 
automatically to the second address line. Finish by typing the rest of the 
payee’s address. 

in the 

Memo: You need not add a memo to your check, but adding a memo is a useful 
way to categorize your expenditures or to send a message to the payee. 
(See Chapter 8, @Categories, for more information on categorizing expendi- 
tures.) 

To add a memo: 

Type anything in the Memo field that you want. 
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~ ~ ~~ 

Quicken tip: If you’d like to add a longer memo, choose Split Transac- 
tion from the Edit Menu, or press (Ctrl( +m. A Split Transaction dialog 
box appears. This dialog box is designed to be used for ”splitting transac- 
tions”-apportioning the amount of the transaction to several categories- 
but it can also serve as a notepad for your transactions. Type your com- 
ments in the Memo column. When you are done, press the on-screen OK 
pushbutton. Press the on-screen Cancel pushbutton to leave the Split 
Transaction dialog box without adding anything. 

Quicken saves the split in the Check Register when you press the on-screen 
Accept pushbutton to record the check. If you use Quicken voucher 
checks, you can print the Split Transaction comments on the voucher. For 
more information, see Chapter 9, Split Transactions. 

Quicken tip: If you’d like to print an additional message on your check- 
such as a charge card number-you can have Quicken set up an extra 
message field. For instructions on how to do this, see ”Other Settings” in 
Chapter 14, Changing Settings. The message field appears to the right of the 
address section. 

Correcting mistakes 
If you make a mistake when you’re typing, there are three ways to 
correct it. 

1. Typeover. Drag the mouse over the text you want to change. Or, use 
Ishiftl+m or to highlight the text without a mouse. Then type in 
the new text. As soon as you press the first key, Quicken deletes all 
highlighted characters and replaces them with what you type. 

Delete. Use the mouse or Ishiftl+m or 
want to get rid of; then press 
for Clear on the Edit Menu. 

2. to highlight the text you 
(the delete key), the accelerator key 

Or 
Use the arrow keys to place the cursor to the right of any character you 
want to delete. Press lBackspacel to delete the letter to the left of the 
cursor. 
Or 
Place the cursor to the left of the characters you want to delete, and 
press m. 
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3. Insert. Click the mouse between any two letters to position the cursor 
there. Begin typing; text inserts at that point. 

Or 

Use the arrow keys to position the cursor between any two letters. 
Begin typing; text inserts at that point. 

Recording the check 
When you finish writing a check, you‘re ready to record it. Once Quicken 
has recorded a check, it becomes a permanent part of your records in the 
Check Register. Quicken deducts the amount from your account balance 
and your new ending balance appears in the lower-right corner of the 
screen. 

To record a check: 

Press the on-screen Accept pushbutton, or press P I ,  or use 
underline the Accept pushbutton and press the space bar. 

As Quicken records your check, the word RECORDING flashes in the 
lower-left corner of the screen, and you hear a beep. The check you have 
just written disappears from the screen and a new, blank check appears on 
the screen. The date on the new check is the last date you entered. The 
cursor is in the Pay to the Order of field, ready for you to type in the 
information for the next check. 

to 

Quicken tip: If Quicken doesn’t seem to display a blank check, it’s be- 
cause you have written-but not yet recorded-a check. Press the on- 
screen Accept pushbutton to record the check. Quicken will then display a 
blank check. 

Reviewing and changing checks you’ve written 
Once you‘ve written and recorded your checks, you can review them 
before printing either by using the scroll bar on the right side of the screen, 
or Im] and to ”flip” through the checks at the Write Checks 
screen. You can also review the checks in the Check Register. If you find a 
mistake in a check you’ve written, you can correct it using the techniques 
outlined above. 
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To review unprinted checks at the Write Checks screen: 

Click on the scroll bar to flip the checks up or down (for detailed directions 
on using the scroll bar, see Chapter 1). Or, press to move back one 
check at a time; press IP9Dn] to move forward. To go to the first check 
written, press +- . Pressing lm d q  will bring you to the 
blank check. As you review checks, you can delete or change them any 
way you like. 

Once you have printed a check, you cannot review it at the Write Checks 
screen. You can review printed checks only in the Check Register. 

To review checks in the Check Register: 

Choose Check Register from the Activities Menu or press 
Check Register appears. Figure 3-2 shows the Check Register. 

+m. The 

payment column shows “X” or asterisk (*) indicates Deposit column shows Balance column 
funds going out of account. cleared on bank statement. funds coming into the shows funds in 

\ \ account. \ the account. 

Check number colu 

Date column. 

Checks yet to be 
printed are marked 
with asterisks. 

Payee is on top line; 
memo is on bottom 
line. 

I I 

I @ lccept  ,I 
Ending Balance: $1,781,52 

Figure 3-2. Quicken’s Check Register. 

Quicken arranges the Check Register in chronological order (earliest date 
first). The Check Register displays all the information written on the 
checks, except for the address, split transactions, and extra message field if 
any. Unprinted checks are indicated by five asterisks (*****I in the Number 
(Num) column. Once the check is printed, Quicken replaces the asterisks 
with the actual check number. 
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If you want to see a split transaction, move to that transaction and press 

do so by reviewing the check at the Write Checks screen. However, you 
can do this only for unprinted checks. Once a check is printed, it appears 
only in the Check Register and the address can no longer be seen. 

There are several ways you can move through the Check Register: 

Click the scroll bar with the mouse to scroll the Check Register 
forward or backward. See Chapter 1 for instructions on using the 
scroll bar. 

+ m. If you want to see an address on an unprinted check, you can 

Use and to move through the Check Register one transaction at 
a time. 

0 Use or to scroll one screen up or one screen down. 

Press wl+ml to go to the beginning of the Check Register; press 
m+ml to go to the end. 

Use m+a and m + m  to move a month at a time. 

As you review checks in the Check Register, you can delete or change them 
as you like. Changes you make to a check that has not yet been printed 
(indicated by asterisks in the Number column) will appear on the check 
when you print it. 

To return to the Write Checks screen: 

Choose Write Checks from the Activities Menu or press m +@ . 
For more information on how to use the Check Register, see Chapter 5, 
Using the Check Register. 

Deleting checks 
You may want to delete an entire check you’ve written-perhaps a practice 
check or a check that is incorrectly filled out. If you have not yet printed a 
check, you can delete it from either the Write Checks screen or the Check 
Register. Just select Delete Transaction from the Edit Menu You can also 
use m +m. Whichever method you use, the result is the same-the 
check is deleted from the Check Register and from the set of checks that 
you have written but not yet printed. 
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To delete a check at the Write Checks screen: 

1. From the Edit Menu, choose Delete Transaction or press 
Quicken displays its Deleting Transaction dialog box, Figure 3-3. 

+a. 

fire you sure you want to delete 
this transaction? (Press No to 
return to editing) 

-I 

Figure 3-3. Deleting Transaction dialog box. 

2. If you wish to delete the transaction, press the on-screen YES pushbut- 
ton. Quicken completely deletes the check both from the Write Checks 
screen and from the Check Register. 

Or 

Press the on-screen NO pushbutton or press 
tion. 

to cancel the dele- 

To delete a check from the Check Register: 

1. Select the transaction you want to delete by clicking on it or using 
or 

From the Edit Menu, choose Delete Transaction or press 
Quicken displays its Deleting Transaction dialog box, Figure 3-3. 

If you wish to delete the transaction, press the on-screen YES pushbut- 
ton. You can also press W l .  Quicken deletes the check that you 
have highlighted in the Check Register. 
Or 

to select it with the highlight box. 

2. +m. 
3. 

Press the on-screen NO pushbutton or press 
deletion. 

to cancel the 
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More features 
You now know the basics of writing, recording, and reviewing checks with 
Quicken. In later chapters you’ll learn about additional check-writing 
features. These include: 

Memorize and Recall, which makes it easy to write checks for recurring 
bills. (See Chapter 6. )  

Expense Categories, which helps you keep track of where your money is 
going. (See Chapter 8.) 

Split Transactions, which lets you allocate a single check to several 
different expense categories. (See Chapter 9.) 

Postdating Checks, which allows you to write checks now for future 
printing and payment. (See Chapter 10.) 
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LID 

Quicken checks and your printer 

Ordering checks and supplies 

Selecting the Print Checks feature 

Printer setup 

Positioning checks in your printer 

Printing your checks 

Printing postdated checks 
~ ~ ~~~~ 

Correcting printing problems 

In this chapter you’ll learn how to print the checks you‘ve written and 
recorded. To print your Quicken checks, all you have to do is position the 
checks in your printer, assign a starting check number, and give the signal 
to start printing. 

You can use the sample checks enclosed in the Quicken package for 
practice. To pay bills with Quicken, you’ll want to order your own 
personalized Quicken checks (use the enclosed check order form and see 
Appendix E for details). The checks you order will come with your name, 
address, account number, bank name, and all the information required by 
financial institutions. They are accepted everywhere your checks are 
accepted now. You need no special permission from your bank to start 
using Quicken checks. They are economical and fit all printers including 
laser printers. 

Some printers waste the first check. If yours does, order Quicken Forms 
SaversTM, which enable your printer to print on the very first check. 

For complete information on Quicken checks, Forms Savers, and other 
supplies, see the Supplies Order Form enclosed in your Quicken package, 
or choose Order Supplies from the Activities Menu. 
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Quicken checks and your printer 
The illustration below identifies some key features of Quicken paper 
checks positioned in a typical printer. Take a moment to study the 
illustration; then follow the instructions under "Selecting the Print Checks 
feature" later in this chapter for positioning checks in your printer. 

Quicken checks are printed Quicken checks are 
on continuous-form paper personalized with your name 
for easy loading and fast, and address-and company institutions need. 
uninterrupted printing. 

Quicken checks are universally accepted. 
They contain all information that financial 

logo, if you wish. I I \  

envelopes. Both your address and the 
payee's address appear in the windows, 
eliminating the need to address 
envelopes. I 

Quicken checks fit all printers that use plain 
paper-either letter quality or dot-matrix 
printers, with or without tractor feed. Checks 
for laser printers are also available. 

Figure 4-1. Quicken checks in a typical printer. 
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Check formats 

Quicken checks come in two formats: continuous-form checks for easy 
insertion and fast, uninterrupted printing in traditional printers, and laser 
checks for use with printers such as the Hewlett-Packard LaserJetTM. 

All Quicken checks fit Quicken window envelopes; both your address and 
the payee’s address appear in the window;, eliminating the need to 
address envelopes. 

When you use Quicken to write checks, you print them on printer-ready 
personalized checks that you order from Intuit. You can use the sample 
checks enclosed in the Quicken package for practice. 

This chapter tells you all you need to know about printing checks, 
including how to: 

Order checks and supplies 

Print your checks 
Correct printer problems. 

Position the checks in your printer 

Ordering checks and supplies 
In order to use Quicken to write and print checks, you’ll want to order 
supplies soon. Supplies available from Intuit include: 

Personalized Quicken checks 
Quicken checks come with your name, address, account number, bank 
name, check numbers, and all the information required by financial 
institutions. Intuit guarantees that they will be accepted everywhere 
your checks are accepted now. They are economical, and fit all print- 
ers (other than thermal-paper printers) and come in both regular and 
voucher style. 

Forms Savers 
Some printers, particularly those with tractor feed, waste the first 
check. Quicken Forms Savers allow your printer to print on the very 
first check, saving you money. 

Window envelopes 
Quicken window envelopes are specially designed to work with 
Quicken checks. Both your address and the payee’s address printed 
on the check show through the envelope’s windows, eliminating the 
need to address envelopes, and saving you time. 
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You’ll find a Supplies Order Form enclosed in the Quicken package. Use it 
to order your checks and envelopes. 

If you don’t have an order form-or if you need another-you can print 
one on your printer. For instructions, choose Order Supplies from the 
Activities Menu after you start Quicken, and follow the directions that 
appear on the screen. 

Selecting the Print Checks feature 
Printing checks is easy with Quicken. 

To print checks: 

1. Choose Write Checks from the Activities Menu. Quicken displays the 
Write Checks screen. 

From the File Menu, choose Print Checks. Quicken displays the Print 
To dialog box (Figure 4-21 

2. 

I -- 
Figure 4-2. Print To dialog box. 

3. Select the Page Setup you want. Page Setup controls margins, the 
number of lines you print per page, and type size. If this is the first 
time you have printed checks with Quicken, just choose Page Setup 1, 
which works for most printers. Full details about Page Setup are 
available in Chapter 14, Changing Settings. 

Note: You cannot print checks to a filename on disk; the File button is 
unavailable (grayed out) when printing checks. The Page Setup dialog 
box is used only to select a Page Setup. 
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4. When you have selected a Page Setup, press the on-screen OK push- 
button in the Print To dialog box; Quicken displays the Print Checks 
dialog box (Figure 4-3). 

Print checks dated 
Starting check number: 

Regular Checks 
B Uoucher Checks 

For help i n  positioning checks, press Sample, 
im=-- 

Figure 4-3. Print Checks dialog box. 

Print Checks dialog box 

You tell Quicken which checks to print at the Print Checks dialog box. 

You can print checks through any date. By setting this date past 
the current date, you can print postdated checks. See Chapter 10, 
Postdating Checks, for more information. 

You set the first check number for Quicken to use. Quicken 
remembers the number of the last check it printed and remembers what 
number to start with next time. 

Print checks 
dated through 

Starting check 
number 

Regular Checks or 
Voucher Checks 

Press one of these on-screen buttons. Voucher checks have a 
blank stub, or voucher, at the bottom of each check. Regular checks do not. 
Typically, you would use the voucher to itemize what the check covers, for 
example, a list of invoice numbers and amounts (see Chapter 9, Split 
Transactions). If you want a second copy of a check for your own records, 
order two-part checks that make a carbonless copy of every check you 
print. 

Print 

Sample 

Cancel 

Press the on-screen Print pushbutton to begin printing checks. 

Press the on-screen Sample pushbutton to use Quicken’s patented 
alignment method to run a test to see if your checks are aligned correctly in 
the printer; Quicken will realign checks automatically if necessary (US. 
Patent # 4725156). 

Press the on-screen Cancel button to return to the Write Checks screen 
without printing anything. 
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Printer setup 
Choose Page Setup from the File Menu to create a special Page Setup- 
margins, type size, etc.-for printing checks. Chapter 14, Changing Settings, 
contains complete information about Page Setup and changing Quicken's 
settings. 

~ ~~ 

Quicken tip: It's a good idea to try printing with Quicken before making 
any setup changes. Since the program comes ready to work with most 
popular printers, you'll probably find that you won't have to change a 
thing. 

Positioning checks in your printer 
Before you begin printing, you must load checks into the printer and 
position them so that the printing starts in the first field of the check (the 
date). The first time you print with Quicken, you should have Quicken 
print a sample check to help you determine the correct alignment. 

To position checks in your printer: 

1. Load the checks into your printer just as you would any continuous- 
form computer paper. Be sure that your printer is turned on and is on 
line or "selected." 

2. With the Print Checks dialog box on screen, press either the on-screen 
Regular Checks or Voucher Checks button, depending on which 
format you are using. Press the on-screen Sample pushbutton. 

Quicken prints a sample check. The Sample Check dialog box 
appears. DO NOT MOVE THE CHECKS UP OR DOWN IN THE 
PRINTER; Quicken will do this for you. 

Without moving the checks in the printer, look at the printed sample 
check. You will see a series of XXXXs typed in for the Date and the 
Amount, the word Payee typed in for the Pay to the Order of field, 
and the words "This is a void check typed in the Memo field. If the 
check printed correctly, the type should rest just above the lines on the 
check. 

3. 

4. 
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If the sample check is printed correctly: 

Press the on-screen OK pushbutton and follow the instructions given in 
”Printing your checks” later in this chapter. 

If the sample check is NOT printed correctly: 

Look at the line labeled POINTER LINE on the check. The arrows at each 
end of the line point to numbers printed along the edges of the check in the 
tear-off strip. Note the number that the arrows point to. This is the 
position number. 

Figure 4-4. The Pointer Line as it appears when printing a sample 
check. 

Quicken tip: DO NOT move the checks in the printer by hand. Doing so 
after the sample check is printed will interfere with Quicken’s automatic 
alignment. 

Type the position number in the Position number window. Press the on- 
screen OK pushbutton. Quicken automatically advances the checks in the 
printer as necessary and prints another sample check. 

The vertical positioning of the check should be almost perfect. At this 
point, you can make any final adjustments, including side-to-side 
positioning, by hand. If a half-line adjustment is needed-for example, if 
the printing is slightly above the line-use the knob on the side of your 
printer to move the check up a half line. If the printing is too far to the 
right or left, move the checks to the right or to the left. Now is a good time 
to note the correct position of the check for future positioning (see below). 

When the checks are positioned correctly: 

Press the on-screen OK pushbutton to continue with the check-printing 
process. 
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Note check positioning for future printing 

Once your checks are positioned correctly, look for a way to align a visible 
part of your printer, such as the sprocket cover or tear-off bar, with one of 
the position numbers at the edge of the check. After you‘ve found 
something to use as an alignment cue, make a note of it. Then you’ll be 
able to align your checks visually each time you load your printer, and you 
won’t have to go through the process of printing another sample check. 

Printing your checks 
After you have properly aligned your checks, Quicken again displays the 
Print Checks dialog box as in Figure 4-3. The Print checks dated through 
area is highlighted. 

1. Type in the date through which you want to print checks. The default 
is the current date. You can print postdated checks by typing a future 
date here. 

2. Select the Starting check number field, and type in the number of the 
first check you want printed. The first time you use Quicken, the 
check number appears as 1001. If that is not correct, press 
advance or reduce the number by one, or type in a different starting 
number. After you have printed checks with Quicken once, the 
program remembers the last check number you printed, and automati- 
cally proposes the next number in series as your new starting number 
each time you print checks. 

Press either the Regular Checks or Voucher Checks on-screen button 
depending on which format of check you are using. 

Press the on-screen Print pushbutton. Quicken prints the selected 
checks. 

or to 

3. 

4. 

When your checks are done, a window asking Did checks print OK? 
appears. Now you can look over your printed checks and reprint any that 
are printed incorrectly. 

If all the checks printed correctly: 

Press the on-screen OK pushbutton. Quicken returns you to the Write 
Checks screen, where you can continue writing checks. 
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If any checks printed incorrectly: 

1. 

2. 

3. 

Type in the number of the first incorrectly printed check (Quicken 
shows you the range of check numbers of the checks it attempted to 
print). If none of the checks printed correctly, the number you type in 
is the starting check number for this run. 

Press the on-screen OK pushbutton. Quicken returns you to the Print 
Checks dialog box, where you can perform the check alignment test 
again if necessary. 

When you have finished realigning your checks, press the on-screen 
Print pushbutton. Quicken reprints the incorrect checks. 

Quicken tip: If you need to reprint incorrectly printed checks at some later 
date, you can do so by going to the Check Register, finding the check you 
want to reprint, and typing an asterisk (*) in the Number (Num) column. 
Quicken replaces the check number with a row of asterisks and considers 
the check unprinted. Record the transaction. You can then go to the Write 
Checks screen and print the check. Similarly, to prevent Quicken from 
printing a check you’ve written, delete the asterisks from the Num column 
in the Check Register. 

When you change a check number to asterisks to reprint a check, any 
address the original check may have had is deleted. To add an address to 
the check after changing the check number to asterisks, go to the Write 
Checks screen and scroll through the checks until you find the one you 
want. Then type in the address and press the on-screen Accept 
pushbutton. 

Printing postdated checks 
Quicken lets you postdate checks and print them now or later. To print 
postdated checks, type the date of the checks through which you want 
Quicken to print in the Print checks dated through field of the Print 
Checks dialog box. 

Postdated checks whose dates have come due will be printed 
automatically whenever you print checks. For more information, see 
Chapter 10, Postdating Checks. 
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Correcting printing problems 
Some of the most common printing problems and their solutions are listed 
in the following chart. If you continue to have problems, consult your 
printer manual or call Intuit Technical Support at (415) 322-0590. 

Quicken tip: If you notice a problem while your checks are being printed, 
you can stop the printing process by pressing or by pressing the 
Cancel pushbutton. Quicken tells you that printing is interrupted; press 
OK to resume printing or press the on-screen Cancel pushbutton or 
to stop printing completely (you cannot resume after pressing Cancel or 
[Escl). 

If your printer continues to print after you press the on-screen Cancel 
pushbutton or press (Escl, your printer probably has a buffer. A buffer 
enables the printer to continue printing even after the computer tells the 
printer to stop. To stop this kind of printer quickly, turn the printer’s 
power switch off. 
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Problem Solution 

Printer doesn’t print. Check equipment. Connect cable securely to printer 
and computer. Make sure Quicken is set to print to 
the correct printer port (e.g., LPT1) on the Setup 
Printer dialog box of the Setup Accessory. See 
Chapter 14, Changing Settings. 

Print falls too high or 
too low on the check. 

Move checks up or down. See “Positioning checks in 
your printer” on page 4-6. 

- 

Print is too far left. Reposition checks horizontally. 
Move checks to the left. 

-- Print is too far right. P 
I -- I 

Reposition checks horizontally. 
Move checks to the right. 

Print is OK on left side 
but doesn’t reach 
right side. per inch. 

“Pitch” setting is wrong. See Chapter 14, Changing 
Settings. Readjust Quicken to 12 characters 

Print is too long on both 
left and right sides. 

Pitch setting is wrong. See Chapter 14, Changing 
Settings. Readjust Quicken to 10 pitch. 

Date printed on 
left of check. 

Pitch setting is wrong. See Chapter 14, Changing 
Settings. Readjust Quicken to 10 pitch. 

Fl Print is double-spaced. Turn on the Line feed filter on the Setup printer 
dialog box of the Setup Accessory. See Chapter 14, 
Changing Settings. 
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The Check Register 

Adding transactions to the Check Register 
- 

Reviewing the Check Register 

Revising the Check Register 

Changing the balance 

Printing the Check Register 

More features 

The Check Register is Quicken’s record of your checking account. 
Quicken’s Check Register looks and works like your paper check register. 
When you press the on-screen Accept pushbutton to record a check at the 
Write Checks screen, it appears in the Check Register and becomes a 
permanent part of your records. 

You can use the Check Register to record all other transactions that affect 
the balance in your checking account. These include checks written by 
hand, automatic teller machine (ATM) transactions, electronic transfers, 
deposits, and checking account fees and interest. In addition, you can use 
the Check Register to keep a record of transactions that don’t involve your 
checking account. These include credit card and cash transactions, and 
business transactions that don’t affect cash. For more information, see 
Chapters 15,16, and 17, Home Uses of Quicken and Business Uses. 
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The Check Register 
You add transactions to the Check Register by typing in the appropriate 
information and pushing the on-screen Accept pushbutton to record it. 
You can change or delete any kind of transaction that you have recorded in 
the Check Register. As you work, Quicken arranges your transactions in 
chronological order and calculates your new balance. You can review or 
print out the Check Register any time you want. 

Displaying the Check Register 

Choose Check Register from the Activities Menu. You can also press 
(Ctrll +B. Quicken displays the Check Register. Figure 5-1 shows the 
different parts of the Check Register. 

Moving around the Check Register 

The transaction with the dark box around it is the currently selected 
transaction. The box is called the selection box. All typing or other 
changes (such as deleting) affect only the selected transaction. There are 
several ways to move around the Check Register and select different 
transactions. 

With a mouse: 

Click a particular transaction with the mouse. Quicken moves the 
selection box to that transaction; you have selected it. 
Click the u p  arrow and down arrow at the ends of the scroll bar with the 
mouse. Quicken moves the selection box up or down the Check 
Register by one transaction. 
Click the scroll bar above or below the elevator box. Quicken moves 
the selection box up or down the Check Register by one page (six 
entries). 
Drag the elevator box up or down the scroll bar with the mouse. 
Quicken moves its selection box to that relative position in the Check 
Register when you release the mouse button. 

With the keyboard: 

Press or on the keyboard. Quicken moves the selection box up 

Press m] or on the keyboard. Quicken moves the selection 

or down one transaction. 

box up or down the Check Register by one page (six entries). 
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Press ma or m + m  to move the selection box to the first 
transaction of the previous or the next month. 

Press m+ml or m+lEnd] to move the selection box to the 
beginning or to the end of the Check Register. 

Quicken puts Opening Balance: initial deposit Use the C (cleared) Column to Amount 

chronological order. from paper check register. when you reconcile your account. deposit. 
transactions in or the balance carried forward check off cleared transactions of 

Number of a 
printed or 
handwritten check. 

Top line for Payee, 
bottom for Memo. 

Asterisks indicate 
checks written but 
not yet printed. 

/ Enter new / 
transactions at the 
end of the Check 
Register. 

Amount of check 
or payment. 

Figure 5-1. Quicken’s Check Register. 

Adding transactions to the Check 

Quicken calculates new balance 
after each transaction. 

Register 
You type transactions into the Check Register in much the same way you 
fill in a blank check at the Write Checks screen. Transactions you add to 
the Check Register may be bank fees, automatic teller machine (ATM) 
transactions, deposits, or checks you have written by hand. You should 
add any transaction that affects the balance in your account to the Check 
Register. Always add transactions to the last blank transaction area at the 
bottom of the Check Register. Quicken will move it to the correct chrono- 
logical location in the Check Register for you. All transactions fall gener- 
ally into two categories, deposits and payments. 
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To add a transaction to the Check Register: 

1. 

2. 

3. 

4. 

5. 

Make sure you’re displaying the Check Register. Choose Check 
Register from the Activities Menu. 

Drag the elevator box to the bottom of the scroll bar or press 
[Ctrll+lEnd] to display the last transaction in your Check Register. 
You have reached the last transaction when you see the End Bar and 
the blank Check Register transaction. 

If not already selected, select the blank Check Register transaction. 

Quicken tip: If you find that there is no blank transaction at the 
bottom of the Check Register, it’s because you have written-but not 
yet recorded-a transaction. Press the on-screen Accept pushbutton to 
record the transaction. Quicken will then display a blank transaction. 

Type in the transaction that you wish to enter. 

Use and 

To move the text entry cursor from field to field, press lTabl or 
check the field you want to move to. 

You can correct any typing mistake you make. See ”Correcting 
mistakes,” page 3-5. 
If you type in an incorrect date, for example, February 35, Quicken 
tells you you’ve entered an ”invalid date” and won’t let you move 
on until you’ve corrected it. 

to move the cursor one space at a time. 

When you are satisfied with the information you’ve typed into the 
blank transaction, press the on-screen Accept pushbutton. Quicken 
moves your transaction to its proper place in chronological order, then 
creates a new blank Check Register transaction, and moves the selec- 
tion box to it. By pressing the on-screen Accept pushbutton, you make 
the transaction a permanent part of your records. (You can alter and 
delete entries after you have accepted them. See “Revising the Check 
Register,” page 5-1 1 .I 

How Quicken organizes your transactions 

Each time you record a transaction, Quicken automatically places the 
transaction in chronological order in the Check Register and recalculates 
all subsequent balances. This keeps your records in order no matter when 
you enter transactions. 
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For example, suppose the date at the end of the Check Register is 2/27/89 
and you want to enter an automatic teller machine (ATM) withdrawal 
made on 2/10/89. All you have to do is type the transaction at the end of 
the Check Register with a date of 2/10/89 and press the on-screen Accept 
pushbutton to record it. Quicken automatically moves the transaction 
where it belongs. 

Quicken keeps transactions in order first by date and then by check 
number within that date. Transactions without check numbers appear in 
the order (within the date) in which you entered them. Whenever Quicken 
moves a transaction into chronological order, the word MOVING appears 
next to RECORDING when you record the transaction. 

Typing a deposit into the Check Register 

A deposit is any money added to your account. Deposits include interest or 
transfers into the account. 

To enter a deposit: 

1. Move to the blank Check Register transaction just above the End Bar. 
Move the cursor to the Date column. 

To change the date, use 
mouse and delete; or backspace to delete and retype-just as you do 
when filling out a check. 

Press m twice to move to the Payee/Memo column, or click the 
Payee/Memo column to move the cursor there. 

Type in the word Deposit (or any other identifying word or phrase you 
want). 

2. or ; or highlight the date with the 

3. 

4. 

5. Press three times to move the cursor to the Deposit column (you 
can also click the Deposit column to move the cursor there). 

Type in the amount of the deposit just as you would type in the 
amount on a check. Remember, type the amount without dollar signs 
or commas. 

When you are satisfied with the deposit amount, press m . Quicken 
moves the cursor to the Memo line-the second line in the Payee/ 
Memo column. You can also click the Memo line. 

6. 

7. 
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8. Type in a memo, if you wish. Memos are optional. You can use the 
Memo line to categorize different kinds of deposits-such as paycheck 
or interest-or to write a note to yourself. See Chapter 8, @Categories, 
for more information on Quicken’s categories. 

Press the on-screen Accept pushbutton to record your deposit. 
Quicken moves your transaction into proper chronological order. 

9. 

Quicken tip: You can add a longer memo to a transaction. Use Quicken’s 
Split Transaction dialog box as a memo pad. Here’s how: 

1. When it’s time to type in your Memo line information, choose Split 
Transaction from the Edit Menu. Quicken displays its Split Transac- 
tion dialog box. You can also use the accelerator key combination, 

Type your extended memo into the lines of the Split Transaction 
dialog box. 

When you’re satisfied with your typing, press the on-screen OK 
pushbutton. Quicken closes the dialog box and saves your extended 
memo. 

Press the on-screen Cancel pushbutton. Quicken closes the dialog box 
and does not save the extended memo information. For more informa- 
tion on Split Transactions, see Chapter 9. 

Wl+B. 
2. 

3. 

Or 

Typing a payment in the Check Register 

A payment is any money subtracted from your account, for example, 
withdrawals, checks, or service charges. 

To type a payment in the Check Register: 

1. Move to the blank Check Register transaction just above the End Bar. 
Move the cursor to the Date column. 

2. To change the date, use or ; or highlight the date with the mouse 
and delete; or backspace to delete and retype-just as you do when 
filling out a check. 
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3. 

4. 

5. 

6. 

7. 

8. 

9. 

10. 

Press to move to the Num column, or click on the column. If the 
transaction you are typing in is a handwritten check, type in the actual 
check number. If the transaction is normally not numbered (for 
example, an ATM withdrawal), just bypass the Num column by 
moving on to the next step. 

Quicken tip: Press when the cursor is in the Num column and 
Quicken automatically enters a check number one greater than the last 
one you entered into the Check Register. Once you have displayed a 
check number this way, increases it and decreases it. 

Press 
Memo column to move the cursor there. 

to move to the Payee/Memo column, or click the Payee/ 

Type in the payee’s name (or any other identifying word or phrase you 
want). 

Press lTabl to move the cursor to the Payment column (you can also 
click the Payment column to move the cursor there). 

Type in the amount of the payment just as you would type in the 
amount on a check. Remember, type the amount without dollar signs 
and commas. 

When you are satisfied with the payment amount, press lTabl three 
times. Quicken moves the cursor to the Memo line-the second line in 
the Payee/Memo column. You can also click the Memo line. 

Type in a memo, if you wish. Memos are optional. You can use the 
Memo line to categorize different kinds of expenditures-such as 
groceries, clothing, or utilities-or to write a note to yourself. See 
Chapter 8, @Categories, for more information on Quicken’s categories. 

Press the on-screen Accept pushbutton to record your payment. 
Quicken moves your transaction into proper chronological order. 

Reviewing the Check Register 
You can review your Check Register at any time. You can move the 
selection box through the Check Register by transaction, by page, or by 
month, and go to the beginning or end of the Check Register by using 
Quicken’s scrolling keys and scroll bar. To find specific transactions, you 
can use Quicken’s Find and Go to Date features. 
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Using the scrolling keys 

Press: 

o r m  

rpsupl o r m l  

To do this: 

Move up or down one transaction at a time. 

Move up or down one screen at a time (six 
Check Register entries). 

Move to the beginning of the previous/next 
month. 

Move to the beginning of the Check Register. 

Move to the end of the Check Register. 

Quicken tip: If you have a mouse, you can also use the scroll bar to move 
through the Check Register. 

Using Find 

The Find feature on the Search Menu locates specific transactions without 
scrolling through the entire Check Register. You can find a transaction 
even if you don’t know all the information contained in the transaction. 

Note: You can also use Find at the Write Checks screen to find a specific 
check that has been written but not yet printed. 

To find a particular Check Register transaction, display Quicken’s 
Transaction to Find dialog box and type in search criteria following a few 
simple rules (outlined below). Quicken searches through the transactions 
in the Check Register and locates the one that matches the criteria you‘ve 
supplied. If the transaction it finds is not the one you’re looking for (you 
may have several transactions with ”Phone Company,” for example), you 
tell Quicken to search forward to find the next  transaction that matches- 
or search backward to find the previous one, if you find you’ve gone too far 
through the Check Register. In this way, you can search through hundreds 
of transactions very quickly. Figure 5-2 shows the Transaction to Find 
dialog box. 
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I1 /I 
Figure 5-2. Transaction to Find dialog box. 

Rules of the search 
You can locate a transaction by matching one or more of the Check 
Register fields: Num (check number), Payee, Memo, Payment, C (cleared), 
and Deposit. 

If you enter information in only one of the fields (for example, Payee), 
Quicken finds a transaction in the Check Register that matches that 
field only-no matter what is in any other field. 
If you enter information in two or more of the fields, Quicken finds a 
transaction in the Check Register that matches all criteria. 

There may be times you don’t know exactly what you’re looking for. For 
example, maybe you wrote a check to Jack’s Towing, but remember only 
the name Jack or that the company did towing. Quicken allows you to 
search the Check Register following these rules: 

Num 

PayeeIMemo 

Payment 

You can enter an asterisk (*) to find any check that Quicken has not yet 
printed. You can enter two periods (..) to find any check that has a check 
number (e.g., Quicken has printed it). Or, you can enter the full check 
number (for example, 456). 

You can type the exact Payee name or Memo information. The top line of 
the Payee/Memo column is the payee field and the bottom line is the 
Memo field. If you don’t know the full name or memo, you can type in 
what you do know and use two periods (..) to represent the rest. For 
example, ..Smith finds Dr. Smith and William F. Smith. The phrase 
..phone.. finds both Phoneland and Mountain Telephone Co. 

You must enter the exact dollar amount you’re searching for 
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C(cleared) To search for cleared transactions, type an X in the C (cleared) column. To 
search for uncleared transactions (transactions for which the C column is 
blank), type a period (.I. To search for transactions marked with an 
asterisk (newly cleared transactions), type an asterisk (*). 

Deposit You must enter the exact dollar amount you’re searching for. 

To use Find: 

1. 

2. 

Choose Check Register or Write Checks from the Activities Menu. 

Choose Find from the Search Menu. You can also press m+m. 
Quicken displays the Transaction to Find dialog box, as in Figure 5-2. 

Type in a word, number, or phrase that matches the transaction you 
want to find, according to Quicken’s search rules. 

Press the on-screen Next pushbutton to search forward; press the on- 
screen Prev pushbutton to search backward. Quicken locates the 
transaction in the Check Register or Write Checks screen (if it exists), 
and selects it. 
Or 

Press the on-screen Cancel pushbutton to leave the Transaction to 
Find dialog box without finding any transaction. 

To find the next transaction that matches your search criteria, choose 
Find Next from the Search Menu (or press m+n). To find the 
most immediate previous transaction that matches your search criteria, 
choose Find Previous from the Search Menu (or press m + m ) .  
Quicken uses the same criteria you last entered in the Transaction to 
Find dialog box. 

3. 

4. 

5. 

Using Go to Date 

Use the Go to Date feature to find transactions by date. 

To use Go to Date: 

1. 

2. 

Choose the Check Register from the Activities menu. 

From the Search Menu, choose Go to Date, or press lCfrll +n. 
Quicken displays its Go to Date dialog box, as in Figure 5-3. 
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/I I Date to f ind:  

Figure 5-3. Go to Date dialog box. 

3. 

4. 

Type the date you want to find in the Date to find field. 

Press the on-screen OK pushbutton. Quicken searches through the 
Check Register and locates the first transaction it finds in the search 
with the date you typed in. This could be the first or last in the series, 
depending on the direction of the search. If there is no transaction 
with the date you specify, Quicken goes to the one that is closest to 
(and earlier than) that date. 

Or 

Press the on-screen Cancel pushbutton. Quicken leaves the Go to 
Date dialog box and locates no transaction. 

Quicken tip: You can also use Find and Go to Date to find unprinted 
checks while you are at the Write Checks screen. The feature works as it 
does in the Check Register. 

Revising the Check Register 
You can change or delete any transaction in the Check Register. When you 
have finished making changes, press the on-screen Accept pushbutton to 
record the changes. Quicken recalculates all subsequent balances, if 
necessary. 

To change a transaction: 

1. 

2. 

In the Check Register, select the transaction you want to change. 

Select the part of the transaction you want to change-check number, 
payee, memo, cleared status, etc. You can also use 
field to field within each Check Register transaction and make the 
desired changes. 

Press the on-screen Accept pushbutton to record the changes in the 
Check Register. 

to move from 

3. 
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To delete an entire transaction: 

1. 

2. 

In the Check Register, select the transaction you want to delete. 

Choose Delete Transaction from the Edit Menu. You can also press 
+m. Quicken asks for confirmation before it deletes the transac- 

tion. Press the on-screen YES pushbutton to confirm. Quicken deletes 
the selected transaction and recalculates all subsequent balances. Or, 
press the on-screen NO button, and Quicken returns to the transaction 
in the Check Register without deleting it. 

Quicken tip: Once you have deleted a transaction, you cannot recover 
it. Be sure you want to delete a transaction before you press the on- 
screen YES pushbutton. 

Changing the balance 
The only column in the Check Register that you cannot change by normal 
editing is the Balance column. If you want to change the balance, you must 
add a payment or deposit transaction to the Check Register. 

To adjust the balance: 

1. 

2. 

3. 

Select the last blank Check Register transaction (press m+m). 
Change the date if you wish. 

Move to the Payee field. Type in the words Balance Adjustment (or 
whatever designation you want). 

Follow the steps below to increase or decrease your balance. 4. 

To increase your balance: 

Type the amount of the increase in the Deposit column and press the 
on-screen Accept pushbutton to record it. Quicken calculates your 
new balance. 

To decrease your balance: 

Type the amount of the decrease in the Payment column. Press the on- 
screen Accept pushbutton to record it. Quicken calculates your new 
balance. 
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Printing the Check Register 
You can print transactions from any portion of your Check Register-a day, 
a week, a month, a year, or more. You then have a printed record of the 
period of time covered. 

To select Print Register: 

1. Display the Check Register by choosing Check Register from the 
Activities Menu, or by pressing ma. 
From the File Menu, choose Print Register. Quicken displays the 
Print To dialog box, as in Figure 5-4. For more information about the 
Print To dialog box, see Chapter 14, Changing Settings. 

2. 

Print t o :  8 %rt:ter 

Figure 5-4. Print To dialog box. 

To print to a printer: 

1. Press the Printer button. Press 

2. 

to move to the Page Setup list. 

Select the Page Setup you want to use for this printing. You can use 

Setup with the mouse. 

Press the on-screen OK pushbutton. Quicken displays the Print 
Register dialog box. 

and to select a Page Setup, or you can click the appropriate Page 

3. 
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To print to a file: 

1. 

2. 

3. 

Check here to print each 
transaction on one line 
instead of two. \ 

Press the File pushbutton. Press to move to the File name field. 

Type the pathname and filename to which you want Quicken to print. 

Press the on-screen OK pushbutton. Quicken displays the Print 
Register dialog box. 

The Title (optional) prints at the 
top of each page printed. 

Enter the date range you want 
Quicken to print. 

Iitle (optional): \Check Register, as of Movenber 1989 1 
0 Print one line per transaction 
H Print transaction splits f’: m m  

Check here to print 
transaction splits. 

4. 

5. 

6. 

7. 

8. 

Figure 5-5. Print Register dialog box. 

Select the from and to Date fields and type in the date 
range of transactions you want Quicken to print. 

Select the Title field if you want to type in a title, such as CHECK 
REGISTER, AS OF NOVEMBER 1989. 

If you want each transaction to print on one line instead of two, check 
the box next to Print one line per transaction. 

If you want to print transaction splits, check the box next to Print 
transaction splits. 

When you are satisfied with your print settings, press the on-screen 
OK pushbutton. Quicken begins printing the Check Register. 
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More features 
Now that you know the basics of using the Check Register, you can use 
many of Quicken’s advanced features. These include: 

Memorize and Recall, which reduces the number of keystrokes needed to 
type recurring transactions such as paycheck deposits and mortgage 
payments. (See Chapter 6. )  

@Categories, which helps you keep track of where your money is coming 
from and where it is going. (See Chapter 8.) 

Split Transactions, which allocates a single transaction to different 
@Categories. You can also split transactions already recorded in the Check 
Register, if you wish. (See Chapter 9.) 

Postdating, which lets you enter transactions now that will affect your 
balance in the future. (See Chapter 10.) 

Quicken User Manual 5-15 



Chapter 5. Using the Check Register 

5-16 Quicken User Manual 



Chapter 6 c3 Memorizing 
0 0 Transactions 

Memorizing transactions 

Recalling memorized transactions 

Changing memorized transactions 

Deleting memorized transactions 

Printing the Memorized Transactions List 

In this chapter you’ll learn how to use one of Quicken’s most valuable 
time-saving features-Memorized Transactions. This feature allows 
Quicken to memorize checks and other transactions that you write repeat- 
edly (for example, mortgage payments, utility bills, and paycheck depos- 
its). When you want to enter such transactions again, you just tell Quicken 
which one you want, and Quicken types it out for you automatically. 

Quicken can memorize any transaction you have typed at the Write 
Checks screen or in the Check Register. Then when you recall a transac- 
tion, with only a few keystrokes you can fill out an entire transaction, or 
only a few parts (for example, the amount and the memo, or the payee and 
the address). This allows you to set up ”templates” for checks that have 
similar information in some parts, but different information in others (for 
example, a check for paying a utility bill where the amount varies from 
month to month). If you split a transaction, Quicken memorizes the 
contents of the split along with the rest of the transaction. 

By using the Memorize Transaction and Recall Transaction features, 
you’ll eliminate the tedious chore of retyping all recurring transactions. In 
addition, you’ll reduce the chance of error due to typing mistakes. 
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Memorizing transactions 
When you use the Memorize Transaction feature, Quicken saves a copy of 
the transaction in a separate list. First, type in a transaction at the Write 
Checks screen or in the Check Register. You can even split the transaction. 
Quicken memorizes whatever you have typed in that one transaction. 

To memorize a transaction: 

1. Type the information you want memorized at the Write Checks screen 
or in the Check Register-including any split transaction information. 
Quicken does not memorize the date or check number. Quicken can 
also memorize existing transactions; in that case, select the transaction 
you want memorized in the Check Register. 

From the Quick Entry Menu, choose Memorize Transaction. You can 
also press 
memorize and displays a simple OWCancel dialog box to confirm that 
this is indeed the information you want memorized. 

If the information you want memorized is highlighted, press the on- 
screen OK pushbutton. Quicken memorizes the highlighted informa- 
tion and flashes the word MEMORIZING on the screen. It adds this 
memorized transaction to the Memorized Transactions List. (You can 
find out how to review this list of memorized transactions in the 
section, “Recalling memorized transactions,” on page 6-6) 

Or 

If the information you want memorized is not highlighted, press the 
on-screen Cancel pushbutton. Quicken does not memorize the trans- 
action information, and the highlight disappears. To change the 
information you want memorized, change or delete the information on 
the check or Check Register entry, and choose Memorize Transaction 
again. 

2. 
+n . Quicken highlights the fields it’s about to 

3. 

Memorize transactions like these 

Here are examples of some typical transactions you may want Quicken to 
memorize. Note that Quicken does not memorize the date. When you 
recall a memorized transaction, the current date always appears on the 
check and in the Check Register. Find out how to recall memorized 
transactions in the following section, “Recalling memorized transactions,” 
on page 6-6. 
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Quicken memorizes 
the Payee, Memo, 
and @Category . 
information because , 
that’s the information 
on the check when ‘ 
you choose Memorize 
Transaction from the 
Quick Entry Menu. 

b- 

I Ending Balance: $2,467,76 

Figure 6-1. Memorizing the check to pay a recurring bill. 

Figure 6-1 shows a check in which all the Payee information and @Catego- 
ries stay the same from month to month-in this example, a phone bill. 
Quicken memorizes the highlighted information. If you split the transac- 
tion, Quicken memorizes the information in the split as well. 

If you want to pay recurring bills with amounts that vary from month to 
month, fill out only those fields that remain the same each month. 
Quicken memorizes those fields you’ve highlighted (see the previous 
section). After you recall the memorized information and the check is 
otherwise complete, fill in the current amount. Note that in Figure 6-1, the 
Memo field holds both the telephone number and the @Category @Tele- 
phone. If you prefer, you could use the extra message line described in 
Chapter 14, Changing Settings, for the telephone number. The @ sign before 
the word ”Telephone” in the Memo field indicates that it is an Wategory. 
(See Chapter 8, @Categories.) 
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I Ending Balance: $2,092,76 

Figure 6-2. A check in which all information stays the same each 
month. 

Figure 6-2 shows a check in which all the information stays the same each 
month, even the amount. An example of this type of check is a rent or 
mortgage payment. Quicken memorizes the highlighted information. If 
you split the transaction, Quicken memorizes the contents of the split as 
well. 

The marked information is 
about to be memized ,  

I Ending Balance: $2,892,76 

Figure 6-3. Paying the same amount to different payees. 
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If you want to pay the same amount to different payees-for example, a 
business sending rebate checks to ten customers-type in the amount and 
memo, but not the payee before you memorize the transaction, as in Figure 
4-3. Quicken memorizes only the information that you have typed in when 
you choose Memorize Transaction from the Quick Entry Menu. When 
you’re ready to recall the memorized transaction, you type in the payee‘s 
name and address. 

If you recall memorized transaction information at a transaction that 
already has information in it, Quicken overwrites the fields in that transac- 
tion with the corresponding filled-in fields from the memorized transac- 
tion. 

f.cept-] 
Ending Balance: $2,129,16 

Figure 6-4. Recurring deposits and payments in the Check Register. 

You can use memorized transactions to enter recurring deposits and 
payments into the Check Register, as in Figure 6-4. Quicken can also 
memorize the transaction’s cleared status, which is useful for such entries 
as bank service charges, which are cleared upon entry. If the Payee/Memo 
information remains the same, but the amount varies from month to 
month, leave out the amount when you type in the transaction. Then, 
when you use the memorized transaction, type in the appropriate amount. 
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Recalling memorized transactions 
You can recall a memorized transaction at the Write Checks screen or in 
the Check Register. You can review your memorized transactions by 
recalling transactions and displaying Quicken’s Memorized Transactions 
List without specifically selecting a transaction from the list. 

Transaction types 

To help you in selecting the correct memorized transaction, Quicken 
displays three transaction types in the Memorized Transactions List: 

Chk Check, memorized at the Write Checks screen. 

Pmt: Check Register payment, memorized in the Check Register. This 
will include handwritten checks entered in the Check Register. 
Dep: Deposit to the Check Register, memorized in the Check Register. 

The three transaction types are important for another reason: different 
types of transactions behave differently when included in Transaction 
Groups (see Chapter 7, Transaction Groups). Quicken prints Chk-type 
transactions as though they were entered at the Write Checks screen; Pmt- 
type transactions appear as though they were entered in the Check Regis- 
ter (as do Dep-type transactions). 

To recall a memorized transaction: 

1. From the Quick Entry Menu, choose Recall Transaction. You can also 
press 
Transactions appear in alphabetical order by payee (see Figure 6-5). 

+m. Quicken displays its Memorized Transactions List. 

I 6-6 Quicken User Manual 



Chapter 6. Memorizing Transactions 

Transaction list is S indicates split Cleared Transaction Transaction Transaction group 
alohabetized by transaction. status. amount (if type. number (if assigned -- I 

payee' \ \ memorized). \ \ 
to one). 

\ 

\ 1,075:51 be; 2 
.:. n.,, ".",VU.-"-. 

Chk 1 
* &,heck 

@fees 11 1415-123-4561 eleleph 
!%!E: charge 
Western Bell 

Memo and 
@Category 
information. 

~ 

Figure 6-5. Memorized Transactions List. 

2. 

3. 

4. 

5. 

Select the transaction you want to enter in the Check Register or Write 
Checks screen. Scroll the list up and down using ml, ml, m, 
or 
type the first letter of the payee you want. 

Press the on-screen OK pushbutton. The memorized transaction will 
be entered on your check or in your Check Register entry. 

Or 

Press the on-screen Cancel pushbutton to return to the Write Checks 
screen or Check Register without recalling a memorized transaction. 

Once the memorized transaction is recalled, you can make any changes 
or additions to the transaction as it appears on the screen. 

Press the on-screen Accept pushbutton to record the transaction as 
usual. 

to highlight the transaction you want to recall. You can also 

Quicken tip: If you memorize a check at the Write Checks screen- 
with an address-and then recall it in the Check Register, Quicken 
enters it into the Check Register without the address. 
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Saving time when recalling transactions 

Here’s how you can save time when recalling transactions: 

1. At the Write Checks screen or in the Check Register, before choosing 
Recall Transaction, type the first letter or two of the payee for the 
transaction you want into the Payee field. 

From the Quick Entry Menu, choose Recall Transaction, or press 
(Ctrll +a. Quicken displays its Memorized Transactions List with 
the first transaction that begins with the letters you typed already 
highlighted. 

If the highlighted transaction is the one you want, press the on-screen 
OK pushbutton. If it is not, the one you want should be only one or 
two entries away. Select it by pressing or , and then press the 
on-screen OK pushbutton. 

Press the on-screen Accept pushbutton to enter the transaction you 
want on a check or in a Check Register entry. 

2. 

3. 

4. 

Changing memorized transactions 
To change a memorized transaction, you must first recall the transaction 
from the Memorized Transactions List to the Write Checks screen or the 
Check Register. Then make your changes and rememorize the transaction. 
You cannot make changes to the Memorized Transactions List directly. 

To change a memorized transaction: 

1. Start with a blank check at the Write Checks screen or a blank transac- 
tion in the Check Register. 

From the Quick Entry Menu, choose Recall Transaction. Quicken 
displays the Memorized Transactions List. 

Select the transaction you want to change and press the on-screen OK 
pushbutton. Quicken recalls the information to the blank check or 
Check Register entry. 

Make your changes directly to the transaction at the Write Checks 
screen or in the Check Register. 

From the Quick Entry Menu, choose Memorize Transaction. Quicken 
highlights the information in your check or entry and displays the OW 
Cancel dialog box. 

2. 

3. 

4. 

5. 
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6.  Press the on-screen OK pushbutton. Quicken asks you if you want to 
replace the original transaction with the changed transaction, or if you 
want to add the changed transaction separately to the list and leave the 
original unchanged. 

Press the on-screen Replace pushbutton to replace the transaction, or 
press the on-screen Add pushbutton to add the changed transaction 
separately and leave the original unchanged. Cancel returns you to 
the Write Checks screen or Check Register and no change is made to 
the Memorized Transactions List. 

7. 

Quicken tip: When you change a memorized transaction, you may 
also change its transaction type, depending on the screen where you 
are when you make the change. If you are at the Check Register screen 
when you change a memorized check, the transaction type will be 
changed to Pmt or Dep, depending on the amount. 

Deleting memorized transactions 
Deleting an entire transaction from the Memorized Transactions List is 
easy. You select the transaction you want to delete directly from the 
Memorized Transactions List and delete it. 

To delete a memorized transaction: 

1. From the Quick Entry Menu, choose Recall Transaction. Quicken 
displays the Memorized Transactions List. 

Select the transaction you want to delete. Use the scroll bar or 
m, or click on the appropriate transaction. 

Press the on-screen Delete pushbutton. Quicken warns you that you 
are about to delete a memorized transaction, and gives you the options 
OK and Cancel. 

2. or 

3. 

4. Press the on-screen OK pushbutton to delete the memorized 
transaction. Quicken returns you to the Memorized Transactions List. 
Or 

Press the on-screen Cancel pushbutton to return to the Memorized 
Transactions List without deleting a transaction. 
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Printing the Memorized Transactions List 

To print the list of memorized transactions: 

1. From the Quick Entry Menu, choose Recall Transaction. Quicken 
displays the list of memorized transactions. 

Press the on-screen Print pushbutton in the Memorized Transactions 
dialog box. Quicken displays its Print To dialog box (Figure 6-6). Use 
the Print To dialog box to determine whether you print to the printer 
or a filename on disk, and which Page Setup you use for printing. 
Chapter 14, ChangingSettings, has a full explanation of Page Setup and 
tells how to use the Print To dialog box. 

2. 

F i i e  NM!; 7 1  

w m  
Y 

Figure 6-6. Print To dialog box. 

3. When you are satisfied with your settings on the Print To dialog box, 
press the on-screen OK pushbutton. Quicken begins its printing 
operation. 
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Quicken’s reminder system and the Billminder 

Setting up a Transaction Group 

Executing a Transaction Group 
~ 

Changing a Transaction Group 

Deleting a Transaction Group 

In this chapter you’ll learn how to use Quicken’s Transaction Group 
feature to type in a group of transactions that are repeated periodically. 

Transaction Groups are groups of recurring transactions that you pay or 
add to your account regularly and at the same time. For example, you may 
have a mortgage payment, phone bill, electric bill, and car payment all due 
around the beginning of each month. You can group these transactions, 
and Quicken will remind you when their due date arrives. When you tell 
Quicken to pay them, Quicken types in the entire group for you automati- 
cally, saving you time and keystrokes, and making sure that you enter 
those transactions accurately; yet you retain complete control. Once 
Quicken has entered the transactions, you can edit them or delete any that 
you don’t want to pay at the scheduled time. 

You can set up as many as nine different Transaction Groups. A group can 
contain just a single transaction, such as your weekly paycheck deposit, or 
many, such as your first of the month bills. You can change the groups, 
adding or deleting transactions whenever you want. 
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Quicken’s reminder system and the Billminder 
Quicken has a sophisticated system to remind you of transactions you 
must make. The system reminds you of two important dates: 

1. 

2. 

This chapter describes how Quicken reminds you about Transaction 
Groups. Quicken reminds you the same way about checks that it must 
print. (See Chapter 10, Postdating Checks.) 

Transaction Groups save you time, ensure accuracy, and serve a schedul- 
ing function. They are optional, but useful for recurring expenses for 
which you may not receive bills. For example, you may owe a monthly 
mortgage payment or a quarterly tax payment. You can set up a Transac- 
tion Group (with only one entry) for each of these transactions. Quicken 
then reminds you when you must pay them. 

Whenever Quicken wants to remind you of checks or Transaction Groups 
that are due or are about to come due, it uses the !F9 Messages Menu. The 
Messages Menu works like any other menu except that its menu choices 
change. If you have no messages, when you display the Messages Menu 
the only menu choice will be a grayed out < Empty >. 

When you do have a message, the !F9 button on the menu bar will flash 
and will keep flashing until you read your messages. Then when you pull 
down the Messages Menu by pressing 
menu choice. Select Billminder, and an Alarm Message dialog box will 
appear telling you whether you have checks due or a Transaction Group 
due or both, as in Figure 7-1. After you have read the message, press the 
on-screen OK pushbutton. The message will go away and the !F9 button 
on the menu bar will no longer flash. 

When it is time to print the checks you have postdated. 

When the scheduled date for a Transaction Group arrives. 

you will see a Billminder 

Transaction group due and checks to 
I Choose Open fron File Menu print o display list of accounts, 

Figure 7-1. Alarm Message dialog box. 
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If you are a hard disk user, you will also see a reminder from the Billmin- 
der system when you first turn on your computer if you have checks to 
pay or Transaction Groups due-if you installed the Billminder program 
when you installed Quicken onto your hard disk (see Chapter 1, Getting 
Started). Every time you turn on your computer, the Billminder program 
will check to see if you have checks to pay or Transaction Groups due and, 
if so, will display a message. 

If you don’t use your computer often, you can increase the time the 
Billminder system looks ahead to remind you of upcoming due dates. For 
example, if you use your computer only once a week, you’ll want the 
Billminder system to remind you of any checks or Transaction Groups due 
today or within the next six days. For more information, see Chapter 14, 
Changing Settings. 

Setting up a Transaction Group 
Transaction Groups make it easy for you to enter a number of transactions 
that come due at the same time. They can also serve a valuable scheduling 
function and warn you when payments (for which you may or may not 
receive bills) come due. 

You can set up as many as nine different Transaction Groups. Each 
Transaction Group can hold an unlimited number of transactions. 

To set up a Transaction Group: 

1. Memorize each transaction you want to include in the group. See 
Chapter 6,  Memorizing Transactions. 

2. From the Quick Entry Menu, choose Set Up Transaction Group. 
Quicken displays the Select Transaction Group to Modify dialog box, 
as in Figure 7-2. You use this dialog box to create a new Transaction 
Group or to modify an existing group by adding or deleting a transac- 
tion. 
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IIII 7 (unused) 
8 (unused) 

Figure 7-2. Select Transaction Group to Modify dialog box. 

3. Select the first "unused" group and press the on-screen OK pushbut- 
ton. Quicken displays its Describe Group dialog box, as in Figure 7-3. 

Press an on-screen 
button to select the 
frequency with whi 
you plan to enter th 
group. 

Type in a name 

Enter the next scheduled 
date you plan to enter the 
group. 

Figure 7-3. Describe Group dialog box. 

4. Type in a name for the group of transactions you are entering, for 
example, "Household" or "Payroll." 

Press one of the eight on-screen buttons representing the eight fre- 
quencies. This tells Quicken how often to remind you to enter the 
Transaction Group. Select None if the group has no definite fre- 
quency. 

Type in the next scheduled date that the group is due. From then on, 
Quicken automatically calculates when the next date should be and 
reminds you according to the frequency that you selected in Step 5. 

5. 

6. 
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7. 

You can also type a schedule date for a group with a frequency of 
None. Quicken reminds you when that group is due but will not auto- 
matically reschedule it for you. 

When the scheduled date arrives, Quicken will remind you that the 
group is due as described on page 7-2. I t  does not automatically "exe- 
cute" OY pay the group. You retain complete control over the time when 
bills are actually paid. 

When you are satisfied that the information in the Describe Group 
dialog box is correct, press the on-screen OK pushbutton. Quicken 
displays its Assign Transactions to Group dialog box, as in Figure 7-4. 

* ji. inteiist Internal Revenue Seruic @Taxes Chk 3 li Pacific Telephone Co. Phone service deposit 1U.W Chk 1 
mess space bar to seiect/deselect c u m n t  transaction, mm@m 

I 

Figure 7-4. Assign Transactions to Group dialog box. 

8. Select the transactions you want to assign to the Transaction Group by 
using or to highlight a transaction and then press the space bar 
to assign it to the group. You can also assign a transaction to a group 
by double-clicking on it with the mouse. When you assign a transac- 
tion to the group, the group number appears in the G y p  column. Press 
the space bar or double-click again to unassign a particular transaction. 

When you have assigned all the transactions you wish to the group, 
press the on-screen OK pushbutton. You have created a Transaction 
Group. Press the on-screen Cancel pushbutton to leave the Assign 
Transactions to Group dialog box without assigning any transactions. 

9. 

Quicken tip: You can assign a memorized transaction to more than one 
group. To do this, memorize the transaction twice so that it appears on the 
Memorized Transactions List twice. Then assign one of the memorized 
transactions to one group, and the remaining one to another. 
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Executing a Transaction Group 
When you execute a Transaction Group, Quicken records the transactions 
of the group in the Check Register. You can then make any changes you 
need to make, such as adding or changing dollar amounts. If the transac- 
tions are checks, you can print them the same way you would print any 
check you‘ve written with Quicken. Executing a group tells Quicken to 
enter the entire group automatically in the Check Register. 

To execute a Transaction Group: 

1. Choose Execute Transaction Group from the Quick Entry Menu. If 
you are not currently in the Check Register, Quicken will take you 
there. Quicken then displays the Select Transaction Group to Execute 
dialog box, as in Figure 7-5. 

Figure 7-5. Select Transaction Group to Execute dialog box. 

2. Select the group you want to execute. You can click on the group or 
use 

Press the on-screen OK pushbutton when you have selected a Transac- 
tion Group. Quicken displays the Transaction Group Date dialog box 
showing the scheduled date for the group you have selected, if there is 
one, or else today’s date. 
Or 

If you press the on-screen Cancel pushbutton, Quicken does not 
execute the Transaction Group and returns you to the Check Register. 

or to select the group. 

3. 
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4. Press the on-screen OK pushbutton to accept the scheduled date. You 
can change the scheduled date, if you wish. Quicken applies this date 
to all transactions in the group, and enters the transactions into the 
Check Register for you. The Transaction Group Entered dialog box 
appears, reminding you to review the transactions just entered and 
make any changes necessary. 
Or 
Press the on-screen Cancel pushbutton and return to the Check 
Register without entering any Transaction Group information. 

Press the on-screen OK button. The Transaction Group Entered 
dialog box disappears. If you wish to change the information in any of 
the group’s transactions, you can do so now, exactly as you would 
modify any other transaction you have already entered. (All Quicken 
has done is type them in for you.) Don’t forget to press the on-screen 
Accept pushbutton to record the changes you make. 

5. 

To print any checks in the Transaction Group: 

1. Choose Write Checks from the Activities Menu. Quicken displays the 
Write Checks screen. 

From the File Menu, choose Print Checks and print the checks as 
usual. For more information on printing checks, see Chapter 4, Print- 
ing Checks. 

2. 

Quicken tip: If a check that has been entered as part of a Transaction 
Group does not print when you select Print Checks, it may be that its 
transaction type, as displayed in the Memorized Transactions List, is 
Pmt for payment, not Chk for check. See page 6-9 for instructions on 
how to change the type of a memorized transaction. 

Changing a Transaction Group 
Once you have set up a Transaction Group, you can add or remove transac- 
tions from it or change the name, frequency, or next scheduled date of the 
group whenever you wish. 

To change an existing group: 

1. In the Check Register or at the Write Checks screen, memorize any 
transactions you want to add. See Chapter 6, Memorizing Transactions. 
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2. Choose Set Up Transaction Group from the Quick Entry Menu. 
Quicken displays the Select Transaction Group to Modify dialog box. 

Select the existing group you want to change. You can click on it or 
use 

Press the on-screen OK pushbutton. Quicken displays its Describe 
Group dialog box. The dialog box shows the current settings for 
Name, Frequency, and Next scheduled date. Make any alterations to 
these settings that you wish. For example, you may wish to rename an 
existing group. 

5. Press the on-screen OK pushbutton. Quicken displays the Assign 
Transactions to Group dialog box. The Assign Transactions to Group 
dialog box lists all the memorized transactions you can assign to a 
Transaction Group. 

Assign new transactions to the Transaction Group by clicking on or 
pressing the space bar on each one. You can unassign a transaction by 
clicking on or pressing the space bar a second time. Quicken acknowl- 
edges each assignment by placing or removing the number of the 
group in the Grp column. 

When you have completed adding or removing transactions from the 
group, press the on-screen OK pushbutton. Quicken saves your 
changes and returns you to the Check Register or Write Checks screen. 

3. 
or to highlight the group. 

4. 

6.  

7. 

Deleting a Transaction Group 
When you delete a Transaction Group, you remove it permanently from 
your records. However, the memorized transactions included in that 
group remain in the Memorized Transactions List. 

To delete a Transaction Group: 

1. In the Check Register or at the Write Checks screen, choose Set Up 
Transaction Group from the Quick Entry Menu. Quicken displays its 
Select Transaction Group to Modify dialog box. 

Select the Transaction Group you want to delete. You can click on it or 
use 

3. Press the on-screen Delete pushbutton. Quicken displays a box that 
warns you that you are about to delete the Transaction Group perma- 
nently. 

2. 
or to highlight the Transaction Group. 
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4. Press the on-screen OK pushbutton in the warning box. Quicken 
deletes the transaction you have specified. The Select Transaction 
Group to Modify dialog box remains on the screen so you can delete 
another Transaction Group if you wish. 
Or 

You can press the on-screen Cancel pushbutton and return to the 
Transaction Group to Modify dialog box without deleting the Trans- 
action Group. 

When you have deleted all the Transaction Groups you wish, press the 
on-screen Cancel pushbutton in the Select Transaction Group to 
Modify dialog box. Quicken returns you to the Check Register or the 
Write Checks screen. 

5. 

Quicken User Manual 7-9 



Chapter 7. Transaction Groups 

7-10 Quicken User Manual 



Chapter 8 

Why use Quicken's @Category feature to categorize transactions? 

Overview of @Categories 
~ 

Setting up @Categories 

Categorizing transactions 

Assigning transactions to subcategories 

Deleting @Categories from the @Category List 

Changing @Category names and descriptions 

Requiring @Categories in all transactions 

Printing the @Category List 

This chapter explains how Quicken's @Category (pronounced "At-cate- 
gory") feature works. @Categories are a specific way of classifying your 
transactions so that Quicken can produce reports on various aspects of 
your finances. Categorizing your transactions using the @Category feature 
can help you with taxes, budgeting, and maintaining a chart of accounts- 
that is, a list of categories for income and expenses. (If you are familiar 
with accounting terms, note that @Categories are synonymous with 
accounts, as in a chart of accounts. Quicken uses the term "@Categories" 
to avoid confusion with the term "bank accounts.") 

@Categories are highly flexible and much easier to use than the rigid 
category structures found in most traditional finance and accounting 
software. With @Categories, you can name your categories using words, 
numbers, or characters in any combination. You can set up @Categories 
beforehand, or you can set them up as you type in transactions. You can 
type @Categories into all your transactions or into just a few. You can 
create your own list of @Categories, use one of the sets of @Categories 
provided on the Quicken program disk, or copy one of the lists suggested 
in Chapters 15,16, and 17 of this manual. 
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Before you actually set up a system of categorizing transactions, you might 
want to scan Chapter 11, Reports, and Chapters 15,16, and 17 on Home Uses 
of Quicken and Business Uses These chapters show examples of how 
valuable the @Category feature can be. 

Why use Quicken’s @Category feature to 
categorize transactions ? 

Although you can use an entry into the Memo field of each check to 
categorize your transactions, @Categories have three distinct advantages: 

@Categories allow you to take full advantage of Quicken’s extensive 
Reports feature. Some Quicken reports are specially designed to sort 
and total transactions by @Categories. If you have not categorized 
your transactions using the @Category feature, you won’t be able to 
use these reports. 

@Categories save you time. You can select an @Category from the 
@Category List and Quicken will type it in the Memo field for you 
automatically, saving you keystrokes. 

@Categories prevent you from miscategorizing a transaction because 
you have mistyped or misspelled the @Category name. Whenever you 
categorize a transaction using the @Category feature, Quicken checks 
the @Category List. If there is no such @Category in the list, Quicken 
will alert you and ask you to select an existing one from the list or to 
add the @Category you have just typed to the list. 

Overview of @Categories 
You categorize a transaction by typing an ”at” sign (@I followed by a 
category name into the Memo field of the check or transaction. You can 
categorize transactions at the Write Checks screen, in the Check Register, 
or in the Split Transaction dialog box. 

Quicken adds each new @Category to the @Category List. When you type 
an @Category into the Memo field of a transaction, Quicken checks to see 
if the Wategory you‘ve typed already exists in the @Category List. If not, 
Quicken alerts you and gives you an opportunity to select another @Cate- 
gory from the list or to add the new @Category you typed to the list. This 
guards against mistyping @Categories-for example, typing “@utility” 
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instead of ”@utilities.” You can change or delete @Categories and view the 
@Category List whenever you wish by choosing Recall @Category from 
the Quick Entry Menu: 

The number of @Categories you can set up depends on three factors: 

How much available RAM your computer has. 

The length of your @Category names and descriptions. 

The number and the size of the memorized transactions in your 
Memorized Transactions List. 

Most users will have room for hundreds of categories. 

@Categories can be very specific or very general. You can have an K a t e -  
gory called ”@utilities” for keeping track of the gas, electric, and water bills 
you pay, or you can have an @Category called ”@household” for keeping 
track of all the expenses incurred in running your home. You can assign a 
single transaction to more than one @Category. For example, you may 
include your electric bill payment in both the “@utilities” and the 
”@household” @Categories. See the section on “Assigning transactions to 
subcategories” on page 8-9 for important information on this subject. 

Setting up @Categories 
There are two ways to set up @Categories. You can set them up by them- 
selves (without typing in any specific transaction), or you can set them up 
as you type in transactions. You can use one method or the other or both 
in combination. 

Setting up @Categories by themselves 

To enter a set of @Categories independent of any specific transaction, you 
can start from either the Write Checks screen or the Check Register. 

1. Choose either Write Checks or Check Register from the Activities 
Menu. Quicken displays the screen you selected. 

From the Quick Entry Menu, choose Memorize @Category. You can 
also press ICtrl] +m. Quicken displays its Memorize @Category 
dialog box, as in Figure 8-1. 

2. 
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Type in the name of the @Category 
here. For example, @UTIL or 
@MORT. 

Type in an optional explanation of the 
name. @UTIL becomes “Water and 
Electricity.” \ / 

\ 
@Category Name: 
Description (optional): 

I 
Figure 8-1. Memorize @Category dialog box. 

3. Type in an @Category name. The name can be up to 15 characters long 
(not counting the @), and can include numbers, letters, and other 
characters in any combination you want. You need not type the @ sign 
in front of the name. Quicken adds that for you. If you use more than 
one word, Quicken inserts an underline character between the words 
for you (for example, Office Supplies becomes @Office-Supplies). 

Select the Description field if you wish and type in a description of the 
@Category. The description is optional but is often useful to give a 
more helpful explanation of the @Category than will fit in the 15- 
character name. The description can be up to 25 characters long. 

In @Category or Budget Reports, Quicken prints the description, if there 
is one, rather than the @Category name (this makes the reports more 
readable). 

4. 

5. When you are satisfied with your @Category name and description (if 
any), press the on-screen OK pushbutton to add the @Category to 
Quicken’s @Category List. You can view this list by choosing Recall 
@Category from the Quick Entry Menu. 
Or 
Press the on-screen Cancel pushbutton to leave the Memorize @Cate- 
gory dialog box without memorizing an @Category. 

Quicken tip: The description is optional and often you won’t need to use 
it . An @Category such as @Groceries, for example, is already descriptive 
enough. However, a description does allow you to provide more informa- 
tion about an @Category. For example, @D&I is quick to type-but 
unclear. The description ”Dividends and Interest” is clearer and more 
immediately recognizable when it appears in reports. If you are using 
Quicken in your business, you might want to use numbers or abbrevia- 
tions for your @Categories (for example, @431-A) and then use the descrip- 
tion to tell what the @Category means. 
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Setting up @Categories as you type in transactions 

You can set up your @Categories as you type information into Quicken. 
This method is useful when you’re not yet sure you’ve thought of all the 
categories you may want to create. 

Quicken tip: While this kind of ”spur of the moment” entry makes 
Quicken extremely flexible, you must be careful not to create two @Catego- 
ries that refer to the same thing-@UTIL one month and @UTILITIES the 
next. A good practice is to check the @Category List for duplicates before 
setting up a new Category. 

To set up @Categories as you type in transactions: 

1. Type in your transaction as usual. Anywhere in the Memo field, type 
an @ sign, followed immediately by the name you want to give the 
new @Category, for example, @MORT. 

The name can be up to 15 characters long, and can include numbers, 
letters, and other characters in any combination. If you want to use 
two words for the name, type an underline character (-) between the 
words so that Quicken recognizes them as part of a single @Category. 

Press m. Because this is an @Category that Quicken does not recog- 
nize, it displays the @Category Not Found dialog box (see Figure 8-2). 

2. 

Do ou want to  add th i s  @Category 
to !he K a t e  ory l i s t ,  or select  an 
existing @Cafegory froM the l i s t ?  

- - # g a m  .I.......I. ..... ............ lllllll..........lllII...... ....,,.l.l..lll,,lllllllllll 

Figure 8-2. @Category Not Found dialog box. 

3. Press the on-screen Add pushbutton to have Quicken add the new 
@Category to the @Category List. Quicken displays its Adding 
@Category dialog box (see Figure 8-3). 
Or 

Press the on-screen Select pushbutton if you have simply made a 
typing error and wish to select an existing @Category from the list. 
Or 
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Press the on-screen Cancel pushbutton to return to the Check Register 
or Write Checks screen without creating a new @Category. In this 
case, you must delete the unrecognized @Category or change it into an 
@Category that Quicken does recognize (or add the @Category as a 
new one) before you can record the transaction. 

Description (optional): [Interest Earned I 
Figure 8-3. Adding @Category dialog box. 

4. Type in a description for the new @Category, if you wish. The descrip- 
tion can be up to 25 characters long. 

Press the on-screen OK pushbutton to memorize the new @Category 
and description. You can view your new @Category in the @Category 
List by choosing Recall @Category from the Quick Entry Menu. 

Or 

Press the on-screen Cancel pushbutton to return to the Check Register 
or Write Checks screen without creating a new @Category. In this 
case, you must delete the unrecognized @Category or change it into an 
@Category that Quicken does recognize (or add the @Category as a 
new one) before you can record the transaction. 

5. 

Categorizing transactions 
There are two ways to categorize transactions using @Categories. You can 
recall the @Category you want from the @Category List, or you can type 
the @Category directly into the Memo field. You can use either method, or 
both. Note that you can type both an @Category and any other memo in 
the Memo field. 

To recall an @Category: 

1. Start at the Write Checks screen, Check Register screen, or Split 
Transaction dialog box. (See Chapter 9, Split Transactions.) 
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2. Position the cursor in the Memo field where you want Quicken to type 
in the @Category for you. Make sure it is at least a space away from 
anything else typed into the Memo field. If your cursor is not in the 
Memo field when you recall an @Category, Quicken erases the Memo 
field and places the @Category at the beginning of the Memo field. 

From the Quick Entry Menu, choose Recall @Category. You can also 
press 
dialog box, as in Figure 8-4. 

3. 
+m. Quicken displays the Memorized @Categories 

Ill Interest Earned 
Int-Paid Interest Paid 

RT Mortgage 
e-Suppl ies  
ipal Principal on Hortgage 

Uater and Electricity 

Figure 8-4. Memorized @Categories dialog box. 

4. Highlight the @Category you want. If your list of @Categories is long, 
you can use m] and m1. Or, click with the mouse on the up and 
down arrows at the top of the list box to see the entire list. 

5. Press the on-screen OK pushbutton. Quicken enters the @Category 
you chose on your check, Check Register transaction, or into the Split 
Transaction dialog box. 

Or 

Press the on-screen Cancel pushbutton. Quicken returns you to the 
Write Checks screen, Check Register, or Split Transaction dialog box 
without entering an @Category. 

Quicken tip: You can speed Quicken’s recall by typing the first letter or 
two of the Wategory at the beginning of the Memo field. You need not 
type the @ sign. When you display the @Category List, Quicken highlights 
the @Category that comes closest alphabetically to the letters you’ve typed. 
For example, if you have two categories, @Groceries and @Utilities, and 
type a U, Quicken highlights the @Utilities @Category. 
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To type an @Category into the Memo field: 

1. Type the information you want on a check or in a Check Register trans- 
action, or display the Split Transaction dialog box (see Chapter 9, Split 
Transact ions). 

Type the @Category you want to use into the Memo field on the Write 
Checks screen, Check Register screen, or Split Transaction dialog box. 
Be sure to type the @ sign first; for example, type @T&E or @Salary. 
You must type the @ sign or Quicken will recognize your entry only as 
a memo and not an @Category. 

Press the on-screen Accept pushbutton. Quicken checks to see if the 
Category you have typed is in the @Category List. 

2. 

3. 

If Quicken finds the Category in the list, the transaction is 
recorded as usual, and you can proceed to your next transaction. 

If Quicken does not find the @Category in the list (perhaps you 
mistyped it), the @Category Not Found dialog box is displayed 
(Figure 8-2, above). 

4. To select an existing @Category from the list, press the on-screen 
Select pushbutton on the @Category Not Found dialog box. Quicken 
displays its Memorized @Categories dialog box. 

Highlight the @Category you want. If the list of @Categories is long, 
you may need to use ml or wl. Or, click with the mouse on the 
up and down arrows at the top of the list box to see the entire list. 

Press the on-screen OK pushbutton, or press P I .  Quicken types 
your selected @Category into the Memo field of the transaction. 

Or 

Press the on-screen Cancel pushbutton. Quicken will not type an 
Category into the Memo field. 

5. 

6. 

To add a new @Category to your list, follow the instructions in the 
section "Setting up @Categories," on page 8-3. 

Quicken tip: Categorizing items in a split transaction is an excellent use of 
Quicken's @Categories. It enables you to keep detailed track of your 
finances. If you use regular (nonvoucher) checks, you can also use the 
Split Transaction dialog box for @Categories you don't want printed on 
your checks. Choose Split Transaction from the Edit Menu and type the 
@Categories into the Memo column. 
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Assigning transactions to subcategories 
Subcategories are useful if you want your reports to group and subtotal 
similar @Categories. For example, you might assign the checks you write 
to pay your utility bills to two @Categories each: @Utilities and either 
@Phone, &as, or @Electric. Thus, your check to AT&T would have 
@Utilities @Phone in the Memo field. Quicken can then produce reports 
giving you subtotals for each subcategory (@Phone, @Gas, and @Electric) 
plus a sum total for the larger @Category (@Utilities). If you want, you can 
even have more levels of subcategories with subcategories of subcategories 
by stringing more categories together in the Memo field. For most people, 
a single category or a category and a subcategory is enough, however. 
Note: Quicken’s Budget Report does not show subcategories. 

Quicken tip: The order in which multiple @Categories appear in the 
Memo field affects the way they appear in Quicken reports. Quicken 
organizes @Category and Budget reports by the @Category that appears 
first in the field. To understand how this affects the reports, read Chapter 
11, Reports, before you begin assigning multiple @Categories. The ex- 
amples in the Reports chapter will help you to understand the implications 
of @Category order. 

Some rules for assigning transactions to subcategories 

Here are some things you should keep in mind when you assign transac- 
tions to subcategories: 

Separate the category and subcategory by at least one space in the 
Memo field. 

If you are creating subcategories, always put the primary category first 
and the subcategory second. For example, @Utilities @Electric. 

Keep the order of your @Categories consistent. For example, always 
put @Utilities before @Electric. Decide on an order that makes sense 
for you (given the kinds of reports you want to get) and stick with it. 

In a split transaction with @Categories in both the Memo field and in 
the splits, Quicken treats the @Categories in the Memo field as if they 
were inserted at the beginning of each line in the split. For example, if 
you type @Utilities in the Memo field of the transaction with splits of 
@Water on one line and @Gas on the next, Quicken treats the transac- 
tion exactly as if the Memo field were blank and the two lines of the 
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split were @Utilities @Water and @Utilities @Gas. Whether you type 
@Utilities once, in the Memo field, or twice, at the beginning of each 
split, is up to you. To Quicken, they’re equivalent. For more informa- 
tion on split transactions, see Chapter 9, Split Transactions. 

Experiment with the kinds of reports you want to produce before 
assigning many of your transactions to multiple @Categories. In this 
way, you’ll learn how to get the results you want without wasting 
time. 

The more levels of subcategories you use, the wider some of the 
reports you create will become, since Quicken indents every time it 
subtotals a category or subcategory. You may want to experiment 
before committing yourself to using multiple levels of subcategories. 

Quicken’s Budget Reports do not show subcategories. 

Deleting @Categories from the @Category List 
When you delete an @Category from the @Category List, you remove it 
from the list-but not from any transactions in which that @ Category 
name already appears. You can remove the @Category names from 
transactions by editing the transactions in the Check Register. 

To delete an @Category from the @Category List: 

1. From the Write Checks screen or the Check Register, choose Recall 
@Category from the Quick Entry Menu. You can also press 

+m. Quicken displays its Memorized @Categories dialog box. 

2. Select the @Category you want to delete. If the list is long, you may 
need to use ml or m l .  Or, click with the mouse on the up or 
down arrows at the top of the list box to see the entire list. 

Press the on-screen Delete pushbutton. You can also press ma, 
Quicken asks you to confirm the deletion. 

Press the on-screen OK pushbutton to confirm the deletion or press the 
on-screen Cancel pushbutton to return to the Memorized’ @Categories 
List. 

Remember to edit any transactions in the Check Register that have the 
@Category in their Memo fields. Either remove the @Category or 
change it to another. Use Quicken’s Find feature to quickly find all 
occurrences of the old @Category name in your Check Register. 

3. 

4. 
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Changing @Category names and descriptions 
You can change @Category names by adding the new name and deleting 
the old name from the @Category List. However, this does not automati- 
cally change transactions in the Check Register that have the old @Cate- 
gory name. You must find transactions with the old @Category name 
using the Check Register’s Find feature and change them to the new 
@Category name. 

To change an @Category name: 

1. Delete the old @Category name from the @Category List, following the 
directions in the section ”Deleting @Categories from the @Category 
List,” on page 8-10. 

Add the new @Category name to the @Category List, following the 
directions in the section ”Setting up @Categories,” on page 8-3. 

Choose Check Register from the Activities Menu to display the Check 
Register. Use Quicken’s Find feature to locate transactions in the 
Check Register that use the old @Category name (see Chapter 5, Using 
the Check Register) and change them to use the new @Category name. 

2. 

3. 

To change an @Category description: 

1. From the Write Checks screen or the Check Register, choose Recall 
@Category from the Quick Entry Menu. You can also press 

+m. Quicken displays its Memorized @Categories dialog box. 

2. Select the @Category you want to change. If your list is long, you may 
need to use or or click with the mouse on the up and 
down arrows at the top of the list box to see the entire list. 

Press the on-screen Edit pushbutton. Quicken displays the Editing 
@Category dialog box. 

3. 

4. Make any editing changes you like to the description. Press the on- 
screen OK pushbutton. Quicken closes the Editing @Category dialog 
box, saves the new description, and returns you to the Memorized 
@Categories dialog box. 

Press the on-screen OK pushbutton in the Memorized @Categories 
dialog box to recall the @Category, or press the on-screen Cancel 
pushbutton to return to the Write Checks screen or Check Register 
without recalling an @Category. 

5. 
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Requiring @Categories in all transactions 
You can change Quicken’s settings so that the program requires you to 
categorize all new transactions. This is useful to ensure that every transac- 
tion you enter is assigned to an @Category. To learn how to set Quicken 
to require @Categories, see Chapter 14, Changing Settings. 

Printing the @Category List 
You can print your list of @Categories. 

To print the @Category List: 

1. Choose Recall @Category from the Quick Entry Menu. Quicken 
displays the Memorized @Categories dialog box. 

Press the on-screen Print pushbutton in the Memorized @Categories 
dialog box. Quicken displays its Print To dialog box. Use the Print To 
dialog box to determine whether you print to the printer or to a file on 
disk, and which Page Setup you use for printing. For a full 
explanation of Page Setup and how to use the Print To dialog box, see 
Chapter 14, Changing Settings. 

When you are satisfied with your settings on the Print To dialog box, 
press the on-screen OK pushbutton. Quicken begins printing. 

Press the on-screen Cancel pushbutton or press to halt 

2. 

3. 

printing. 

8-12 Quicken User Manual 



Chapter 9 

Split Transactions c3o 
Selecting the Split Transaction feature 

Using the Split Transaction feature as an adding machine 

Reviewing, changing, and deleting split transactions 

Zero-amount transactions: Using split transactions to keep track of non- 
checking account expenses 

Using split transactions for extra memo room 

A split transaction is a single transaction that consists of more than one 
item. For example, suppose you write a check for a mortgage payment 
that includes interest, principal, insurance, and taxes. Quicken lets you 
split the transaction so that in addition to having a record of the check, you 
have a record of each individual expense @Category covered by the check. 
Quicken saves these records in the Check Register. If you use voucher 
checks, Quicken prints the split information on the voucher. 

You can review, change, delete, or add splits whenever you want. In 
addition, you can use the Split Transaction feature as a way of adding 
longer memos to checks or other transactions. 

You’ll find that split transactions are a good way to keep detailed records 
of income and expenses. Used in combination with Quicken’s @Categories 
and Reports features, they are a valuable tool for financial reporting, 
budgeting, and keeping tax records. 
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Selecting the Split Transaction feature 
You can split transactions at the Write Checks screen or in the Check 
Register. You split transactions by typing items and amounts into the Split 
Transaction dialog box. 

To split a transaction: 

1. Type in the payee or description, amount, memo, and other informa- 
tion for the transaction as you normally would. 

2. Choose Split Transaction from the Edit Menu. You can also press 
m + m .  Quicken displays its Split Transaction dialog box, as in 
Figure 9-1. Quicken opens the dialog box, which already shows the 
total amount of your transaction, and positions the cursor in the Memo 
column at line #l. 

Type in the dollar amount of each split. 

Type in the individual 
splits for the transac- 
tion, one to a line. 

Room for 15 splits. 
Quicken displays six at 
a time, and scrolls the -..- 
list for you when 
needed. 

II ltul 

Figure 9-1. Split Transaction dialog box. 

3. Type in the first @Category or memo information you want to include 
in the split. 

Press m to move the cursor to the Amount column. 

Type in the amount of the first item. Don’t worry if an amount is 
already in the column; type right over it. 

4. 

5. 

6. Press to select the next line in the Memo column. Quicken 
moves the cursor and automatically subtracts the amount of the first 
entry from the total amount of the transaction. It displays the remain- 
der on the next line in the Amount column. 
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7. Continue to add @Category or memo information and amounts in this 
way. You may split a transaction in as many as 15 different parts. 

When you are satisfied with your entries, press the on-screen OK 
pushbutton. Quicken returns you to the Check Register or Write 
Checks screen, where you can finish typing in the information for the 
transaction and then record it. 
Or 
Press the on-screen Cancel pushbutton to return to the Check Register 
or Write Checks screen without splitting the transaction. 

8. 

When a transaction has been split, the word SPLIT appears under the 
check number in the NUM column of the Check Register. On the Write 
Checks screen, the word SPLIT appears to the right of the Memo field. 
This is a reminder. The word SPLIT does not appear on the printed check. 
The contents of the split print on the voucher portion of voucher checks. 
Split information does not print on regular checks. 

Quicken tip: Use the Memorize feature to save split ”templates” that you 
use frequently. Then you need type only the amounts for each transaction 
and not the words. See the example in the ”Payroll” section of Chapter 17. 

Using the Split Transaction feature 
as an adding machine 

Quicken’s Split Transaction feature can act as an adding machine. This is 
useful when you are writing a single check to cover several items or 
depositing a number of checks in one deposit. 

To have Quicken add amounts: 

1. Press lTabl as necessary to move the cursor to the Amount field and to 
select (highlight) the contents of the field. In the Check Register, select 
either the Payment field or the Deposit field, depending on whether 
you want to add up payments or deposits. With a mouse, simply click 
on the field to move the cursor there and to select the contents. 

2. With the contents of the Amount field selected, choose Split Transac- 
tion from the Edit Menu. You can also press [Ctrll+a. Quicken 
displays the Split Transaction dialog box. 
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3. Type in the individual items and their amounts. Quicken acts as an 
adding machine, updating the highlighted amount on the check or 
Check Register transaction with the running total of the amounts you 
enter. 

When you have finished entering the individual amounts, press the 
on-screen OK pushbutton to save the split information and return you 
to the Check Register or Write Checks screen. 
Or 
Press the on-screen Cancel pushbutton. Quicken returns you to the 
Check Register or Write Checks screen without saving the split infor- 
mation. The sum of the splits, however, is not lost and remains in the 
Amount field. 

4. 

Reviewing, changing, and deleting 
split transactions 

You can review, change, and delete the splits you have assigned to your 
transactions whenever you want. 

To review existing split transactions: 

1. Select the transaction whose split you want to review. See Chapter 5, 
Using the Check Register. 

From the Edit Menu, choose Split Transaction. You can also press 
m+n. Quicken displays the Split Transaction dialog box, 
showing the split information for the transaction you have selected. 

2. 

3. Check the on-screen scroll arrows or use and to scroll through 
the splits. 

When you have finished, press the on-screen Cancel pushbutton. 
Quicken returns you to the Check Register or Write Checks screen. 
You can also press the on-screen OK pushbutton, but if you have made 
any inadvertent changes to the list of split transactions, Quicken will 
accept them. When just reviewing your splits, pressing Cancel is safer 
than pressing OK. 

4. 

To change existing split transactions: 

1. 

2. 

Select the transaction whose split you want to change. 

From the Edit Menu, choose Split Transaction. You can also press 
m + m .  Quicken displays the Split Transaction dialog box, 
showing the split information for the transaction you have selected. 
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3. 

4. 

5. 

Click the on-screen scroll arrows or use or to select the line of 
information you want to change. 

Use highlighting, overtyping, or deleting to change any information 
you wish. If you change an amount, Quicken will recalculate the 
remainder or add a new split line in order to keep the sum of the splits 
equal to the amount of the transaction. 

Press the on-screen OK pushbutton. Quicken changes the split trans- 
action information and returns you to the Write Checks or Check 
Register screen. 
Or 
Press the on-screen Cancel pushbutton. Quicken returns you to the 
Write Checks or Check Register screen without changing any of the 
split transaction information. 

To delete existing split transactions: 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Select the transaction whose splits you want to delete. 

From the Edit Menu, choose Split Transaction. You can also press 
m + m .  Quicken displays the Split Transaction dialog box. 

Click the on-screen scroll arrows or use or to select the Memo 
column of the split you want to delete. 

Press 
Amount column. 

Press to delete the amount. 

When you have finished deleting the splits, press the on-screen OK 
pushbutton. Quicken saves the new list of splits and returns you to the 
Check Register or Write Checks screen. If you have deleted all the 
splits from the Split Transaction dialog box, Quicken removes the 
word SPLIT from the NUM column of the Check Register or from the 
unprinted check, depending on where you are. 
Or 
Press the on-screen Cancel pushbutton to return to the Check Register 
or Write Checks screen without deleting any of the split transaction 
information. 

Press the on-screen Accept pushbutton to record the changed transac- 
tion. 

to delete the Memo field. Press a to move to the 
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Zero-amount transactions: Using split transactions 
to keep track of non-checking-account expenses 

You can use split transactions to keep track of non-checking-account 
expenses or income-such as cash expenditures or income or credit card 
transactions-that you want to include in a report later on, but which don’t 
affect your checking account balance. 

What zero-amount transactions do 

You can use a zero-amount transaction to enter checking account transac- 
tions for categorization and inclusion in reports without affecting your 
checking account balance. 

For example, say you donate $20 cash to a charity. You want to keep a 
record of the donation, but because it was cash and does not affect your 
checking account balance, you cannot simply enter it as a $20 payment to 
@Charity in the Check Register. Instead, enter the transaction into the 
Check Register with an amount of zero so that your account balance is not 
affected. Then split that zero amount into a $20 payment to @Charity and 
an offsetting $20 deposit to, say, @Offset. The total of the splits then adds 
up to zero, the amount of the transaction. When you later do a report, you 
can limit the report to @Charity transactions, or to everything except 
@Offset transactions. For more information on reports, see Chapter 11. 

To use zero-amount transactions: 

1. Type a transaction into the Check Register, using a descriptive phrase 
such as ”cash expenses” in the Payee column. 

2. Choose Split Transaction from the Edit Menu. You can also press 
m+a. Quicken displays the Split Transaction dialog box. 

Type the @Category for the transaction in the Memo column. Press 3. 
to move the cursor to the Amount column. 

4. Enter the amount of the transaction. If the transaction is a payment or 
an expense, enter the amount as a negative number. If the transaction 
is income, enter the amount as a positive number. Press a to move 
the cursor to the Memo column of the next split. Notice that Quicken 
has entered the same amount with the opposite sign in the Amount 
column of the next split. 
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5. Type an @Category for the offsetting amount, say, @Offset. It doesn’t 
matter what you call this, but you should use the same @Category for 
all the offsets in all your zero-amount transactions. This will make it 
easy for you to restrict your reports to all @Categories except @Offset. 

Press the on-screen OK pushbutton to save the splits and return to the 
Check Register. 

Press the on-screen Accept pushbutton to record the zero-amount 
transaction in the Check Register. 

6.  

7. 

The information that the split transaction contains is available for any 
reports you want to create, but the amount does not affect the balance in 
your checking account. For more information on using this feature, see 
Chapters 15,16, and 17, Home Uses of Quicken and Business Uses For 
information on reports, see Chapter 11. 

Using split transactions for extra memo room 
You can use the Split Transaction dialog box as a notepad to gain extra 
room for memos. You can use it to add a memo that is more than 30 
characters long to your check or other transaction. 

To use split transactions for memos: 

1. Choose Split Transaction from the Edit Menu. You can also press 
m+B.  Quicken displays the Split Transaction dialog box. 

Type your memo in the Memo column of the Split Transaction dialog 
box. When you reach the end of a line, press lTabl twice to move to 
the next line. 

2. 

3. When you have entered your long memo, press the on-screen OK 
pushbutton. Quicken returns you to the Write Checks screen or Check 
Register. The word SPLIT appears in the NUM column of the Check 
Register or on the unprinted check, depending on where you are. 

If you use voucher checks, Quicken prints the contents of the Split Trans- 
action dialog box on the voucher. 
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0 cl Chapter Postdating lo  Checks LID 
Writing postdated checks 

~~ _ _ _ ~  

Printing postdated checks 

Reminders of transactions coming due 

Adding postdated transactions to the Check Register 

Using postdating for accounts payable 

This chapter explains how Quicken’s Postdating feature works. Postdat- 
ing is useful for entering bills you have received but don’t want to pay 
until later. Business users can use this feature to keep track of their ac- 
counts payable and to manage cash flow. You can postdate checks at the 
Write Checks screen or postdate transactions in the Check Register. The 
amounts of these checks and transactions do not affect the current balance 
in your account until their date comes due. 

When you postdate transactions, Quicken shows how much is currently in 
your account (Current Balance) and how much will remain when all 
postdated items-whether payments or deposits-take effect (Ending 
Balance). If you write postdated checks, Quicken reminds you when it’s 
time to print them. 

You’ll find postdating a convenient and useful feature. You can use it to 
anticipate deposits that will be made automatically to your account-such 
as payroll, annuity, or Social Security payments-or to write checks for all 
your monthly bills in one session. Since Quicken keeps a running tally of 
your current and ending balances, you’ll have an accurate picture of the 
financial status of your account both now and in the future. Postdating can 
help you anticipate cash flow problems and manage your finances better. 
Used in conjunction with Quicken’s Reports feature, it can produce instant 
accounts payable reports. 
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Writing postdated checks 
Writing postdated checks is easy. In fact, except for changing the date, it’s 
the same as writing regular checks with Quicken. 

To write a postdated check: 

1. Choose Write Checks from the Activities Menu. Quicken displays a 
blank check. 

2. Change the current date that Quicken automatically put on the check 
to the date in the future that you want to print the check. 

Fill in the fields of the check as usual. See Chapter 3, Writing Checks, 
for more details. 

3. 

4. Press the on-screen Accept pushbutton to record the check. You can 
also press PI. 

Notice that Quicken now displays a Current Balance in the lower-left 
corner of the screen and an Ending Balance in the lower-right corner of the 
screen. The Current Balance is the amount you have in your account as of 
today. The Ending Balance is the amount you will have in your account 
when all the postdated transactions (as well as the currently dated ones) 
are paid. 

Postdated transactions appear in the Check Register separated from other 
transactions by a double line called the Today Line. 

Printing postdated checks 
When the date of a postdated check arrives, Quicken automatically in- 
cludes the check in the list of checks to be printed. 

Figure 10-1 shows the Print Checks dialog box. The Print checks dated 
through setting defaults to the current date. Quicken prints all checks 
dated on or before this date. 
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Print checks dated 
through always shows the 
current date. Change this 
date to print postdated 

Print checks dated I Starting check number: 
I Regular Checks 
dJ Uoucher Checks I checks. I 

For help i n  positioning checks, press Sample, 

Figure 10-1. The Print checks dated through setting. 

To print postdated checks that have fallen due: 

In the Print Checks dialog box, leave the date in the Print checks 
dated through setting at today’s date. Press the on-screen Print 
pushbutton. Quicken prints all checks bearing dates up to and includ- 
ing the current date-this includes all postdated checks that have 
fallen due. 

To print postdated checks that have not fallen due: 

Change the date in the Print Checks dated through setting to the date 
of the latest postdated check you want printed. Press the on-screen 
Print pushbutton. Quicken prints all checks dated on or before the 
date you specify. 

For more information on printing checks, see Chapter 4, Printing Checks. 

Reminders of transactions coming due 
You need not remember when you must print checks coming due. 
Quicken reminds you with a BillminderTM message that appears in the !F9 
Message Menu. Quicken also shows which accounts have checks and 
Transaction Groups coming due in the Select Bank Account to Open 
dialog box. For more information on Quicken’s reminder system, see page 
7-1. 

To see which accounts have checks coming due: 

1. Choose Open from the File Menu. Quicken displays the Select Bank 
Account to Open dialog box, as in Figure 10-2. 
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Currently open 
bank account. 

Other accounts 
on disk. 

Next postdated 
check is due on 
this date. 

Next Transaction Group 
should be executed on 
this date. 

Figure 10-2. Select Bank Account to Open dialog box. 

Note: If you have bank accounts in different directories, you may 
wish to change directories and see the checks coming due for those 
accounts too. For directions on changing directories, see Chapter 13, 
Account Activif ies. 

2. If an account is listed as having checks or a Transaction Group due, 
select that account and press the on-screen OK pushbutton. The 
selected account becomes your current account. 

Print checks or execute Transaction Groups as necessary in the usual 
way. For more information on printing checks or executing Transac- 
tion Groups, see Chapter 4, Printing Checks, or Chapter 7, Transaction 
Groups. 

3. 

Hard disk users are also reminded when they turn on their computers. 
Quicken’s Billminder tells you if there are checks to be printed, even if you 
don’t run Quicken. You can adjust how far in advance Billminder remind- 
ers warn you of checks or Transaction Groups coming due. 

Quicken normally reminds you three days in advance of the date of a 
check or Transaction Group. If a check is dated for Thursday, reminders 
begin on Monday. (Quicken treats checks whose dates fall on a weekend 
as though their dates fell on the preceding Friday.) This three-day setting 
is good for hard disk users who use their computer twice a week. If your 
usage frequency is different, you should set Quicken differently so it does 
not remind you too early or too late. Select Other Settings from the File 
Menu. See Chapter 14, Changing Settings, for details. 
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Adding postdated transactions 
to the Check Register 

Postdating transactions you add to the Check Register is useful for antici- 
pating deposits, withdrawals, or bank fees you know you will incur. 

You add a postdated transaction to the Check Register just as you would 
any transaction, except that you date it for the future, typically the date 
you expect the deposit to be added or the payment to be subtracted from 
your account. 

To add a postdated transaction to the Check Register: 

1. Choose Check Register from the Activities Menu. You can also press 
m + m .  Quicken displays the Check Register. 

Type your information into the blank Check Register entry as de- 
scribed in Chapter 5, Using the Check Register. Change the date to the 
date in the future that you expect the deposit to be added or the 
payment to be subtracted from your account. 

When you're satisfied with your transaction entry, press the on-screen 
Accept pushbutton to record the transaction. 

2. 

3. 

Quicken displays the Current Balance at the lower-left corner and an 
Ending Balance in the lower-right corner of the screen. The Current 
Balance is the amount you have in your account as of today. The Ending 
Balance is the amount you will have in your account when all postdated 
payments and deposits have been made. 

Quicken tip: Postdated transactions are separated from other transactions 
by a double line called the Today Line. 

Using postdating for accounts payable 
You can use postdating to produce up-to-date accounts payable reports. 
To do this, write postdated checks for all bills as you receive them. Postdate 
each check for a few days before you want to mail the check and pay the 
bill. Your Check Register then shows how much money you need to cover 
your known bills. For a detailed description of managing accounts payable 
with Quicken, see Chapter 16, Business Uses: Payables, Receivables, and Cash 
Flow. 
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OLl Reports 

Overview 

Transaction Reports 

Exact matches and key word matches 

@Category Reports 

Budget Reports 

This chapter tells you how to create reports. Producing reports is one of 
Quicken’s most valuable features. With Quicken’s reports you can exam- 
ine your finances in detail and view them in different ways to understand 
them better. 

Reports are based on the transactions recorded in Quicken’s Check Regis- 
ter. To create a report, tell Quicken what information you want to see and 
the form in which you wish to see it. Quicken then produces the report 
automatically, displaying it on the screen and printing it out if you want. 

Quicken can produce many different reports, depending on the criteria 
you set. You can get reports on your spending, your budget, on tax- 
deductible expenses, on cash flow, on accounts payable, and much more. 

In this chapter, you’ll learn how to produce Quicken’s three report types: 
Transaction Reports, @Category Reports, and Budget Reports. For more 
examples of ways in which you can use Quicken reports in your home or 
business, see Chapters 15,16, and 17. 
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0 vervie w 
Quicken produces three types of reports. Each of these reports is discussed 
in detail later in this chapter. The three reports are: 

Transaction Report. Displays a list of transactions. You can sort and 
subtotal the list in several ways, such as by payee or by week. Produce 
and print this report by choosing Transaction Report from the Activi- 
ties Menu. 

@Category Report. Displays subtotals by @Category without showing 
individual transactions. Produce and print this report by choosing 
@Category Report from the Activities Menu. 

Budget Report. Displays subtotals by @Category. In the Budget 
Report, you can set budget amounts for each @Category. The report 
tells you whether you have met or exceeded your budget, and if so, by 
how much. Produce and print this report by choosing Budget Report 
from the Activities Menu. 

Wide reports 
There is virtually no limit to the width and length of Quicken’s reports. 
Quicken creates reports using as many columns and as many rows as it 
requires to include all the information you request. You can see these 
reports in full by scrolling them with the horizontal and vertical scroll bars, 
or by using 

and 
through the report, use the keys in the following table. 

and to scroll right and left one column at a time, and 
to scroll up and down one line at a time. To move even faster 

To Move: 

Right one screen. 

Left one screen. 

Up one screen. 

Down one screen. 

To top left corner. 

To bottom right corner. 

To left of row. 

To right of row. 
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Press: To Move: 

Moves halfway between the 
current position and the end of 
the document in the direction 
of the arrow. 

Figure 11-1 is a representation of a wide report, showing the portion you 
can see on the screen as well as the portion you cannot see. 

Figure 11-1. A wide report, showing the portion that Quicken initially 
displays on the screen. 

Think of the report as a sheet of paper that may be larger than your 
computer screen. If the report is too long to fit on the screen, the vertical 
scroll bar along the right of the report screen will have an elevator in it 
whose position within the scroll bar corresponds to the rows of the report 
currently displayed on the screen. If the report is too wide to fit on the 
screen, the horizontal scroll bar along the bottom of the report screen will 
have an elevator in it whose position within the scroll bar corresponds to 
the columns of the report currently displayed on the screen. If all the rows 
or all the columns of the report can fit on the screen at one time, the 
corresponding scroll bar will not have an elevator in it. 
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Printing wide reports 

Some reports are too wide to print across a single sheet of computer paper. 
Quicken solves this problem by printing its wide reports in vertical strips, 
each sized appropriately for your computer paper (including wide-carriage 
computer paper). When the report is finished, you can tape the sheets of 
paper together to produce a wide, printed-out report. Quicken prints 
reports like this automatically. You don’t have to do anything except tape 
the report together when it is finished. Reports that do fit your computer 
paper print as you would expect. 

In addition, you can fit more characters per line on a page with condensed 
(16.7 characters per inch) type. The owner’s manual of your printer tells 
you if your printer has this capability. 

For a more detailed explanation of setting up your printer, see page 14-4. 

Quicken tip: If you’re using a laser printer or a dot-matrix printer that 
supports different type fonts (Times, Helvetica, etc.), make sure that you 
print Quicken’s reports using a nonproportional font. In nonproportional 
fonts, all the characters have the same width-the 1 takes up as much space 
as the M. If you print using a proportional font, Quicken’s columns may 
not line up evenly. 

Transaction Reports 
Transaction Reports list transactions from the Check Register. When you 
create the report, you specify which transactions you want listed and how 
you want Quicken to group and subtotal them. For example, the following 
Transaction Report is subtotaled by @Category; it shows a detailed listing 
of tax deductions. The Transaction Report following that is subtotaled by 
payee; it shows income and expense by payee. 
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Figure 11-2. Transaction Report subtotaled by @Category. 
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i- 
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Figure 11-3. Transaction Report subtotaled by payee. 

To create a Transaction Report: 

1. Choose Transaction Report from the Activities Menu. Quicken 
displays the Create Transaction Report dialog box, as in Figure 11-4. 
The cursor is in the Report title field. 
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Restrictions. You can 
restrict the transactions 
that Quicken uses in its 
report. Restrict by date, 
transaction type, payee, 
memo, cleared status, 
or any combination. 

subtotal. How you 
want Quicken to / 
calculate the 
subtotals for the 
report. 

2. 

3. 

4. 

Create Transaction Report 
Report title (optional): lITEHIZED DEDUCTIONS FOR SCHEDULE 1 

Restrict to transactions from: through: 112/31/89] 
I 

which are: Payments d2 Deposits d2 Either - -  - -  

and whose memo matches (optional) : B , ,tax,, 
and whose payee matches (optional): 

Not c 1 eared - and whose cleared status is: 
B!Ekig(Y or *) 8 Newly cleared 

8 :Zre Subtotal by: Don't Cleek subtotal B k;tfhmonth 
Two weeks Quarter rn @Category 

I 
0 Show totals only 

I 
Show totals only. You can produce a complete 
report showing all transactions, or a summary report 
showing only the totals of the transactions. 

Figure 11-4. Create Transaction Report dialog box produces a 
report similar to that in Figure 11 -2. 

Type in a title for the report if you wish. The title can include num- 
bers, letters, and other characters. If you don't type a title, Quicken 
supplies a descriptive title determined by your subtotal, such as 
TRANSACTION REPORT BY PAYEE. If you subtotal by nothing, the 
title reads TRANSACTION REPORT. Press m. The cursor moves 
to the Restrict to transactions from field. 

Type the date of transactions at which you want the report to start. 
The default is January 1 of the current year. Press lTabl to move to the 
through field and type in the date at which you want the report to 
conclude. The default is today's date. 

Set additional restrictions if you wish. This is optional. For many 
reports you need not set any additional restrictions. When you do, 
remember that Quicken includes in its reports only transactions that 
fall within the date range AND which meet ALL the additional restric- 
tions. 

The following are optional steps to set additional restrictions: 

Press one of the on-screen buttons Payments, Deposits, or Either. 
Pressing Either creates a report composed of all transactions; 
pressing Payments or Deposits creates reports comprising those 
transaction types only. 

Note: Zero-amount transactions are treated as deposits in reports. 
For more information on zero-amount transactions, see Chapter 9, 
Split Transactions. 

Quicken User Manual 11-7 



Chapter 11. Reports 

Select the whose payee matches field and type the name of a 
payee. Quicken produces a report that includes only transactions 
with that payee. You can type the exact name or a partial name. 
See the section ”Exact matches and key word matches” on page 11- 
10 for the rules about finding partial matches. 

Select the whose memo matches field and type memo (or split) 
information that you want Quicken to use in selecting the transac- 
tions that make up the report. Quicken will include in the report 
all transactions, and their splits (if any), whose Memo fields match 
what you type in the whose memo matches field. If the Memo 
field of a transaction does not match but one of its split memos 
does, Quicken treats the transaction as having the matching split 
memo as its Memo field and the corresponding split amount as its 
amount. 

With whose memo matches, as with whose payee matches, you 
can request partial matches. In Figure 11-4, the whose memo 
matches field would restrict the report to transactions containing 
the word ”tax” in the memo field. See the section ”Exact matches 
and key word matches” on page 11-10 for the rules about finding 
partial matches. 

Press one of the on-screen Cleared Status buttons: Anything, 
Cleared (X or *), Not cleared, or Newly cleared (*). Quicken 
creates a report restricted to transactions with the cleared status 
you have selected. Anything means both cleared and uncleared 
transactions. You should leave the Anything button selected 
unless you are creating a report specifically to show which of your 
transactions are Cleared or Uncleared. 

5. Press one of the nine on-screen Subtotal by pushbuttons. When 
Quicken subtotals a report, it automatically sorts, groups, and subto- 
tals according to the button you choose. The following table explains 
the effect of each of the nine pushbuttons. 
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Choose This: To Get This: 

Don't subtotal Transactions listed in chronological order. No 
grouping or subtotals. 

Week Transactions sorted, grouped, and subtotaled 
by week, running Sunday through Saturday. 

Two weeks Transactions sorted, grouped, and subtotaled 
by two-week periods, running Sunday 
through Saturday. 

Transactions sorted, grouped, and subtotaled 
by twice-monthly periods, starting on the 1st 
and 16th of each month. 

Half month 

Month 

Quarter 

Year 

Payee 

Transactions sorted, grouped, and subtotaled 
by month, starting on the 1st of each month. 

Transactions sorted, grouped, and subtotaled 
by quarter. A quarter includes three consecu- 
tive calendar months, starting with January 1, 
April 1, July 1, and October 1. 

Transactions sorted, grouped, and subtotaled 
by calendar year. 

Transactions sorted, grouped, and subtotaled 
by payee. 

@Category Transactions sorted, grouped, and subtotaled 
by @Category. If your transactions have 
subcategories, Quicken sorts, groups, and 
subtotals each subcategory within each @Cate- 
gory. 

Check the Show totals only checkbox if you want the report to 
leave off the detailed information about all the transactions and 
show only a summary report of the totals and subtotals, if any. 
Usually, you would leave this unchecked to show transaction 
detail. 

6. When you are satisfied with the settings for all your criteria, press the 
on-screen Start Report pushbutton. Quicken starts searching the 
Check Register to find transactions that meet the criteria you've set. 
This may take some time, depending on the size of your Check Regis- 
ter and the complexity of your criteria. When Quicken has found all 
the transactions that meet your criteria, it displays the report on the 
screen. 
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7. Examine the report by scrolling around it with 
or using the two scroll bars if you have a mouse. 

To print the report, choose Print Report from the File Menu. Quicken 
displays the Print To dialog box. 

Select whether you want to print to the printer or to a file, and the Page 
Setup you wish to use. Press the on-screen OK pushbutton. Quicken 
prints the report. 

When you have finished examining the report, press the on-screen 
Done pushbutton. You can also press m. Quicken returns to the 
Create Transaction Report dialog box. 

> m, , and H, 

8. 

9. 

10. 

Exact matches and key word matches 
The Restrict to part of the Create Report dialog box gives you great control 
over which transactions Quicken includes in reports. The whose payee 
matches and whose memo matches fields are particularly powerful. They 
are useful for reports that focus only on a particular type of transaction, 
such as tax-related transactions. Another use is segregating expenses, such 
as expenses for different properties, clients, or jobs. 

In preparing the report, Quicken includes only transactions that match 
what you type in the whose payee matches and whose memo matches 
fields. Quicken does not differentiate between uppercase and lowercase 
letters and ignores any spaces before or after the payees and memos. The 
type of match that Quicken looks for can be an “exact match,” a ”key word 
match,” or a ”mixed match.” Here’s how they differ: 

Exact match. The report includes only those transactions that exactly 
match the word or phrase you type. For example, if you type @utili- 
ties in the whose memo matches field, the report will include only the 
transactions that have the phrase ”@utilities” in the transaction’s 
Memo field; no more, no less. 

Key word match. The report includes only those transactions that 
contain the word or phrase you type. To do this, type two periods on 
one or both sides of the word or phrase. For example, type ..@utilities.. 
in the whose memo matches field and the report includes all the 
transactions that have the phrase ”@utilities” anywhere in the 
transaction’s Memo field. The Memo fields can contain other charac- 
ters as well. 
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Mixed match. In general, you can use two periods to indicate any 
number of characters. For example, if you type @utilities.. in the 
whose memo matches field, the report will include all transactions 
whose memos begin with "@utilities," with any or no characters follow- 
ing. Similarly, ..@utilities will include all transactions whose memos 
end with "@utilities," and @..bus will include all transactions whose 
memos begin with "@,, and end with "bus." 

A question mark (?) is used to indicate any single character. For example, 
if you type Sm?the in the whose payee matches field, the report will 
include transactions with payees "Smithe" or "Smythe" but not "Smirthe." 

A leading tilde (-) negates whatever you type. For example, -..Smith.. in 
the whose payee matches field will include all transactions except those 
with "Smith in the payee field. The tilde must be the first character in the 
whose payee matches or the whose memo matches field. 

See the examples below. These examples apply to both the whose memo 
matches and whose payee matches fields of the Create Report dialog box. 
Try examples like these yourself in your own reports-the Transaction 
Report you obtain will make the results clear. 

Examples of Examples of what Examples of what the 
what you type the report includes report does not include 

tax 

tax.. 

..tax 

..tax.. 

-tax 

-..tax.. 

t..x 

t?x 

tax, Tax, TAX taxable, tax deduction, surtax, 
new tax loss, rent, utilities 

tax, Tax, TAX, taxable, 
tax deduction utilities 

tax, Tax, TAX, surtax 
property tax 

tax, Tax, TAX, taxable, tax 
deduction, surtax, new tax loss 

taxable, tax deduction, surtax, 
new tax loss, rent, utilities 

surtax, new tax loss, rent, 

taxable, tax deduction, 
new tax loss, rent, utilities 

rent, utilities 

tax, Tax, TAX 

rent, utilities 

tax, Tax, TAX 
trix, tx, tkx, t x, 

tax, Tax, TAX, taxable, surtax, tax 
deduction, new tax loss 

taxable, surtax, tax deduction, 
new tax loss, rent, utilities 

tax, Tax, TAX, tkx, trix, tx, taxable, surtax, tax deduc- 
tion, new tax loss, rent, utilities 
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@Category Reports 
@Category Reports are summary reports. They show subtotals by K a t e -  
gory without showing individual transactions. In addition, they ask how 
often you want Quicken to subtotal each @Category. Figure 11-5 shows 
household income and spending for two months, subtotaled by month. 

M m L Y  FINUUES,  SEPTEMER I OCTOBER 
P I  1/69 T h w h  10/31/89 

1 S T - W  
111 2/89 

9/ 1189- 
(.t.pory DeScIIptIm 9/69 10/m 10/31/69 

.................................................................. 

5m.m 
25.64 

7.433.64 

0.00 
25.75 

7.W3.65 

5m.m 
51.39 

14,867.a 

7,959.28 

1,102.74 

352.76 
1 m . m  

377.27 
85.m 

462.27 
126.12 
372.81 
243.87 

2,W.76 

524.89 
3 7 . a  
64.66 

o.m 

5m.m 
o.m 

19.87 

2M.47 
81.51 

2e4.w 
174.76 
72.56 __________ 

7,y15.92 

7.459.40 

1,173.76 

286.97 
50.m 

171.90 
0.m 

171.W 
a m  

354.60 
202.65 

2,943.76 
648.43 

o.m 
r5o.m 

500.00 
194.66 

U . W  
87.37 

139.62 
156.94 

2W.56 
49.92 
o.m 

.......... 
7,152.58 

15,418.68 

2,276.50 
150.W 
639.73 

5L9.17 
85 m 

by.17 
126.12 
727.u 
446.52 

5,887.52 
648.43 
524 89 
187.81 
259.32 

1,aa.m 
a m  

107.24 

345.09 
2B.45 

583 54 
224.68 
72.56 

14,IYI. 50 

WEULL T O W  5n.B 306.82 M . 1 8  

P q e  1 

Figure 11-5. Income and spending for two months, subtotaled by 
month. 
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Report title (optional): 1NONTHLY FININCES, SEPTENBER AND OCTOBER1 
Restrict to transactions from: through: Ile/3l/ssl 
which are: 0 Payments 0 Deposits Either 
and whose payee matches (optional): 

@Category Reports are very useful. Depending on the @Categories you set 
up, you can use them in preparing tax returns, managing rental property, 
producing profit and lass statements, billing for work done, showing 
monthly spending trends, and so on. For suggestions on how to get the 
most out of @Category Reports, see Chapters 15,16, and 17 on home and 
business uses of Quicken. 

To create an @Category Report: 

1. 

2. 

3. 

Choose @Category Report from the Activities Menu. Quicken 
displays the Create @Category Report dialog box, as in Figure 11-6. 
The cursor is in the Report title field. 

and whose m e w  matches (optional) : I 
and whose cleared status is: B!E9g(~ or *I 8 Newly Not c 1 cleared e are d 

] 
(*I 

subtotal 0 Half month 0 Year rn Nonth 
T w o  weeks 6J Quarter 

~ 

0 Select @Categories to include 

Figure 11-6. Create @Category Report dialog box filled in to 
create the report shown in Figure 11-5. 

Type in a title for the report if you wish. The title can include num- 
bers, letters, and other characters. If you don’t type a title, Quicken 
supplies a descriptive title based on your subtotal, such as @CATE- 
GORY REPORT BY WEEK. Press m. The cursor moves to the 
Restrict to transactions from field. 

Type the date of transactions at which you want the report to start, 
The default is January 1 of the current year. Press m to move to the 
through field and type in the date at which you want the report to 
conclude. The default is today’s date. 

Quicken User Manual 11-13 



Chapter 11. Reports 

4. Set additional restrictions if you wish. This is optional. For many 
reports you need not set any additional restrictions. When you do, 
remember that Quicken includes in its reports only transactions that 
fall within the date range AND that meet ALL the additional restric- 
tions. 

The following are optional steps to set additional restrictions: 

Press one of the on-screen buttons Payments, Deposits, or Either. 
Pressing Either creates a report composed of all transactions; 
pressing Payments or Deposits creates reports comprising those 
transaction types only. 

Note: Zero-amount transactions are treated as deposits in reports. 
For more information on zero-amount transactions, see Chapter 9, 
Split  Transactions. 

Select the whose payee matches field and type the name of a 
payee. Quicken produces a report that includes only transactions 
with that payee. You can type the exact name or a partial name. 
See the section ”Exact matches and key word matches” on page 11- 
10 for the rules about finding partial matches. 

Select the whose memo matches field and type memo (or split) 
information that you want Quicken to use in selecting the transac- 
tions that make up the report. Quicken will include in the report 
all transactions, and their splits (if any), whose Memo fields match 
what you type in the whose memo matches field. If the Memo 
field of a transaction does not match but one of its split memos 
does, Quicken treats the transaction as having the matching split 
memo as its Memo field and the corresponding split amount as its 
amount. 

With whose memo matches, as with whose payee matches, you 
can request partial matches. In Figure 11-4, the whose memo 
matches field would restrict the report to transactions containing 
the word ”tax” in the memo field. See the section ”Exact matches 
and key word matches” on page 11-10 for the rules about finding 
partial matches. 

Press one of the on-screen Cleared Status buttons: Anything, 
Cleared (X or *), Not cleared, or Newly cleared (9. Quicken 
creates a report restricted to transactions with the cleared status 
you have selected. Anything means both cleared and uncleared 
transactions. You should leave the Anything button selected 
unless you are creating a report specifically to show which of your 
transactions are Cleared or Uncleared. 
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5. Press one of the seven on-screen Subtotal by buttons. When Quicken 
subtotals an @Category Report, each subtotal produces another 
column in the report. The following table explains the effect of each of 
the seven buttons. 

Choose This: To Get This: 

Don’t subtotal Shows only one column covering the entire 
time period. No grouping or subtotals. 

Week Shows a column for each week, running 
Sunday through Saturday. 

Two weeks 

Half month 

Shows a column for each two-week period, 
running Sunday through Saturday. 

Shows a column for each twice-monthly 
period, starting on the 1st and 16th of each 
month. 

Month 

Quarter 

Shows a column for each month, starting on 
the 1st of each month. 

Shows a column for each quarter of the year. 
A quarter includes three consecutive calendar 
months, starting with January 1, April 1, July 
1, and October 1. 

Year Shows a column for each calendar year. 

Note: If your transactions have subcategories, Quicken sorts, groups, 
and subtotals each subcategory within each @Category. This means 
that each time period column in the @Category Report can consist of 
multiple columns for subcategory subtotals, depending on how many 
levels of subcategories you use. For more information on subcatego- 
ries, see Chapter 8, page 8-9. 

Indicate by clicking on the Select @Categories to include checkbox 
whether you want to select the @Categories to be included in the 
report. If you do not check this box, Quicken includes in the report 
all @Categories it finds transactions assigned to. 

Or 
If you do click the box, Quicken will prompt you as it starts the 
report, to select which specific @Categories to include in the report 
(see next page). 
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6. When you are satisfied with the settings for all your criteria, press the 
on-screen Start Report pushbutton. If you have not checked the Select 
@Categories to include checkbox, Quicken starts searching the Check 
Register to find transactions that meet the criteria you’ve set. 
Or 

If you have checked the Select @Categories to include checkbox, 
Quicken displays the Select @Categories To Include dialog box, as in 
Figure 11 -7. 

@Category names. 

\ 
Bonuses Bonuses Earned 

W C h a r i t u  Charits Donations 

J ;Ill I 1111 Dinin?: 
Dinin -Out 

Educa ion Mucaiion 
,ntertairment Entertainment 

@Category descriptions. 

@m--- _I - I Qs/Electric 
; i f t s \  Gifts 
iroceries Groceries 
lousehold Household 
lousing Housing 
nsurance Insurance 

, No check mark indicates 
@Category excluded 
from report. 

\Check mark indicates 
@Category included in 
report. 

Figure 11 -7. Select @Categories To Include dialog box. 

To exclude an @Category from the report, use the to select 
that Category and then press the space bar. The check mark in the 
Include column disappears. Press the space bar a second time to 
include the @Category again. The check mark reappears. You can also 
double-click with the mouse to include and exclude an @Category. 
When you have finished selecting @Categories to include, press the on- 
screen OK pushbutton. Quicken starts searching the Check Register to 
find transactions that meet the criteria you’ve set. 

It may take Quicken some time to search through the Check Register to 
generate the report, depending on the size of your Check Register and 
the complexity of your criteria. When Quicken has found all the 
transactions that meet your criteria, it displays the report on the screen. 

Examine the report by scrolling around it with m, m, , and H I  or 
using the two scroll bars if you have a mouse. 

To print the report, choose Print Report from the File Menu. Quicken 
displays the Print To dialog box. 

or 

7. 

8. 
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9. Select whether you want to print to the printer or to a file, and the Page 
Setup you wish to use. Press the on-screen OK pushbutton. Quicken 
prints the report. 

10. When you have finished examining the report, press the on-screen 
Done pushbutton. You can also press m. Quicken returns to the 
Create Transaction Report dialog box. 

Looking over the @Category Report 

There are several things to notice about an @Category Report. First, note 
that Quicken displays category descriptions rather than @Category names 
for @Categories that have descriptions. Quicken displays the @Category 
name only if there is no description. 

Second, note that Quicken lists both categories and subcategories if you 
have assigned transactions to subcategories (see the Entertainment and 
Utilities sections of the report in Figure 11-5). Quicken indents each level 
of subcategory and adds extra columns to the report. Phone and Gas/ 
Electric are indented in the report because some transactions were catego- 
rized as @Utilities @Phone and some as @Utilities @Gas/Electric. For 
more information on subcategories, see Chapter 8, page 8-9. 

Third, note that Quicken totals any uncategorized transactions covered by 
the date range and shows their total as ”Not Categorized.” Both payments 
and deposits can include uncategorized transactions. In the example in 
Figure 11-5 the only uncategorized transactions were payments. 

Quicken tip: You may find under some categories a ”Not Categorized” 
subcategory, such as ”Not Categorized Utilities.” The reason for this is 
that you have assigned subcategories to some transactions in the @Cate- 
gory, but not to all. For example, if the Check Register contains a transac- 
tion for $100 categorized as @Utilities @Phone and another transaction for 
$50 categorized simply as @Utilities, the @Category Report would display 
under the “Utilities” category $100 for the ”Phone” subcategory and $50 
for ”Not Categorized Utilities,” and the total for ”Utilities” would be $150. 
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Budget Reports 
Budget Reports, as their name indicates, are useful for budgeting-that is, 
comparing actual spending and income with budgeted spending and 
income. To produce budget reports, you must first assign your transac- 
tions to @Categories. You then specify a budget amount for each @Cate- 
gory you want included in the Budget Report. (Once you've specified a 
budget amount for an @Category, Quicken remembers it so you never 
have to enter it again, unless you want to change it.) Quicken then com- 
pares actual @Category amounts with the budgeted amounts and produces 
a report showing the actual and budgeted amounts and the difference 
between the two. 

Figure 11-8 shows a one-month report for a typical household budget. 

lST_a*rrK 
111 2/89 

lDNTHLI BUC-GET, OCTOBER 
101 1/89 Through 10/31/69 

101 1/89 - 10/31(89 
Category D C I C l l p t r m  Actual Budge? D l f f  
.................................................. 
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Bonwcs Eeirned 0.W 250.W -250.W 
IntcPclit Earned 25.75 25.W 0.75 
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miit  INCCUE 7,459.40 7,675. W -215.60 

............................ 

1,173.76 1,lW.W 73.76 
50.W 50.W 0 . W  

286.97 lW.W 186.97 
171.90 lW.W 71.90 

o.m 1 w . w  -~m.m 
354.60 350.m 4.60 
202.65 lW.W 102.65 

2,943.76 2,943.76 0 . W  
648.43 6m.W 41.43 

0 . W  4 w w  - M . W  
150.W 175.W -25.W 
194.M lW.W 94 M 

42.w 20.w 22 w 
87.37 1W.W -12.63 

296.56 275 W 21.56 
49.92 150 W -1W.08 

5 w . m  5m.m o.w 

............................ 
7,152.58 7,163.76 -11.18 

iiiiiiiii iiiiiiiii iiiiiiiiii 

OVERALL TOTAL 306.82 511.24 -204.42 

Figure 11-8. Household Budget Report for one month. 
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To create a Budget Report: 

1. 

2. 

3. 

4. 

Choose Budget Report from the Activities Menu. Quicken displays 
the Create Budget Report dialog box, as in Figure 11-9. The cursor is 
in the Report title field. 

Create Budget Report 
Report title (optional): IMONTHLY BUDGET, OCTOBER I 
Restrict to transactions from: through: 

which are: Q Payments Q Deposits Q Either 
and whose payee matches (optional): 
and whose memo matches (optional) : 
and whose cleared status is: Not c 1 eared 8%klg(~ or *) 8 Newly cleared ( a )  

Don’t subtotal Half month Q Year 
Week E Month 
Two weeks barter 

..... ........................................... .. ..................... ......................... 

Figure 11-9. Create Budget Report dialog box set up to produce 
the report in Figure 11 -8. 

Type in a title for the report if you wish. The title can include num- 
bers, letters, and other characters. If you don’t type a title, Quicken 
supplies a descriptive title based on your subtotal, such as BUDGET 
REPORT BY MONTH. Press m. The cursor moves to the Restrict 
to transactions from field. 

Type the date of transactions at which you want the report to start. 
The default is January 1 of the current year. Press 
through field and type in the date at which you want the report to 
conclude. The default is today’s date. 

Set additional restrictions if you wish. This is optional. For many 
reports you need not set any additional restrictions. When you do, 
remember that Quicken includes in its reports only transactions that 
fall within the date range A N D  that meet ALL the additional restric- 
tions. 

to move to the 

The following are optional steps to set additional restrictions: 

Press one of the on-screen buttons: Payments, Deposits, or Either. 
Pressing Either creates a report composed of all transactions; 
pressing Payments or Deposits creates reports comprising those 
transaction types only. 
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Note: Zero-amount transactions are treated as deposits in reports. 
For more information on zero-amount transactions, see Chapter 9, 
page 9-6. 

Select the whose payee matches field and type the name of a 
payee. Quicken produces a report that includes only transactions 
with that payee. You can type the exact name or a partial name. 
See the section “Exact matches and key word matches” on page 11- 
10 for the rules about finding partial matches. 

Select the whose memo matches field and type memo (or split) 
information that you want Quicken to use in selecting the transac- 
tions that make up the report. Quicken will include in the report 
all transactions, and their splits (if any), whose Memo fields match 
what you type in the whose memo matches field. If the Memo 
field of a transaction does not match but one of its split memos 
does, Quicken treats the transaction as having the matching split 
memo as its Memo field and the corresponding split amount as its 
amount. 

With whose memo matches, as with whose payee matches, you 
can request partial matches. In Figure 11-4, the whose memo 
matches field would restrict the report to transactions containing 
the word ”tax” in the Memo field. See the section “Exact matches 
and key word matches” on page 11-10 for the rules about finding 
partial matches. 

Press one of the on-screen Cleared Status buttons: Anything, 
Cleared (X or *), Not cleared, or Newly cleared (*). Quicken 
creates a report restricted to transactions with the cleared status 
you have selected. Anything means both cleared and uncleared 
transactions. You should leave the Anything button selected 
unless you are creating a report specifically to show which of your 
transactions are Cleared or Uncleared. 

5. Press one of the seven on-screen Subtotal by pushbuttons. When 
Quicken subtotals a Budget Report, each subtotal produces another 
column in the report. The following table explains the effect of each of 
the seven pushbuttons. 
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Choose This: To Get This: 

Don’t subtotal Shows only one column covering the entire 
time period. No grouping or subtotals. 

Week Shows a column for each week, running 
Sunday through Saturday. 

Two weeks 

Half month 

Shows a column for each two-week period, 
running Sunday through Saturday. 

Shows a column for each twice-monthly 
period, starting on the 1st and 16th of each 
month. 

Month 

Quarter 

Shows a column for each month, starting on 
the 1st of each month. 

Shows a column for each quarter of the year. 
A quarter includes three consecutive calendar 
months, starting with January 1, April 1, July 
1, and October 1. 

Year Shows a column for each calendar year. 

Note: Unlike @Category Reports, Budget Reports do not subtotal or 
display subcategories. If you have assigned transactions to subcatego- 
ries within categories, only the main @Category (the first one in the 
Memo field) will be listed in the Budget Report. For more information 
on subcategories, see Chapter 8, page 8-9. 

6. If you want to change or add budget amounts to any @Categories, 
press the on-screen Edit Budgets pushbutton. Quicken displays the 
Edit Budget Amounts dialog box. Make any changes necessary and 
press the on-screen OK pushbutton when done. Quicken returns you 
to the Create Budget Report dialog box. For more information on 
editing budget amounts, see page 11-22. 

When you are satisfied with your criteria settings, press the on-screen 
Start Report pushbutton. Quicken starts searching the Check Register 
to find transactions that meet the criteria you set in the Create Budget 
Report dialog box. This may take some time, depending on the size of 
your Check Register and the complexity of your criteria. When 
Quicken has found all the transactions that meet your criteria, it 
displays the report on the screen. 

8. Examine the report by scrolling around it with m, , H, and H, 
or using the two scroll bars if you have a mouse. 

7. 
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9. 

10. 

11. 

To print the report, choose Print Report from the File Menu. Quicken 
displays the Print To dialog box. 

Select whether you want to print to the printer or to a file, and the Page 
Setup you wish to use. Press the on-screen OK pushbutton. Quicken 
prints the report. 

When you have finished examining the report, press the on-screen 
Done pushbutton. You can also press m. Quicken returns to the 
Create Transaction Report dialog box. 

Specifying budget amounts 

Whenever you memorize a new @Category, Quicken assigns it a budget 
amount of zero. For creating Budget Reports, you’ll probably want to 
change the budget amounts of some @Categories or even exclude some 
@Categories from being listed in the Budget Report. Any changes you 
make to the budget amounts of @Categories are saved by Quicken, so once 
you enter a budget amount, you never have to reenter it, unless you need 
to change it. 

To add or change budget amounts: 

1. At the Create Budget Report dialog box, press the on-screen Edit 
Budgets pushbutton. Quicken displays the Specify Budget Amounts 
dialog box, as in Figure 11-10. The Specify Budget Amounts dialog 
box shows each @Category and its description. 

@Category name. @Category Monthly budget Check mark indicates @Category 
\ description. amount. , included in report. 

No check mark indicates @Category 
excluded from report. 

Figure 1 1-1 0. Specify Budget Amounts dialog box. 
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2. You can change the budget amount of any @Category or include or 
exclude the @Category from the Budget Report. 

To change the monthly budget amount of an @Category, move the 
cursor to the @Category’s Budget column. Use , mi, or lml to move through the list of @Categories, or click the up 
arrow and down arrow on the scroll bar with the mouse. Type the 
new budget amount over the existing one. Remember to enter the 
budget amounts for expense @Categories as negative numbers and 
for income @Categories as positive numbers. You must enter each 
amount as a monthly figure. Budget amounts always appear as 
monthly in this dialog box, no matter what time period you use in 
the Budget Report. If you choose a time period other than 
monthly in the Create Budget Report dialog box, Quicken adjusts 
the budget amounts accordingly. For example, if you subtotal a 
report by year, Quicken multiplies the budget amounts by 12 
before displaying them in the report. 

To exclude an @Category from the Budget Report, move the cursor 
to the Include column of that @Category and then press the space 
bar. The check mark in the Include column disappears. Press the 
space bar a second time to include the @Category again. The 
check mark reappears. You can also double-click with the mouse 
to exclude an @Category from the Budget Report. 

Note: When you change the budget amount of an @Category, the 
check mark in the Include column will automatically appear too if 
it is not already there to include the @Category in the report. 

3. When you are satisfied with the budget amounts and include status of 
all the @Categories, press the on-screen OK pushbutton. Quicken 
returns you to the Create Budget Report dialog box, where you can 
press the on-screen Start Report pushbutton to begin the report. 
Or 
Press the on-screen Cancel pushbutton to cancel any changes you have 
made to the budget amounts and return to the Create Budget Report 
dialog box. 

Budget Reports group @Categories with positive budget amounts (or zero) 
in the INCOME section at the top of the report and those with negative 
amounts in the EXPENSES section at the bottom of the report. 
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a CI Chapter Reconciling ’* Your 
Account 

Entering the ending balance and marking cleared transactions 

If your account balances 

If your account doesn’t balance 

In this chapter you’ll learn how to reconcile your Quicken Check Register 
with your monthly bank statement. “Reconciling your account” means 
verifying that your records and the bank‘s records show the same amount 
of money in your account at the end of a specific time period. 

Entering the ending balance and 
marking cleared transactions 

You begin reconciling with Quicken by entering the ending balance from 
your bank statement. The ending balance is the amount of money the bank 
had in your account on the last day of the period covered by the statement. 
Most monthly statements label this amount the ”ending balance.” On 
some statements, it may be the last number shown in the statement’s 
balance column. 

After entering the ending balance, mark as cleared in the Check Register all 
the transactions listed on the bank statement, just as you do when reconcil- 
ing a paper checkbook. 

Quicken compares your Check Register with the bank statement. If they 
agree, your account is in balance. If your Check Register and the bank 
statement don’t agree, Quicken helps you find the difference. If there is a 
difference, Quicken offers to adjust your records to agree with the bank 
statement. 

Quicken User Manual 12-1 



Chapter 12. Reconciling Your Account 

Quicken is designed to reconcile one statement at a time. If you’re recon- 
ciling more than one statement, do the oldest one first. Also, be sure that 
all outstanding transactions-such as checks you’ve written by hand-are 
entered in the Check Register before you begin reconciling. Quicken won’t 
be able to reconcile your account correctly unless you have recorded all 
your transactions. 

To begin reconciliation: 

1. Choose Reconcile from the Activities Menu. Quicken displays a 
shortened Check Register, with a Reconciliation Summary section at 
the bottom. This is called the Reconciliation Register. Quicken over- 
lays this Reconciliation Register with the Ending Bank Balance dialog 
box, as shown in Figure 12-1. 

Ending balance from bank statement: 

-@!E!? 

Figure 12-1. Ending Bank Balance dialog box. 

2. Type in the ending balance from your bank statement and press the 
on-screen OK pushbutton. Quicken returns to the Reconciliation 
Register, as in Figure 12-2. Quicken positions the highlight box at the 
first uncleared transaction in the Check Register. The cursor is in the 
Cleared (C) column. 
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Type an asterisk (*) in the Cleared (C) column for transactions 
listed on your bank statement. You can also double-click. 

Total dollar amount of all transactions in 
Check Register marked cleared (X or *). 

Running summary of 
transactions you 
have marked 
cleared. 

When finished 
marking cleared 
transactions, press 
End Recon. 1 

I Ending Balance: $2,459,68/ 1 
I 

Move highlight box to next uncleared transaction by 
pressing the on-screen Next pushbutton; move back 
by pressing the on-screen Prev pushbutton. 

Difference between banks records and 
yours. If zero, your Check Register 
balances with the bank statement. 

Figure 12-2. Marking cleared transactions during a reconciliation. 

3. If the transaction is listed on the bank statement, type an asterisk (*) in 
the Cleared (C) column to indicate that the transaction has cleared the 
bank. If you are using a mouse, you can also double-click the Cleared 
(C) column to mark the transaction cleared. An asterisk appears. To 
unmark a transaction, press the space bar or double-click again. The 
asterisk disappears. 

Press the on-screen Next pushbutton. Quicken moves the highlight 
box to the next uncleared transaction in the Check Register. If that 
transaction is listed on the bank statement, mark it cleared as in Step 3 
above. (If you need to go back to an earlier uncleared transaction, 
press the on-screen Prev pushbutton.) 

In addition to using the Next and Prev pushbuttons, you can move 
through the Reconciliation Register in all the same ways that you can 
in the regular, full-sized Check Register. The Next and Prev pushbut- 
tons are just another way to move through the Reconciliation Register, 
which is especially convenient when reconciling. 

4. 

Quicken User Manual 12-3 



Chapter 12. Reconciling Your Account 

Quicken tip: If you are using the keyboard, remember to use 
m+n and m+m, the accelerator keys for these pushbuttons, to 
save you time. 

Continue marking cleared all transactions listed on the bank statement. 

Add to the Reconciliation Register any transactions shown on the bank 
statement that do not appear in the Reconciliation Register. These may 
include bank fees, ATM transactions you neglected to record, and so 
on. Type in these additional transactions at the end of the Reconcili- 
ation Register exactly as though you were entering a new transaction. 
Be sure to include an asterisk (*> in the Cleared (C) column to mark it 
as cleared. Press the on-screen Accept pushbutton to record each such 
additional transaction. 

5. 

6. When you have finished marking and adding cleared transactions, 
press the on-screen End Recon pushbutton. Quicken compares your 
Check Register with the bank statement. If your records agree with the 
bank's, Quicken will congratulate you and offer to print a Reconcili- 
ation Report (see below). 

Or 

If your records do not agree with the bank's, Quicken will give you the 
opportunity to find and fix the discrepancies, or simply to accept the 
bank's records as correct and enter a balance adjustment to bring your 
records into agreement with the bank's (see page 12-10). 

As you mark transactions cleared, the Reconciliation Summary at the 
bottom of the screen is updated to show you a running summary of your 
reconciliation. This summary information includes the total number and 
dollar amount of the transactions you have marked cleared from this bank 
statement, the total dollar amount of all transactions marked cleared (from 
this statement and all previous bank statements), and the difference 
between the dollar amount of all cleared transactions and the bank balance 
on the statement (which you told Quicken when you began reconciling). 

When you reconcile your account, you are checking to be sure that your 
records of all the transactions that have cleared the bank agree with the 
bank's records of those transactions. Specifically, you are verifying that 
you have a record in your Check Register of all the transactions that the 
bank has a record of and that the dollar amount of each of those transac- 
tions is the same as what the bank reported them to be. If your records 
and the bank's records agree, then after you have marked cleared all the 
transactions in the Check Register that appear on the bank statement, the 
total of all cleared transactions as displayed in the Reconciliation Register 
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will match the total of transactions on your bank statement and the Differ- 
ence amount in the Reconciliation Summary will be zero. If your records 
and the bank's records do not agree, the amounts will not be the same and 
the Difference will not be zero. 

Quicken tip: It is helpful to place a check mark beside each transaction on 
the bank statement that you mark in the Reconciliation Register. This 
helps you find transactions that appear on the statement but are missing 
from the Check Register. 

If your account balances 
When you press the on-screen End Recon pushbutton, Quicken compares 
your records with the bank statement to see if they are in balance. Specifi- 
cally, Quicken checks to see if the sum of the amounts of all cleared 
transactions in the Reconciliation Register (those you just marked with 
asterisks as well as any you had cleared in prior months) equals the bank 
statement's ending balance, which you told Quicken when you first started 
reconciling. 

If your Reconciliation Register balances with the bank statement, Quicken 
updates your records and changes all the asterisks in the Cleared (C) 
column to X's. The X's are used to help distinguish transactions that have 
been cleared and reconciled this month from transactions you may clear 
next month. 

After updating your records, Quicken displays the Reconcile Complete 
dialog box with a congratulations message, as in Figure 12-3. 

Congratulations! Your llccount Balances, 
Each * in your register has been changed to an X and our 
records haue been updated to Match your bank stateMen i I 

Press OK-to 1eaue.reconciling 
or Press Print to print a Reconciliation report 

Figure 12-3. Reconcile Complete dialog box with Congratulations. 
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If you wish to print out a Reconciliation Report that summarizes your 
account activity according to the bank statement, you can do so now. 

To print a Reconciliation Report: 

1. At the Reconcile Complete dialog box, press the on-screen Print 
pushbutton. Quicken displays the Print To dialog box. 

Choose whether to print to the printer or to a file and the Page Setup 
you wish to use. 

Press the on-screen OK pushbutton. Quicken prints a Reconciliation 
Report. 

2. 

3. 

Quicken tip: If after leaving Reconcile you wish to print a Reconciliation 
Report of your most recent reconciliation, you can do so by selecting 
Reconcile from the Activities Menu as if you were going to reconcile a 
new bank statement. Leave the bank's ending balance at zero (or any 
value). When the Reconciliation Register is displayed, select Print Report 
from the File Menu and follow the steps above to print the report. After 
printing is complete and you return to the Reconciliation Register, just 
press or select another activity from the Activities Menu to leave 
Reconcile. 

If your account doesn't balance 
If, when you press the on-screen End Recon pushbutton, the total of all 
cleared transactions in the Reconciliation Register does not agree with the 
bank statement's ending balance (and therefore the Difference amount on 
the Reconciliation Summary is not zero), your records and the bank's are 
not in balance. Quicken displays the Out of Balance dialog box, as in 
Figure 12-4, to show you the amount of the difference and to suggest 
possible reasons for the difference. 

At this point you have three options: you can try to find and correct the 
source of the difference; you can ignore the difference and accept the 
bank's records as correct; or you can quit reconciling for now (your work 
so far will be saved) and come back to it later. 
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Quicken lists the 
oossible causes of 

The dollar amount of the difference. 

[(e difference in the 
order they’re most 
likely to occur. \ 

Quicken gives 
you three - 
options. 

There i s  a difference of - 3.99, Y o u r  register way haue: - too few deposits marked as cleared 
and/or - incorrect dollar amounts on some items 

or Press 
or Press Id;t t o  accept bank’s recods  as correct (and add a balance 

‘and/or - too many payments marked as cleared 

Press Cancel to  return to  the register to  find and f i x  the problem, 
i t  to  quit recon for now (your rork will  be saued). 

adjustment) I 

m n -  

Figure 12-4. Out of Balance dialog box. 

Correcting the difference and reconciling the account 

To correct the difference, press the on-screen Cancel pushbutton to return 
to the Reconciliation Register. The Reconciliation Summary remains at the 
bottom of the screen. You can now check your reconciliation against the 
bank statement in a systematic way. 

First, double-check that the Bank Balance as displayed in the Reconciliation 
Summary is the same as the ending balance on the bank statement. If the 
figures do not agree, you will need to retype the Bank Balance. 

Next, check the dollar total for ”Checks, Debits” shown in the summary 
against the dollar total for debits shown on your bank statement. Debits 
are all payments, such as checks written or bank fees charged, that are 
subtracted from your account. If the figures do not agree, you know you 
have a problem with checks and debits. 

Also check the dollar total for ”Deposits, Credits” shown in the summary 
against the dollar total for credits shown on your bank statement. Credits 
are all additions to your account such as deposits and interest. If the 
figures do not agree, you know you have a problem with deposits and 
credits. 

If the Bank Balance is incorrect: 

1. Press as necessary to move the cursor to the Bank Balance field 
of the Reconciliation Summary, or click there with the mouse. 
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2. Type the correct bank ending balance over the incorrect one. Note that 
the Bank Balance field is the only field in the Reconciliation Summary 
that you can move the cursor to and change directly. 

Press the on-screen End Recon pushbutton. If the account balances 
now, Quicken will update your records, changing all the asterisks in 
the Cleared (C) column to X’s and displaying the Reconcile Complete 
dialog box, as in Figure 12-3. 
Or 

3. 

If the account still does not balance, the Out of Balance dialog box will 
reappear. See below for instructions on how to check for errors in 
payments or deposits. 

If you have a problem with checks and debits: 

Count the number of debit (payment) transactions listed on your bank 
statement. Be sure to count all debit transactions, including checks, 
transfers out of the account, ATM withdrawals, service charges and 
fees, and automatic payments. Some statements count the number of 
debits for you. 

Compare the number of debits on the bank statement with the number 
of debits shown in the Reconciliation Summary. 

If the counts are different ... 
You either: 

1. 

2. 

3. 

To correct the problem, go through the Reconciliation Register. Find any 
payments listed on the bank statement that you may have neglected to 
clear and clear them. If you find payments that you mistakenly cleared, 
delete the asterisk from the Cleared (C) column. Add any transactions that 
appear on the bank statement but are not currently in the Reconciliation 
Register. 

Missed recording a payment in the Check Register. 

Missed marking a payment as cleared. 

Mistakenly marked a payment as cleared. 

If the counts are the same but the amounts are different ... 
You probably recorded the payment, but typed in the amount incorrectly. 
To correct the problem, see ”Looking for incorrect amounts” later in this 
chapter. 
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If you have a problem with deposits and credits: 

Count the number of credit transactions listed on your bank statement. 
Be sure to count all credit transactions, including direct deposits, 
transfers into the account, deposits made at automatic teller machines, 
and interest received. Some statements count the number of credits for 
you. 

Compare the number of credits on the bank statement with the num- 
ber of credits shown in the Reconciliation Summary. 

If the counts are different ... 
You either: 

1. 

2. 

3. 

To correct the problem, go through the Reconciliation Register. Find any 
deposits listed on the bank statement that you may have neglected to clear 
and clear them. If you find deposits that you mistakenly cleared, delete the 
asterisk from the Cleared (C) column. Add any deposits that appear on 
the bank statement but not in the Reconciliation Register. 

If the counts are the same but the amounts are different ... 

Missed recording a deposit in the Check Register. 

Missed marking a deposit as cleared. 

Mistakenly marked a deposit as cleared. 

You probably recorded the deposit, but typed in the amount incorrectly. 
To correct the problem, see ”Looking for incorrect amounts” below. 

Looking for incorrect amounts 

Go through the Reconciliation Register, comparing the dollar amount 
of each transaction shown on the bank statement with its dollar 
amount in the Reconciliation Register. 

If you find any amounts recorded incorrectly, type the correct amount 
over the incorrect amount and press the on-screen Accept pushbutton 
to record the change. 
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Ending the reconciliation 

If the steps you have taken above have corrected the problem, the 
Difference amount in the Reconciliation Summary will be zero. Press 
the on-screen End Recon pushbutton. Quicken updates your records 
and displays the Reconcile Complete dialog box with a congratula- 
tions message, as in Figure 12-3. See ”If your account balances” on 
page 12-5. 

If your account still doesn’t balance, you may want to double-check 
your work. In particular, make sure that all transactions on the bank 
statement are correctly recorded in the Reconciliation Register and are 
marked cleared. If you still can‘t locate the problem, there may be an 
error on your bank statement and you should contact your bank. 

Ignoring the difference and reconciling the account 

You may decide to ignore the difference between your Reconciliation 
Register and the bank statement. This will save you time if the amount is 
small and you feel it is not worth your time to track it down. Quicken will 
add a Balance Adjustment transaction to the Reconciliation Register to 
bring your records into balance with the bank’s. 

Quicken tip: Be cautious about accepting the banks ending balance as 
correct and adding a Balance Adjustment. Accepting your bank‘s records 
could introduce an error into your Check Register equal to the size of the 
difference. In some circumstances, this could cause you to overdraw your 
account. It’s always safer to go through the Check Register to locate and 
correct the source of the difference. 

To ignore the difference: 

1. Press the on-screen End Recon pushbutton. Quicken displays the Out 
of Balance dialog box, as in Figure 12-4. 

Press the on-screen OK pushbutton. Quicken displays the Adding 
Balance Adjustment dialog box. Quicken explains that it will be 
adding either a payment or deposit to your Check Register in order to 
balance with your bank statement. Press the on-screen OK pushbutton 
to add the adjustment. 
Or 

2. 
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Press the on-screen Cancel pushbutton and Quicken will not add a 
Balance Adjustment. Quicken will return you to the Reconciliation 
Register to continue reconciling. 

Once Quicken has entered your balance adjustment, it will update 
your records, changing all the asterisks to X's, and display the Recon- 
cile Complete dialog box with a message that the Check Register has 
been adjusted to agree with the bank statement. If you wish to print 
out a Reconciliation Report that summarizes your account activity 
according to the bank statement, you can do so now by pressing the 
on-screen Print pushbutton. See page 12-6 for detailed instructions. 

Or 

Press the on-screen OK pushbutton to end reconciling and return to 
the Check Register. 

3. 
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IzI Account Activities 
LID 

Setting up additional bank accounts 

Selecting bank accounts 

Changing where Quicken looks for data 
_ _ ~ ~  ~ 

Backing up and restoring bank accounts 

Copying bank accounts 

Deleting bank accounts 

Renaming bank accounts 

In Chapter 2 you learned how to set up your first bank account with 
Quicken. In this chapter you’ll learn how to set up additional bank ac- 
counts, how to change directories, how to back up and restore accounts, 
how to delete and rename accounts, and how to copy accounts. 

Pay particular attention to the instructions for backing up an account. You 
should maintain backup copies of all your bank accounts to guard against 
accidental loss of data. 

Setting up additional bank accounts 
With Quicken, you can set up as many bank accounts as you want. If you 
are a floppy disk user, you can set up all your accounts on one data disk, or 
you can maintain a separate data disk for each account-which we recom- 
mend. 

To set up additional accounts: 

1. From the File Menu, choose New. If you keep your data on floppy 
disks, Quicken displays the Change Disks dialog box to allow you to 
change disks if you wish to set up your new account on a different 
disk. If so, insert the disk now and then press the on-screen OK 
pushbutton. 
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Quicken displays the Set Up Bank Account dialog box, as in 
Figure 13-1. 

Nane for this bank account: -1 
Opening Balance: (1 

(8 character DOS filenane) 

mkm= 

Figure 13-1. Set Up Bank Account dialog box. 

2. Type in the name and opening balance for the account, just as you did 
when you set up your first account with Quicken. 

When you are satisfied with the information you've entered, press the 
on-screen OK pushbutton. Quicken brings you to the Check Register 
of your new account, open and ready for you to begin entering trans- 
actions. 

3. 

The new account is now available on the Select Bank Account list, which 
you can see by choosing Open from the File Menu. 

Selecting bank accounts 
Quicken always displays the current bank account name at the top of the 
screen so that you always know which account you are using. If you want 
to change bank accounts, you can do so at any time. Quicken automati- 
cally saves your current transaction information before it opens another 
account. 

To select a different account: 

1. Choose Open from the File Menu. Quicken displays the Select Bank 
Account to Open dialog box (Figure 13-2). 
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-.--- - - -  I 

~ 

Figure 13-2. Select Bank Account to Open dialog box. 

2. Use or to select the account you wish to use. (If the account is 
on another disk or directory, see "Changing where Quicken looks for 
data" below.) Press the on-screen OK pushbutton. Quicken opens the 
account and displays the Check Register for that account. 
Or 
If you have a mouse, double-click on the account name in the Select 
Bank Account to Open dialog box. Quicken opens the account and 
displays the Check Register for that account. 

The Select Bank Account list includes detailed information about your 
bank accounts. The list shows the name of each account and the date you 
last made changes to it. The list also shows the size of the account. If you 
have postdated checks, the list shows when the next check is due to be 
printed. If you have scheduled Transaction Groups, the list shows when 
the next group is due to be executed. 

Changing where Quicken looks for data 
Quicken can look for data on only one disk drive or in one directory at a 
time. If it doesn't find an account you know you've set up, Quicken is 
probably looking at the wrong drive or directory. 

A directory is a portion of a disk that you've set up and labeled with a 
name. You typically set up directories in order to organize your programs 
and files on the disk. For example, you might want to keep Quicken and 
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all your Quicken account files in one directory and your word processor 
program and files in another. This is particularly useful with a hard disk 
on which there may be hundreds of programs and files. 

To use a different disk or directory: 

1. Choose Open from the File Menu. Quicken displays its Select Bank 
Account to Open dialog box. In addition to the names of your ac- 
counts, you will see letters enclosed in brackets designating disk 
drives, such as [A:] or [a:]. You may also see directory names enclosed 
in brackets, such as [DATA] or [WORK], if the current directory has 
subdirectories. The special directory name [..I signifies the parent 
directory of the current directory. If the current directory is a subdirec- 
tory of another directory, selecting [..I brings you "up" one level. 

Current drive and 
directory. 

Accounts in current 
directory. 

Parent directory of 
current directory. 

Subdirectory of current 
directory. 

Other disk drives. 

Figure 13-3. Changing a drive or directory. 

2. Use or to select the letter designating the drive or the name of 
the directory you wish to use. Press the on-screen OK pushbutton. 
Quicken displays the list of bank accounts for the new drive or direc- 
tory. 
Or 
If you have a mouse, double-click the letter designating the drive or 
the name of the directory you wish to use. Quicken displays the list of 
bank accounts for the new drive or directory. 

Select the account you wish to use in the new drive or directory. 
Quicken opens the account and displays the Check Register for that 
account. 

3. 
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Quicken tip: If you wish to open an account from the current drive, but 
on a different disk, simply insert the new disk and select the letter desig- 
nating the drive. Quicken will read the disk in the drive and update the 
list of accounts on the screen to the accounts on this new disk. For ex- 
ample, you open a file from drive [B:]. Quicken displays the Select Bank 
Account to Open dialog box, based on the disk that is currently in drive 
[B:]; let’s call it DISKl. The account you really need is on a different disk; 
we’ll call it DISK2. You need to change the disk in drive [B:] from DISKl to 
DISK2. Once DISK2 is in drive [B:], select [B:] again from the Select Bank 
Account to Open dialog box. Quicken will read the disk in drive [B:] and 
then display the Select Bank Account to Open dialog box based on DISK2. 

Backing up and restoring bank accounts 
At least once a month you should make a backup copy of each of your 
bank accounts to guard against accidental loss of data. A good rule of 
thumb is to back up often enough so that recreating lost records would be 
relatively quick-you wouldn’t want to re-enter a year’s worth of transac- 
tions. For some users, a weekly backup may be required. Quicken can do 
this for you in seconds. Backups are important insurance, because in the 
event of a data loss, you can use the copy of the account stored on the 
backup disk. 

Backing up a bank account 

The first time you make a backup copy, you will need a blank, formatted 
disk. Be sure to have one on hand before you start Quicken. (For subse- 
quent backups, simply reuse your backup disk.) If there’s room on the 
disk, you can use the same backup disk for several accounts with different 
names. Quicken warns you if there’s not enough room left on the backup 
disk to hold the account you’re trying to back up. 

To back up an account: 

1. Open the account you want to back up by choosing Open from the 
File Menu and selecting that account (see page 13-2). 

Choose Copy from the File Menu. Quicken displays the Copy Cur- 
rent Account dialog box (Figure 13-4). The cursor is in the Copy 
transactions from field. 

2. 
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Use these date settings to determine 
the range of transactions you copy. 

/ /  

Also copies all uncleared 
transactions, even if they 
occur prior to the date 
range you specified. 

You must supply a 
new account name 
for the copy of your Copy transactions from: 

lllso copy prior unc transactions. 

Enter new name for copied account: 

Figure 13-4. Copy Current Account dialog box. 

3. Press a three times to move the cursor to the Enter new name for 
copied account field. Do not change the from or to date fields; they 
are already correctly set for backing up the entire account. If you do 
not wish to back up the entire account, see ”Copying bank accounts” 
on page 13-7. 

Type a name for the backup account. You must type a different name 
for the backup account from the current account if the two accounts 
are in the same drive and directory. If you want Quicken to back up 
your account to a different drive or directory, type the drive letter or 
directory name along with the new account name. For example, if you 
are copying the account CHECKING from drive [C:] to drive [B:], type 
B:CHECKING in the Enter new name for copied account field. 

When you are satisfied with your settings, press the on-screen OK 
pushbutton. Quicken will make a backup copy of the account. 

4. 

5. 

Quicken tip: If you enter simply a drive or directoryin the Enter new 
name for copied account field, such as A or \MYDATA, Quicken will 
make a backup copy of the current account to that drive or directory and 
give it the same name as the current account being copied. 

To copy from a floppy disk to a different disk in the same drive, just type 
the drive designator, such as A:, in the Enter new name for copied account 
field. Quicken will tell you when to swap from the SOURCE disk (the disk 
you are copying from) to the DESTINATION disk (the disk you are 
copying to). You may have to swap disks several times, depending on the 
size of the account you are copying. 

Once you have made a backup copy of your account, you should update it 
at least once a month. To do so, simply follow the steps outlined above. 
Store your backup disk in a safe place. 

13-6 Quicken User Manual 



Chapter 13. Account Activities 

Restoring an account you have backed up 

If you are a floppy disk user, you need not specifically restore accounts. If 
your primary data disk is damaged or lost, just start using your backup 
disk as your primary data disk. Then make a backup of the new data disk. 
(Don’t forget to continue making backup copies!) 

If you are a hard disk user, you’ll need to restore accounts only if your 
hard disk ”crashes” or if the file somehow becomes damaged. In this 
event, first reinstall Quicken, following the instructions in Chapter 1, 
Getting Started. 

To restore an account: 

1. Choose Open from the File Menu. Quicken displays the Select Bank 
Account to Open dialog box. 

Insert your backup disk that contains the account you need to restore 
into the floppy drive. Select the drive that contains the backup disk. 
After Quicken displays the accounts on that disk, open the account. 

Once the account is opened, choose Copy from the File Menu. 
Quicken displays the Copy Current Account dialog box. 

Move the cursor to the Enter new name for copied account field, and 
type in a name for the copied account. Make sure you type the drive 
designator of the hard disk, such as C ,  followed by the account name 
to indicate that the copy is to be placed on your hard disk. Press the 
on-screen OK pushbutton to begin restoring 

2. 

3. 

4. 

Quicken tip: If Quicken finds an account with the same name on the hard 
disk as the one you are restoring, it asks you to confirm that it is OK to 
overwrite the current account on the hard disk. ”Overwrite” means that 
Quicken erases the account from the hard disk and replaces it with the 
copy from the backup disk. Be sure you want to do this. 

Copying bank accounts 
In addition to copying entire accounts, as when backing up and restoring, 
Quicken also lets you copy part of an account. You might want to do this 
in order to start a new account file for a new year, or because your data 
disk is full. Copying an account also allows you to copy your list of 
memorized transactions and @Categories to a new account without 
copying the transaction data in the Check Register. 
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To copy an account: 

1. Open the account you want to copy by selecting Open from the File 
Menu. 

2. Choose Copy from the File Menu. Quicken displays the Copy Cur- 
rent Account dialog box (Figure 13-4). The cursor is in the Copy 
transactions from field. 

3. Quicken defaults to the earliest date in the Check Register. However, 
you may not always want to copy all the data from your account. For 
example, you may not want to copy transactions from previous years. 
If you want to change the date, type in the earliest date from which 
you want Quicken to copy transactions. 

Move the cursor to the to date field. You can move the cursor to a new 
field by using or by clicking the field with the mouse. Type in 
the latest date through which you want Quicken to copy transactions. 
Quicken defaults to the last date there was a recorded transaction. 

4. 

5. Check the Also copy prior uncleared transactions checkbox to tell 
Quicken you want to copy uncleared transactions that are prior to the 
from date. This will make it easier for you to reconcile the new 
account. In general, you should leave this box checked. If you don’t 
want those transactions copied, click or press the space bar on the 
checkbox to uncheck it. 

6. Move the cursor to the Enter new name for copied account field, and 
type in a name for the copied account. You must type in a different 
name for the copied account name if the two accounts are in the same 
directory. 

If you want Quicken to copy transactions to a different drive or 
directory, type the drive letter, along with the new name. For example, 
if you are copying CHECKING from drive [C:] to drive [B:], type in 
B:CHECKING in the New name for copied account field. Quicken 
will copy the account to the floppy in your [B:] drive. 

When you are satisfied with your settings, press the on-screen OK 
pushbutton. Quicken will copy the transactions selected. 

7. 

Deleting bank accounts 
Deleting a bank account permanently removes the entire account from your 
disk. Once you have removed it, there is no way to get it back. 
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To delete an account: 

1. Choose Delete from the File Menu. Quicken displays the Select Bank 
Account to Delete dialog box. 

Use or to select the account you wish to delete. Press the on- 
screen OK pushbutton. You can also type the account name into the 
File field and press the on-screen OK pushbutton. If you have a 
mouse, you can double-click on the account name to select it. 

Quicken displays a CAUTION dialog box which asks you if you are 
sure you want to permanently remove the account from your files. 

To proceed with deleting the account, press the on-screen YES push- 
button. Quicken deletes the account and returns you to the Check 
Register. 
Or 

2. 

3. 

Press the on-screen NO pushbutton. The account will not be deleted. 

Note: If you delete the current account, you will return to a blank 
desktop after leaving the Select Bank Account to Delete dialog box. 

Renaming bank accounts 
Occasionally, you may wish to rename an account. For example, if you 
have a single account on Quicken called CHECKING and then decide to 
set up a new account, you might want to rename CHECKING to CHECK1 
and set up the new account as CHECK2. 

To rename an account: 

1. From the File Menu, choose Rename. Quicken displays the Select 
Bank Account to Rename dialog box. 

Use or to select the account you want to rename. Press the on- 
screen OK pushbutton. Quicken displays the Enter New Account 
Name dialog box. 
Or 
If you have a mouse, double-click the account you want to rename. 
Quicken displays the Enter New Account Name dialog box. 

Type in the new name for the account (8 characters maximum). 

Press the on-screen OK pushbutton. Quicken renames the account. 

2. 

3. 

4. 
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DeskMate settings 

Quicken Page Setup 

Other settings 

This chapter tells you how to change Quicken’s settings. Though Quicken 
comes set up and ready to work, you may want to change some of the 
settings to suit your own taste or your computer system. For example, you 
can decide whether or not the program beeps, what screen colors you want 
(if you have a color monitor), how much confirmation Quicken requires 
when you change your records, and so on. Some printers require special 
settings to work properly. Changing settings is easy, so you can experi- 
ment to see what works best for you. 

You can change: 

DeskMate Setup on the F10 Accessories Menu. These include Mouse 
Settings, Date and Time, Printer Settings, and Colors. You can change 
the DeskMate settings at DeskMate’s Desktop or from within Quicken 
without returning to DeskMate. 

Page Setup on the File Menu. These include page margins, characters 
per inch (pitch), and printer control codes. You can create up to six 
different Page Setups. 

Other Settings on the File Menu. These specify your preferences 
regarding beeps when Quicken is recording and memorizing, whether 
you want advance reminders to execute scheduled Transaction 
Groups, whether you require an @Category on all transactions, and so 
forth. 
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DeskMate settings 
You may need to change the hardware settings on your computer-for 
example, which printer port your printer is connected to, or maybe you 
just changed from using a monochrome monitor to a color monitor. These 
settings can be changed with the DeskMate Setup accessory on the F10 
Accessories Menu either at the DeskMate desktop or from within Quicken. 

Open the F10 Accessories Menu from the menu bar. Select Setup from the 
displayed menu. Detailed instructions for opening a menu and selecting 
an option are given on page 2-3. The DeskMate Setup screen appears as 
shown in Figure 14-1. 

Printer Settings 
Driver nane; dnpdih  
Line feed f i l ter:  Off 
Printer Ports: LPTl 
Characters Per Inch: 18 

Figure 14-1. DeskMate Setup Areas. 

To change any of the areas, open the F2 Options Menu, or double-click on 
the area you want to change. 

Mouse settings 

The first thing to do is let DeskMate know whether you have a mouse, and 
what kind it is. Also, here is where you determine the speed at which the 
mouse double-clicks. 

1. Select Mouse from the Options menu. The Setup Mouse Device 
dialog box is displayed, as shown in Figure 14-2. 
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Figure 14-2. Setup Mouse Device dialog box. 

2. Select from the Pointing Device button group the appropriate device. 
If you are not using a mouse, select None. Select Other mouse if using 
a Bus mouse. If you are using a Serial mouse, you will also need to 
select the port that mouse is connected to, either Coml or Com2. 

Select from the Double Click Speed button group the speed you 
desire. Click on 1 if you want the speed to be very fast, and click on 5 
if you want the speed to be very slow. You can try different speeds to 
find the one you want by double-clicking on the TEST pushbutton 
after you select a speed. If the double-click depresses the button, it 
was recognized as a double-click. If you are not satisfied with that 
speed, try another one. 

Once you are satisfied with your choices, press the on-screen OK 
pushbutton to save your mouse settings. 
Or 
Press the on-screen Cancel pushbutton and the settings will not 
change. 

3. 

4. 

Comm mica tions settings 

Quicken is not a communications program, so these settings have no value 
to Quicken. You can just ignore this option. 

Quicken User Manual 14-3 



Chapter 14. Changing Settings 

Date and Time 

Some computers have built-in clocks. If yours doesn’t, use this option to 
set the date and time. Note that Quicken will ask for a date when you start 
if the computer’s system date is not set. There may be times when you 
need to change your system date and time. If the date and time displayed 
in the upper-left corner of your DeskMate desktop are not correct, you will 
need to change it. 

1. Select Date and Time from the Options Menu. The Set Date and 
Time dialog box is displayed, as shown in Figure 14-3. 

Figure 14-3. Set Date and Time dialog box. 

2. DeskMate will display your current system date. If the date is not 
correct, select the Date field and type the correct date. 

DeskMate will display your current system time. If the time is not 
correct, select the Time field and type the correct time. Time is dis- 
played in 12-hour increments, so press the AM or PM button to 
indicate the correct time. 

Once you are satisfied with your choices, press the on-screen OK 
pushbutton to save your work. 
Or 
Press the on-screen Cancel pushbutton to return to the original default 
settings. 

3. 

4. 

Printer settings 
DeskMate needs to know what kind of printer you are using, what printer 
port it is hooked up to, and what size pitch you want the type to be. 
However, Quicken ignores DeskMate’s printer setup. Even after setting up 
your printer for DeskMate, you will need to set some printer settings in 
Quicken. 
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Select Printer from the Options Menu. The Setup Printer dialog box is 
displayed, as in Figure 14-4. 

I 
0 Line feed f i l t er  
Characters Per Inch:m18 9 1 2  9 1 6 , 7  
Printer Ports: 8 L P T l  QLPT2 9 L P T 3  

i!m=- 
I’ 

Figure 14-4. Setup Printer dialog box. 

Select your printer by highlighting the name on the list in the Printers 
box. You don’t need to fill in the Driver name, because the correct 
driver name will automatically be filled in once you have highlighted 
your printer name. If you don’t see your printer listed, select ASCII. 
This works on all printers. The only disadvantage is that you won’t be 
able to print at different pitches. 

Quicken has its own setup for pitch selection. You should base the 
remaining choices on other programs you will be running with Desk- 
Mate. 

Once you are satisfied with your choices, press the on-screen OK 
pushbutton to save your work. 
Or 
Press the on-screen Cancel pushbutton to return to the original default 
settings. 

Colors 
The Colors option allows you to create the screen color combination that is 
most appealing to you. You need to set colors only if you have a color 
monitor, or if your monitor shows shades of gray. If you have a mono- 
chrome monitor, the Colors option will be grayed out, and you will not be 
able to use this option. Depending on the type of monitor you are using, 
the dialog box may be slightly different. 

1. Select Colors from the Options Menu. The Set Colors dialog box is 
displayed, as in Figure 14-5. 
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Figure 14-5. Set Colors dialog box. 

2. Four horizontal elevator bars will be displayed, one for Red, Green, 
Blue, and Brightness. Click on either the Less or More arrows at the 
ends of each bar and watch the color combination and brightness 
change. 

Once you have selected the combination you prefer, press the Perma- 
nent button to make a permanent change. Pressing the Temporary 
button will make a temporary change to the colors but will not save 
the changes to disk. 

Once you are satisfied with your choices, press the on-screen OK 
pushbutton to save your work. 
Or 
Press the on-screen Reset pushbutton to reset. 
Or 
Press the on-screen Cancel pushbutton to return to the original default 
settings. 

3. 

4. 

Quicken Page Setup 
Quicken's Page Setup controls how Quicken's checks, Check Register, and 
various reports print. Through Page Setup you may change margins, page 
lengths and widths, etc. 
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You can create up to six different Page Setups, giving each a different 
name. You may want to create different Page Setups for the different types 
of checks you print and for the various reports you create, for example, 
extrawide reports. You select which Page Setup to use right before you 
print. 

To create a Page Setup: 

1. Choose Page Setup from the File Menu. Quicken displays the Choose 
Page Setup dialog box, as shown in Figure 14-6. This box lists the six 
Page Setups. 

8 Page Setup 2 
fi Page Setup 3 
fi Page Setup 4 
8 Page Setup 5 
fi Page Setup 6 

Figure 14-6. Choose Page Setup dialog box. 

2. Select the name of the Page Setup you want to modify. All six will be 
set initially to the same default settings and called Page Setup 1, Page 
Setup 2, etc. To create a new Page Setup, you select an existing one 
and modify it. You can use 
the on-screen OK pushbutton to open it. Quicken displays the Page 
Setup dialog box for the Page Setup you have chosen, as in Figure 14- 
7. The Setup Name field is highlighted. The original default has been 
entered. 

or to select a Page Setup, and press 
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The name of this setup. 

A check here tells 
Quicken to pause 
between Daaes to let 

Distance in characters from the left edge Number of characters in a printed 
line. For most printers, this 
number is 80 if the pitch is 10 
characters per inch, or 96 if the 
pitch is 12 CPI (assuming a left 

g. 

’ margin of 0). 
you put iri a“new sheet 
of paper if you are 
using a sheetfeed 
printer (rather than a 
continuous form). \ 
A check here tells 

Printed l ine  width: 

IT- Total l i n e s  per page: 
y E d p : : ; : s  per page: 6B 

\ 
0 Send control sequence 

per inch: 
a 1 0  m12 Q16,7 - \ 

Quicken to start its 
printing process by 
sending any printer 
control codes you’ve 

-lm3- typed into the Edit 
Codes dialog box. 

Press this on-screen button to type in or edit the printer control codes 
that Quicken sends to the printer before it starts to print. 

3. 

4. 

5. 

Figure 14-7. Page Setup dialog box. 

Total number of lines it is possible 
to print on the paper you’re using. 
Many printers produce 6 lines per 
inch, or 66 lines for an 11 -inch 
page. 

The number of lines that Quicken 
actually prints on each page; be 
sure to allow for top and bottom 
margins. 

The number of characters you 
want your printer to print per inch. 
Also called “pitch” or CPI. 

If you want to change the name to something more descriptive, type in 
a new setup name, for example, Wide Reports. If you leave the name 
unchanged, Quicken saves your new settings to the same name. 

Select the Left margin field; you can click on it or press m. Type in 
the left margin for this setup in number of characters. In the same 
way, type in numbers for Printed line width, Total lines per page, 
and Printed lines per page. 

If you want Quicken to pause between pages, rather than print 
continuously, select the Pause field. 

If you want Quicken to send a control sequence to the printer, 
select the Send control sequence field. See the next section, 
”Entering control codes,” for more information. 

Press one of the three on-screen Characters per inch buttons: 10,12, or 
16.7 (condensed print). This does one of two things: 

a. If you are using a printer driver capable of setting the printer into 
different pitches, this will set the printer. 

b. If you are using a printer driver that can’t set printer pitches (e.g., 
ASCII), this simply tells Quicken what the printer is printing out. 
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You may set the printer either manually (some printers can be 
changed by pressing buttons on them) or by supplying the correct 
control sequence to set printer pitch. 

To enter a printer control sequence, press the on-screen Edit Codes 
pushbutton. Quicken displays the Edit Control Codes dialog box. 
Type in the control codes you want Quicken to send before print- 
ing, and the control codes (if any) you want Quicken to send after 
printing. Your printer’s manual will list the control codes for the 
printer. These codes can change the way your printer prints (letter 
sizes, spacing, pitch, etc.). When you are satisfied, press the on- 
screen OK pushbutton or press the on-screen Cancel pushbutton 
to return to the Page Setup dialog box without entering any 
control codes. 

6.  When you’re satisfied with this particular Page Setup, press the on- 
screen OK pushbutton. Press the on-screen Cancel pushbutton to 
return to the screen where you were when you started. 

Entering control codes 

You can send control codes to the printer before, after, or both before and 
after you print anything. You might use control codes to select letter- 
quality or draft printing, or to change the printer’s character size (24 point, 
for example) or pitch (if using ASCII driver). You must refer to your printer’s 
manual to learn the control codes for your specific printer. 

The examples in the table below show the format in which you must enter 
control codes in the Before printing and After printing fields. The ex- 
ample is for IBM graphics and compatible printers if you want emphasized 
print. 

In the Before printing field, enter: 
In the After printing field, enter: 

\ 27E 
\ 27F 

Quicken Tip: If you select pitch for printer drivers that know how to 
select that pitch, you need not do anything else. If the printer driver 
doesn’t know how to select that pitch (e.g., ASCII), you may need to 
explicitly set the pitch via pitch control codes (in addition to selecting pitch 
at Page Setup). 

The control codes you send to the printer remain in effect until you change 
printer settings again and explicitly change or remove them. 
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Printing with Page Setups 

When you want to print in Quicken, select Print Register from the File 
Menu. Quicken will display the Print To dialog box to ask you which 
Page Setup you wish to use. Typically, you’ll have a specific page setup 
for what you are printing, for example, CHECKS or REGISTER (see Figure 
14-8). 

Print t o :  8 Frf:ter 

Figure 14-8. Print To dialog box. 

To print to a printer: 

1. Press the on-screen Printer button. 

2. Press lTabl to move the cursor to the Page Setup list, and then use 
or to select a Page Setup, or you can click the appropriate Page 
Setup with the mouse. 

3. Press the on-screen OK pushbutton. Quicken continues and displays 
the Print Checks, Print Register, or Print Report dialog box, depend- 
ing on what you are printing. Refer to the previous chapters on 
printing. 

To print to file: 

1. Press the on-screen File button. Quicken’s File name field becomes 
active (ungrayed). 
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2. 

3. 

Type the filename to which you want Quicken to print. 

Press the on-screen OK pushbutton. Quicken prints its file to disk. 

Note: You cannot print checks to a filename on disk. When printing 
checks, the File button is unavailable (grayed out). 

Other Settings 
Quicken has a number of other program settings that you can change to 
suit your own preferences. 

To change Other Settings: 

1. Choose Other Settings from the File Menu. Quicken displays the 
Other Settings dialog box (see Figure 14-9). 

R Beep when recording and memorizing 
[XI Request confirmation (for example 

when changing the Check Register) 
0 Require Kategor in memo of all 

new transaciions 
0 Extra message line on check (printed 

on check but not recorded) 
Days in advance to remind of postdated 

checks and scheduled groups (8-38) 

Figure 14-9. Other Settings dialog box. 

2. Select each of the four fields whose features you want to change. See 
the explanation of each field in the text below. 

(For hard disk users only.) Type in the number of days in advance you 
want Quicken to remind you of postdated checks and scheduled, 
groups to execute via the !F9 Messages Menu and the Billminder 
program when you turn on your computer. 

When satisfied with your settings, press the on-screen OK pushbutton. 
Press the on-screen Cancel pushbutton to return to the Check Register 
or Write Checks screen without changing the existing settings. 

3. 

4. 
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Quicken’s other program settings are described below. 

Beep when 
recording and 
memorizing 

You can turn Quicken’s beeping sound on or off. If you turn the beep 
off, you won’t hear beeps when Quicken records, memorizes, 
or deletes transactions. The default is for on (Quicken beeps). 

Request 
confirmation 

Select this field if you want Quicken to ask you to confirm when you 
delete or change transactions in your Check Register. The default is on 
(Quicken will confirm). 

The advantage of having the confirm questions turned off is that you 
needn’t use as many keystrokes or mouse clicks-especially when chang- 
ing transactions in the Check Register. The disadvantage is that Quicken 
does not stop you and give you a chance to reconsider whether what you 
have typed is correct before Quicken records it. 

Require 
@Category 

Select this field and Quicken will warn you if you try to record a 
transaction without an @Category in the Memo field. The default is off. 

This is useful if you want to keep complete categorized records of your 
income and expenditures to use in Quicken reports. Note that this feature 
will not examine splits. If you are categorizing splits without putting an 
@Category in the Memo field, you’ll get a warning message that the 
transaction has no @Category. In this case, ignore the warning. 

Extra message 
line on check 

Select this field for Quicken to add an extra message line on 
your checks. If you choose to have an extra message line, it appears to the 
right of the address, as in Figure 14-10. To type a message in the extra 
message line on the check, click there or press lTabl as needed to move the 
cursor to the extra message line. Type your message and press again. 
The cursor moves to the second line of the address field. Quicken prints 
this message line on your checks, but does not record it in the Check Register. 
The extra message line is useful for such things as typing a charge account 
number on your check. Quicken can memorize the extra message line, but 
does not add it to the Check Register. 
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+ 
DBTE 1/19/98 

- 

$ 
PRY TO THE 
ORDER OF 

DOLLBRS 
MSC: Bct 4824 512 711 124 

RDDRESS 

MEMO - +, 

Ending Balance: $2,508.08 
~~~ 

Figure 14-10. Check with extra message line. 

Quicken can remind you to print postdated checks and execute 
scheduled Transaction Groups several days before their scheduled dates. 
This helps ensure that your bills are paid on time if, for example, you don’t 
use Quicken every day. Quicken comes set to begin reminding you three 
days before a scheduled date. If the scheduled date is Thursday, Quicken 
first reminds you on Monday. Note that weekends don’t count. Quicken 
treats checks or groups falling due on a weekend as though they fell due 
on the preceding Friday. 

Set the days in advance on the basis of your frequency of use. To do this, 
type in the number of days in advance that you want to be reminded. 

Days in advance 
to remind 

Frequency of Use Table for setting Days in advance to remind 

How often you use your computer Set Days in advance to 

Daily (except weekends) 0 days 

At least every other day 1 day 
At least once every three days 2 days 
At least weekly 6 days 
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U’I Quicken 

Credit cards and cash 

Budgeting 

Cash management 

Personal income taxes/Form 1040 

Employee business expenseslForm 21 06 
______ ~~ 

Home businesslschedule C 

Rental propertylSchedule E 

Assets and liabilities 

This chapter tells you how Quicken can act as a powerful home accounting 
system to keep track of your personal finances. 

This chapter and the ones that follow do not cover the additional uses and 
reports that Quicken provides when you use it with Lotus@ 1-2-38, 
Symphony@, or any Lotus-compatible spreadsheet program using the 
Quicken Transfer Utility program. The manual that comes with the 
Quicken Transfer Utility discusses these uses and reports in detail. 

The Transfer Utility links Quicken and 1-2-3. With it, Quicken transfers 
data automatically into Lotus worksheets-even those you may have 
custom tailored. The Transfer Utility package also provides a set of 
spreadsheet templates (worksheets already set up for you). 

To obtain your Quicken Transfer Utility, see the flyer in your Quicken 
package, or select Order Supplies from the Activities Menu. 
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Credit cards and cash 
With Quicken you can categorize and track credit card and cash expenses, 
along with your regular checking account expenses. You can keep detailed 
track of where all of your money is going, and best of all, you can do it 
without having to type in every credit card or cash transaction. 

Credit cards 
You don’t need to enter credit card transactions each time you use your 
card. Instead, wait until you pay your bill. Then, when you write the one 
check to cover the credit card purchases, refer to your credit card bill and 
use a Split Transaction to allocate amounts from the single check to the 
appropriate @Categories, as shown by the purchase records on the bill. 
For example, say that your department store credit card has six transac- 
tions and five are clothing and one is a gift. Write the check to pay the bill; 
then split the transaction among the different purchases. 

To split a transaction: 

1. 

2. 

3. 

4. 

5. 
6. 

7. 

8. 

Make sure the check you want to split is on the screen. (If you haven’t 
written the check yet, display a blank check and fill in the date, payee, 
and amount.) 

From the Edit Menu, choose Split Transaction (or press m+B). 
Quicken displays the Split Transaction dialog box. You can enter up 
to 15 different memos and amounts in a Split Transaction dialog box. 

Type your @Category for gifts (for example, @Gifts) in the Memo 
column of the Split Transaction dialog box. 

Press lTabl to move to the Amount column. Type in the amount of the 
gift. Quicken calculates the remainder automatically. In this example, 
the remainder is the clothing amount. 

Press lTabl or click on the next line of the Memo column. 
Type your @Category for clothing (for example, @Clothes). 

Press the on-screen OK pushbutton (or press 1-1) to record the 
split and return to the Write Checks screen. 

Press the on-screen Accept pushbutton to record the check. 

Cash 
You can use the same method for cash as for credit cards, but most people 
don’t want to take the time to categorize every cent of cash they spend. 
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One suggestion for accounting for cash expenditures is to assign all cash 
withdrawals and ”less cash  amounts from deposits to an @Category 
named, say, @CashMisc. 

If you then spend a significant amount of cash for something that belongs 
in another @Category, use a Split Transaction to allocate a portion of the 
cash withdrawal to the appropriate @Category. Splitting transactions is 
described in Chapter 9, Split Transactions. For cash expenditures that don’t 
affect the balance in your bank account-but which you still wish to 
record-see the section ”Zero-amount transactions” on page 9-6, in Chap- 
ter 9. 

Budgeting 
Quicken is very flexible: it can budget all your expenditures or just the 
ones you’re interested in budgeting. Quicken doesn’t force you to do more 
work than you want to. 

The budgeting process with Quicken has three parts: 

Assigning transactions to @Categories. 
Producing a Budget Report. 

Establishing income and expense @Categories to use. 

Establishing budget categories 

To use Quicken for budgeting, establish a set of income and expense 
@Categories-sometimes called “budget categories.” Quicken’s 
@Category feature allows you to enter @Categories all at once or “on the 
fly” as you type in transactions. (See Chapter 8, @Categories.) 

You don’t need to establish a rigid set of @Categories before you can use 
Quicken. Instead, you can add to or modify your @Categories at any time. 
You can also recategorize past transactions-for example, if you want to 
divide one old category into two new ones, and need to distribute the past 
transactions among the new categories. 

Typical @Category List 
The following list is typical of home @Categories. For ease of use, the 
actual @Category names are abbreviated. You can use numbers, if you 
prefer, in the manner of an accounting-style chart of accounts. You can 
leave off descriptions if they’re redundant. 
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Quicken alphabetizes the list by @Category name, not by Description, both 
in the @Category List and in reports subtotaled by @Category. Note that 
- Otherexp and -0therinc each begin with an underline character (J so 
that they show up last in reports. 

Quicken tip: Put only one @Category in each transaction (or in each line 
of a split transaction). Then you should see the same list of @Categories on 
both the Budget and @Category Reports. To get different @Categories to 
appear on adjacent lines in the reports, give them @Category names that 
are alphabetically next to each other. For example, to get home repairs, 
utilities, and mortgage to appear next to each other, give them names such 
as @H-repairs, @H-utilities, and @H-mortgage. 

List of typical @Categories and their descriptions. 

@Category 

Auto 
Bonuses Bonuses Earned 
Charity Charity Donations 
Christmas 
Dividends Dividends Earned 
Dues 
Education 
Enter Entertainment 
Gifts 
Groceries 
Household 
Housing 
Insurance 
Int-Earned 
Int-Paid 
Major 
Med 
Recreation 
Savings 
Subscriptions 
Taxes 
Utilities 
- Otherexp 
- Otherinc 

Description 
._______ 

MortgageiRent 

interest Earned 
Interest Paid 
Major Expenses 
Medical & Dental 

Savings Fund 

Other Expenses 
Other Income 
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Assigning transactions to @Categories 

Assigning a transaction to an Category is easy. You can pick from a list 
of existing @Categories, or create a new @Category as you need it. 

To pick an existing @Category: 

1. When it's time to assign an @Category, choose Recall @Category from 
the Quick Entry Menu. You can also press m+@. Quicken 
displays your existing @Category List. 

Select the @Category you want. Quicken enters that @Category for 
you. 

Press the on-screen OK pushbutton. 

2. 

3. 

For more details on assigning @Categories, see Chapter 8. 

If you split a transaction: 

If you split a transaction, you can assign an @Category either to the full 
transaction or to each item in the split. Normally, you would not assign 
@Categories to both the full transaction and the split items. 

To require an @Category for each transaction: 

To make it easier for you to remember to categorize transactions, Quicken 
has a feature you can set that requires that every transaction be assigned to 
an Category. To require an @Category for your transactions: 

1. From the File Menu, choose Other Settings. Quicken displays the 
Other Settings dialog box, as in Figure 15-1. 

@Categories Required 
checkbox. 

IxI Beep when recording and memorizing 
N Request confirnation (for example 

' R Require Kategor . i n  meno of a l l  

0 Extra message l ine  on check (printed 
on check but not recorded) 

Days in  advance to  remind of postdated 
checks and scheduled groups (8-38) 

when changing the Check Register) 

new tramaclions 

m=@m 

Figure 15-1. Other Settings dialog box. 
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2. 

3. 

Check the Require @Category checkbox. 

Press the on-screen OK pushbutton to accept the new settings, or 
Cancel to leave the dialog box without making any changes. 

From now on, Quicken will warn you if you try to record a transaction 
without an @Category in the Memo field, but it still permits you to record 
it. 

Note: When you record a transaction with @Categories required, Quicken 
only checks the Memo field of that transaction for an @Category. If you 
have split the transaction and assigned an @Category to each line of the 
split, Quicken will still warn you that the transaction does not appear to be 
categorized by displaying the @Category Required dialog box. In this 
case, simply ignore the warning by pressing the on-screen NO pushbutton. 
Quicken will record the transaction as usual. 

Producing reports 

Reports that are particularly useful in home budgeting are the @Category 
Report and the Budget Report. For more information on @Category and 
Budget Reports, see Chapter 11, Reports. 

Creating an @Category Report 
The @Category Report can show any trends or patterns in your spending 
by month or by quarter. For example, are car expenses mounting slowly? 
How much have you been spending on entertainment lately? When you 
know this type of information, you can budget for it more effectively. 

To create an @Category Report: 

1. Choose @Category Report from the Activities Menu. Quicken dis- 
plays the Create @Category Report dialog box. (See Figure 15-2.) 

Enter a title (optional), a date range, and a time period to subtotal by. 

Press the on-screen Start Report pushbutton. Quicken produces the 
report. 

2. 

3. 
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Create @Category Report 
Report title (optional): lNONTHLY FINIINCES, lUCUST THRU OCTOBER I 
Restrict to transactions from: through: 118/31/891 
which are: Q Payments 0 Deposits rn Either 
and whose payee matches (optional): 
and whose memo Matches (optional) : 
and whose cleared status is: 

F 
Not cleared 8E!2(x or *) $3 Newly cleared (*I 

Subtotal by: Don’t subtotal Q Half Month Q Year 
k k w e e k s  8 !%er 

0 Select @Categories to include 

Figure 15-2. Create @Category Report dialog box. 

The resulting @Category Report will be similar to the abbreviated example 
shown in Figure 15-3. The OVERALL TOTAL at the bottom of the report is 
your net savings for the month. 11 the number is positive, you earned more 
than you spent. If the number is negative, you spent more than you 
earned. 

If the report shows a category called ”Not Categorized,” it means that 
Quicken found some transactions that were not assigned to an @Category. 
For a list of these transactions, create a Transaction Report restricted to 
transactions without an @ in the Memo field. (Do this by typing -..@.. in 
the whose memo matches field of the Create Transaction Report dialog 
box.) 

Note: If you don’t find these transactions by using the technique de- 
scribed above , you have transactions with @Categories that have been 
deleted from the @Category List. You must add these @Categories back to 
the @Category List. 
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81 1189- 
Category D C s c r I p f l m  8/89 9/89 10189 10/31/69 
............................................................. 

I n c m  
B m Y I e l i  Earned o m  5m.m 0.m 5m.m 
Interest Earned 21 43 25.64 25.75 7 2 . E  
Sal.?Y 7 , m . n  7,433.64 7,433.65 22,268.M 

TOTLL I n c w  7,122.M 7,959.28 7.459.40 22,840.88 

......................................... 

TOTAL EXPENSES 

1,295.6L 
0.m 

132.05 
24.m 

363.75 
274.M 
m . 4 3  

8o.m 

1,102.74 
1 m . m  
352.76 
462.27 
126.12 
372.84 
286.98 
174.76 

lST_8lNK P q r  1 
11/ 2169 

3.Mo.53 2,978.47 

1,173.76 3,572.14 

286.97 719.73 
171.m 76b.22 

0.W 150.12 

5o.m 1so.m 

3 5 4 . a  1,091.19 
2%.56 858.M 
49.92 1,115.11 

2,yU.71 8,622.71 

..................... 

.................... .......- ~ =-=_= _== ....... 
OVERALL TOTAL 4,361.67 4,980.81 5,075.69 14,418.17 

Figure 15-3. Typical @Category Report for home finances. 

Creating a Budget Report 

The Budget Report compares actual amounts spent with the amounts you 
have budgeted for your @Categories and calculates the differences be- 
tween the two by @Category. You can see exactly where you met your 
budget, where you exceeded it, and by how much. 

See Chapter 11, Reports, for a much more detailed description of Budget 
Reports and the process of editing the budget amounts the first time you 
do a Budget Report. The following steps assume you have already set the 
budget amounts. 

To create a Budget Report: 

1. From the Activities Menu, choose Budget Report. Quicken displays 
the Create Budget Report dialog box, as in Figure 15-4. 
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~ 

Create Budget Report 
Report title (optional): (NONTHLY BUDGET, OCTOBER I 
Restrict to transactions from: -through: llP/3v8917 

which are: Q Payments Q Deposits dlD Either 
and 
and 
and 

whose 
whose 
whose 

payee matches (optional): 
memo matches (optional) : 

Not cleared 
Newly cleared 

Don't subtotal 8 Half nonth 
Week Nonth 
Two ueeks quarter 

Q Year 

Figure 15-4. Create Budget Report dialog box. 

2. Enter a title (optional), date range, and a time period to subtotal by (see 
Figure 15-4). 

3. Press the on-screen Start Report pushbutton. Quicken produces a 
report similar to the one in Figure 15-5. 

1 ST-BLIIK 
111 2/89 

OVERLLL TOTAL 

0.w 250 w -250.m 
25.75 25.W 0.75 

7.433.65 7,400.W 3.65 
._____... ..____... .______... 
7.~59.40 7,675.~ -215.m 

1,ln 76 1,lW.W n.76 
50.W 50 W 0 W 
286.97 1W.W 186.97 
171.50 1W.W 71.50 
0.w lw.m -1m.m 

35L.M 350.W L . M  
M2.65 1W.m 102.65 

2.94.76 2,943.76 0.W 
t48.W 6 m . w  48.43 

15O.W 175.m -25.W 
194.66 lw.w 94.66 
5w.w 5w.w 0.m 
62.w M W  22.w 
87.37 1m.w -12.63 
296.56 275.m 21.54 
49.92 150 W -1W.M 

o.w m . m  -4oo.w 

.._._____ .......__ _.....____ 
7,152.58 7,163.76 -11.18 

==_===== ====.==== -=====--= 
y16.82 511.24 -2W.U 

Figure 15-5. Typical monthly Budget Report. 
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Transaction Report 

Quicken can also produce a report showing all the transactions that make 
up each budget category. Unlike the report in Figure 15-5, the Transaction 
Report is a detailed report that shows every transaction-not just a sum- 
mary of them. It allows you to see which individual transactions helped or 
hurt your budget. 

For more information on creating a Transaction Report, see Chapter 11, 
Reports. 

Cash management 
One important aspect of cash management is maximizing the interest you 
earn on your cash. Quicken gives you a way to earn more interest without 
spending less. 

Most households pay bills in one or two sittings per month. As a result, 
most bills are paid many days before their due dates. This results in lost 
interest for households with interest-bearing checking accounts. If the bills 
were paid later, just before their due dates, cash would remain in the check- 
ing account longer and earn more interest. Quicken makes that easy. 

How much more interest can you earn this way? Here’s a typical example. 
Say you pay $2,500 in bills each month. Quicken may enable you to pay 
those bills 10 days later each month on average. At 5% interest, you earn 
over $40 more interest every year. 

To manage cash and maximize interest earned from an interest- 
bearing checking account: 

1. Enter bills into Quicken as you receive them, at least every week or so. 

2. As you enter the bill, postdate the check for when you actually want to 
pay it. Remember to allow enough time for the check to reach the 
payee through the mail. See Chapter 10, Postdating Checks. 

3. You then have two options for printing and sending the checks: 

Let Quicken remind you when it’s time to print and mail checks. If 
you use a hard disk, Quicken‘s Billminder feature reminds you 
without even using Quicken-all you need to do is turn on your 
computer. See Chapter 10, Postdating Checks. 

Print all the checks at once, including postdated ones. The checks 
print in chronological order. Keep the stack handy-say, in a desk 
drawer. Check it every few days and mail the checks that are 
coming due. 
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Personal income taxedform 1040 
Quicken greatly simplifies the preparation of your Federal Income Tax 
Return (Form 1040) and related tax schedules. Below is a list of tax cate- 
gory descriptions that match frequently used lines on Form 1040 and 
Schedules A (Itemized Deductions) and B (Interest and Dividend Income). 
You can add the categories you use to your @Category List (see Chapter 8, 
@Categories) and use them to categorize your transactions. @Category 
descriptions can't exceed 25 characters, so abbreviate the category descrip- 
tions below as you wish. At tax time, Quicken quickly produces @Cate- 
gory Reports that help you prepare your return. 

Alimony paid 
Alimony received 
Casualty and theft losses 
Charity contributions c $3000 
Charity contributions >$3000 
Dividend income 
Home mortgage interest paid 
Investment interest paid 
IRA contribution 
Keogh contribution 
Medical other 
Medical transport and lodging 
Medicine, doctors, etc. 
Medicines & drugs 
Mortgage interest to banks 
Mortgage interest to individuals 
Moving expenses 
Other deductions 
Other income 
Pensions received 
Personal interest paid 
Points 
Real estate tax 
Spouse's IRA contribution 
Tax-exempt interest income 
Taxable interest income 
Union & professional dues 
Wages 
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Employee business expenses/Form 2106 
Quicken can help you report your unreimbursed business expenses for IRS 
Form 2106 (Employee Business Expenses). The categories below corre- 
spond to lines on the current Form 2106. 

Business car-gas, oil, etc. 
Business car-rental 
Meals & entertainment 
Other travel expenses 
Parking, tolls, train, bus 
Reimbursements not on W2/1099 
Reimbursements on W2/1099 
Travel-lodging, plane, etc. 

Home business/Schedule C 
Quicken has many home business uses. Chapters 16 and 17 discuss in 
detail Quicken’s business uses, and include categories to use for the IRS’s 
Schedule C-Profit (or Loss) from Business or Profession. 

If you run a home business using your personal checking account, prefix 
each @Category for business transactions with BUS in the Memo field (for 
example, BUS @PHONE or BUS @RENT). Don’t prefix personal transac- 
tions. If a transaction is part business and part personal, split the transac- 
tion into the business part and the personal part. 

When you produce reports, restrict them by typing ..BUS.. in the memo 
matches field of the Create Report dialog box. The resulting reports will 
be based only on business transactions. To produce reports on your 
personal transactions, restrict them by typing -..BUS.. in the memo 
matches field of the Create Report dialog box. 

Rental property/Schedule E 
Quicken can track rental property income and expenses for Schedule E 
(Supplemental Income). If you own several properties, it can keep records 
for each property separate. See Chapter 17 for a description and an 
example of this procedure. 
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Assets and liabilities 
Producing a personal balance sheet of all assets and liabilities requires a 
good deal of work and a knowledge of double-entry accounting. Most 
people don’t want to invest the time it takes to do this on a regular basis. 

However, as you type in your transactions, Quicken can easily track assets 
and liabilities whose values change regularly. For details, see Chapter 17, 
Business Uses: Bookkeeping, Petty Cash, and Payroll. 
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0 Payables, Receivables, and Cash Flow 

Accounts payable 

Forecasting cash requirements 

Accounts receivable 

Forecasting cash flow and cash position 

Quicken has many business uses beyond paying bills and maintaining a 
check register. These include accounts payable, accounts receivable, petty 
cash, and reporting income and expenses by job, property, or client. 
Quicken is used by businesses ranging in size from home businesses to 
large corporations (who use it for petty cash accounting). Many nonprofit 
organizations such as churches and charities also use Quicken. 

Quicken’s power and flexibility come from a flexible reporting system that 
can produce many different kinds of reports for many different uses. 
Quicken is not “hard-wired” to produce a given report, such as an ac- 
counts payable report. With Quicken, you need to learn only a few func- 
tions that can be used in many ways. This chapter contains some examples 
to show you Quicken‘s potential. As you use Quicken, you’re sure to find 
other ways that this highly flexible program can help you in your business. 

Note that this chapter and the ones that follow do not cover the additional 
uses and reports that Quicken provides when used with Lotus 1-2-3, 
Symphony, or compatible spreadsheets. These uses and reports are 
discussed in the on-disk manual that comes with the Quicken Transfer 
Utility. The Quicken Transfer Utility provides the means for linking 
Quicken with 1-2-3. It enables Quicken to enter its data automatically into 
Lotus spreadsheets, even those you have custom-tailored to meet your 
own needs. To obtain your Quicken Transfer Utility, see the order blank 
included in your Quicken package, or choose Order Supplies from the 
Activities Menu. 
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Accounts payable 
Quicken organizes your payables so that you know how much you owe, to 
whom, and when the payments are due. You can use Quicken to forecast 
your cash requirements. Quicken can do all this without any extra work 
on your part. 

Postdating checks 

To use Quicken for accounts payable, enter each bill you receive into 
Quicken when you receive the bill. Postdate each check with the date on 
which you plan to pay that bill (see page 10-5). Those postdated payments 
form your ”accounts payable.” 

When Quicken prints your checks, it automatically prints all checks dated 
on or before the current date and holds the remaining postdated checks for 
future payment. (Of course, you can change the date through which you 
want Quicken to print its checks in the Print Checks dialog box.) 

To review checks before printing: 

Before printing checks, you may want to review the checks about to be 
printed. 

1. From the Activities Menu, choose Write Checks. You can also press 
m + m .  Quicken displays the Write Checks screen. 

Use m] and [P9Dnl to ”flip” through the display of unprinted 
checks. If you have a mouse, you can click on the scroll bar. Quicken 
displays the checks in chronological order. 

2. 

To delay paying a bill: 

1. 

2. 

Choose Write Checks from the Activities Menu. 

Select the check you wish to delay paying by using ml and ml 
or by clicking on the scroll bar with the mouse. 

Move the cursor to the Date field and change the date of the check to 
the future date on which you want to pay it. You can change the date 
quickly by using . 

Press the on-screen Accept pushbutton to record the change in the 
Check Register. 

3. 

4. 

16-2 Quicken User Manual 



Chapter 16. Business Uses: Payables, Receivables, and Cash Flow 

To pay a postdated check early: 

1. 

2. 

Choose Write Checks from the Activities Menu. 

Scroll to the check you wish to pay early by using ml and IP9Dn] or 
by clicking on the scroll bar with the mouse. 

Move the cursor to the Date field and change the date of the check to 
today's date. You can change the date quickly by using m. 
Press the on-screen Accept pushbutton to record the change. The 
check is now ready to be printed. 

3. 

4. 

Accounts payable reports 

Quicken has three useful ways of showing your accounts payable. 

Cash requirements by day 
Postdating checks allows you to see your cash requirements by day, since 
they appear below the Today Line in the Check Register. To print this 
portion of the Check Register: 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Display the Check Register by choosing Check Register from the 
Activities Menu. You can also press @+m. 
When the Check Register appears on the screen, choose Print Register 
from the File Menu. Quicken displays the Print To dialog box. 
Indicate that you want to print to the printer by pressing the on-screen 
Printer button. 

Choose which Page Setup you wish to use. Press the on-screen OK 
pushbutton. Quicken displays the Print Register dialog box. 

Set the date range in the Print Register dialog box to cover from 
tomorrow to some date in the future-covering any date range you 
want to analyze. 

If you wish, type in a descriptive title, such as Cash Requirements. 

Check the appropriate checkboxes if you want the transactions printed 
one per line and if you want to print splits detail. 

Press the on-screen OK pushbutton to begin printing. 
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Accounts Payable by Week 

Accounts Payable by Week is a type of report used by many businesses. 
To see your accounts payable by week: 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

From the Activities Menu, choose Transaction Report. Quicken 
displays its Create Transaction Report dialog box (Figure 16-1). 

Create Transaction Report 
Report title (optional): IIICCOUNTS PIIYIIBLE BY WEEK 
Restrict to transactions from: through:118/31/8?jl 

1 
which are: m Payments 0 Deposits 0 Either 
and whose payee matches (optional 1 : 
and whose memo matches (optional) : 
and whose cleared status is: 

E 
Not c 1 eared 8Xkig(x or *) 8 Newly cleared (*I 

Subtotal by: 0 Don’t subtotal Half month 
m Neek 8 Month u Two weeks Quarter I 0 Show totals only 

Figure 16-1. Create Transaction Report dialog box set up to 
produce an Accounts Payable by Week report. 

Select the Report title field and type a descriptive title. See Figure 16-1 
for an example. 

Set the date range in the from and through fields to cover from tomor- 
row to some date in the future-covering any date range you want to 
analyze. 

Press the on-screen Payments pushbutton to restrict the report to 
transactions that are payments only. 

Do not restrict by payee, memo, or cleared status. 

Since the report is based on weekly information, press the Week 
button in the Subtotal by section. 

When you have finished setting up the Transaction Report, press the 
on-screen Start Report pushbutton. The report produced by the 
Create Transaction Report dialog box in Figure 16-1 appears in Figure 

Note: The report will print to the screen. Once the report is on the 
screen, select Print Report from the File Menu to have the report print 
out on paper. The printing procedure for reports is explained on page 

16-2. 

11-16. 
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OVERALL TOTAL 101 9189 - 1OI31189 

miAL INCCUE 
miAL WEUSES 

UET TOTAL 

-932.56 
-14,889.W 

-732.72 

-16,554.32 

-10.542.m 
-31.85 
-92.a 

4 5 4 . 9 3  
- 8 . i a . m  

.:9,43.83 

-ui.ar 
-5m.m 

-921.8r 

-32,m.w 
-7,445.89 

-im.ar 

Figure 16-2. Typical Accounts Payable by Week report. 

Accounts Payable by Supplier 

Quicken can also show Accounts Payable by Supplier, :hat is, how much 
and to whom you owe payments. To create such a report: 

1. 

2. 

3. 

4. 

Choose Transaction Report from the Activities Menu. Quicken 
displays its Create Transaction Report dialog box. 

Select the Report title field and type a title for the report similar to that 
in Figure 16-3. 

Set the date range in the from and through fields to cover from tomor- 
row to some date in the future-covering any date range you want to 
analyze. 

Press the on-screen Payments pushbutton to restrict the report to 
transactions that are payments only. 
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5. 

6. 

Do not restrict by payee, memo, or cleared status. 

Since the report is based on payee information, press the Payee button 
in the Subtotal by section. 

7. When you have finished setting up the Transaction Report, press the 
on-screen Start Report pushbutton. The report produced by the 
Create Transaction Report dialog box in Figure 16-3 appears in Figure 
16-4. 

Create Transaction Report 
Report title (optional): IftCCOUNTS PllYllBLE BY WEEK 
Restrict to transactions from: t h r o u g h : [ m l  

I 
which are: Payments Q Deposits 0 Either 
and whose payee matches (optional): 
and whose memo matches (optional) : 
and whose cleared status is: 

E 
Not cleared 

8 R E i g ( y  or *) 8 Newly cleared (*) 
Subtotal by: Q Don't subtotal Half month 

QD Week Month Payee u Two weeks Quarter - I 0 Show totals only 
Figure 16-3. Create Transaction Report dialog box set up for an 
Accounts Payable by Supplier report. 
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1sr-w 
101 6/89 

ACCOWTS PAYWE 81 SUPPLIER 
101 9/69 T h r W  10l31169 

WEULL T o m  

Figure 16-4. Typical Accounts Payable by Supplier report. 

Forecasting cash requirements 

Quicken can go a step beyond accounts payable by forecasting how much 
cash you will need to cover all your future payments, even those you 
aren't billed for, such as payroll. (Note that Quicken can forecast cash 
coming in, as well as cash going out, enabling you to forecast your exact 
cash position. For details, see the section on "Forecasting cash flow and 
cash position" later in this chapter.) 
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To forecast cash requirements, enter into Quicken all payments you expect 
to make, even if you haven‘t or won’t be billed for them. To see what your cash 
requirements are, use the same reports described in the ”Accounts pay- 
able” section above. 

Quicken tip: Use Transaction Groups, as described in Chapter 7, to reduce 
keystrokes when typing in future transactions. For example, say that you 
write 11 payroll checks every two weeks. Memorize each of these transac- 
tions with its typical dollar amount. Assign all 11 to one Transaction 
Group. You can then enter several months of expected payroll expenses 
with just a few keystrokes. Later, as you learn the precise dollar amounts, 
you can change the amounts and splits in the Check Register accordingly. 

Accounts receivable 
Quicken can track your accounts receivable. Just type a quick summary of 
each invoice or statement you generate into one Quicken account desig- 
nated for accounts receivable. You will then be only a few keystrokes 
away from a complete summary of how much you’re owed, by whom, and 
on what date. You won’t have to hassle with index cards, file folders, or 
handwritten lists. Receivables that are lost because you forgot to catch up 
with wayward customers will be a thing of the past. You’ll know exactly 
who’s late making payments, so you can collect on time, rather than 
months past the due date. 

Note: If your objective in tracking your receivables is to forecast your cash 
flow, see the section on “Forecasting cash flow and cash position” later in 
this chapter. 

Entering new in voices 
To use Quicken for accounts receivable, you need to set up a new “bank 
account” (see Chapter 13, Account Activities). Give this bank account a 
descriptive name, such as ”Acct-Rec.” The Opening Balance for your 
accounts receivable account should be zero. 

Quicken tip: Don’t put accounts receivable into your real checking 
account. To track who is late in paying you, you must enter the accounts 
receivable transactions into a separate ”bank account” set up for accounts 
receivable. 
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Assemble all your invoices (or statements, if that’s how you bill customers) 
and type a summary of each into the Check Register of the accounts 
receivable account you just set up. See the following example. 

To enter a receivable: 

1. From the File Menu, choose Open and select the account you’ve set up 
for your receivables. Quicken will display the Check Register for the 
account. 

Type the date due in the Date column and your invoice number in the 
Num column. 

Type the name of the customer you are billing in the Payee line. 

Type the amount of the invoice in the Deposit column. Use the 
Payment column for credit memos, which indicate that you owe a 
customer money. 

Type the date you issued the invoice in the Memo line. 

2. 

3. 

4. 

5. 

A typical accounts receivable Check Register appears in Figure 16-5. 

Quicken tip: Don’t forget to use Quicken’s many keystroke-saving 
features. Use 
Use Memorized Transactions for customers you bill regularly. Use Split 
Transactions if you need more room for notes or to split the invoice into 
different item parts. 

to automatically increase the invoice number by one. 

Figure 16-5. Check Register used for accounts receivable. 
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Entering paid invoices 

To handle partially paid invoices: 

If an invoice is partially paid, here’s how to keep track of the amount still 
outstanding. 

1. 

2. 

3. 

4. 

5. 

Display the Check Register for the receivables account. Select the 
invoice that has been partially paid. 

Highlight the dollar amount with the mouse or press 
cursor there; press m. Do not type a zero. 

From the Edit Menu, choose Split Transaction. Quicken displays its 
Split Transaction dialog box. 

Type the total amount of the invoice on the first line of the Amount 
column. Type the payment received on the second line of the Amount 
column, with a minus sign (-) in front of the payment. 

Press the on-screen OK pushbutton. Quicken subtracts the payment 
from the total amount of the invoice and enters the remainder in the 
Deposit column of the Check Register. 

to move the 

To handle fully paid invoices: 

When an invoice is paid in full, you can handle it in either of two ways. 
Whichever way you choose, you should apply it consistently. 

Delete the invoice transaction from the Check Register. After you 
delete paid-in-full invoices, the Check Register shows only the out- 
standing invoices. For details, see ”Accounts receivable reports” 
below. 

Or 
A more complete way is to type the payment in a Split Transaction for 
the invoice as described above, but enter only the full amount. Once 
the payment is entered, the amount for the invoice transaction will be 
zero. This gives you a record of each customer‘s payment history. For 
details, see the section on “Customer Payment History” later in this 
chapter. 

Whichever way you handle fully paid invoices, the Ending Balance in the 
Check Register of your receivables account is the total amount of your 
accounts receivable. 
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Accounts receivable reports 
You can use the receivab1f:s information in several ways. 

Overdue invoices 

Because invoices are arranged by the date due, overdue invoices are easy 
to spot since all invoices appearing above the Today Line are overdue. 
However, this is true only if you’re using the ”delete paid invoice” 
method. If you are using the ”split” method, only nonzero amounts at the 
beginning are overdue. The invoices at the beginning of the Check Regis- 
ter are the most overdue. The Check Register’s Current Balance is the total 
amount of all overdue invoices. 

To print a list of the overdue invoices in order of “age”: 

1. Choose Print Register from the File Menu. Quicken displays the Print 
To dialog box. Select the Page Setup you want to use. Press the on- 
screen OK pushbutton. Quicken displays the Print Register dialog 
box. 

Set the date so that the from date is on or before the actual date of the 
oldest invoice and the to date is today’s date. 

Type in a descriptive title such as Overdue Invoices in Age Order in 
the Title field. 

Check the appropriate checkboxes if you want the transactions printed 
one per line and if you want to print splits detail. 

Press the on-screen OK pushbutton. 

2. 

3. 

4. 

5. 

Receivables aged by week 

At times, you might want a report showing all your receivables, paid and 
unpaid. Many companies analyze their receivables on a weekly basis. 

To see your receivables aged by week: 

1. From the Activities Menu, choose Transaction Report. Quicken 
displays its Create Transaction Report dialog box. 

Type in a descriptive title, such as Receivables Aged by Week. 

Set the date range to cover all invoices from first to last. 

2. 

3. 
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4. Since the report is based on weekly information, press the Week 
button in the Subtotal by section. 

Press the on-screen OK pushbutton. The report will be displayed on 
the screen. More information on reports and printing them can be 
found in Chapter 11. 

5. 

Receivables by customer 

Aside from wanting to know how much money is owed to you, it is impor- 
tant to know who owes you. Creating a report based on the customers can 
produce valuable information. 

To see your receivables by customer: 

1. 

2. 

3. 

4. 

5. 

From the Activities Menu, choose Transaction Report. Quicken 
displays its Create Transaction Report dialog box. 

Type a descriptive title, such as Accounts Receivables by Customer. 
Your Create Transaction Report dialog box should look like that in 
Figure 16-6. 

Set the date range to cover the due dates for all invoices you've issued. 

Since the report is based on payee information, press the Payee button 
in the Subtotal by section. 

When you have finished setting up the Transaction Report, press the 
on-screen Start Report pushbutton. 

Create Transaction Report 
Report title (optional) : [lCCOUNTS RECEIUlBLE BY CUSTOMER I 
Restrict to transactions from: through: 

which are: Q Payments a Deposits Q Either 
and whose payee matches (optional): 
and whose memo matches (optional) : 
and whose cleared status is: Not c 1 eared 

Newly cleared (*I 
Subtotal by: Don't subtotal Half month Q Year 

8 Et!i:gory g Month 
Quarter 

g Week 
Two weeks 

... I..... ........... .,.,, 1.. .................... 0 Show totals only 

Figure 16-6. Create Transaction Report dialog box set up for a 
Receivables by Customer report. 
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The resulting report is shown in Figure 16-7. Quicken can produce a 
similar report showing only overdue accounts. To do this, set the date 
range to cover only dates from your oldest invoice up to today. 

ACtOUNlS  REtElVIBLE BY CUSTOlER 

11 1/89 Through 12/31/89 

10113 4302 
10116 43% 

10116 265 
1 1 I M  UM 

10113 by13 
10125 4376 
11110 4452 
11 I24 4497 

OVEWLL TOTAL 

5,458.85 
10,322.82 

15,761 .b7 

- 1 m . m  
1,075.W 

975.m 

__.__..-- -- 

n4.n 
1,989 04 

883.87 
1.430.37 

.___..__..- 
5.058.05 

21.774.n 

21,774.12 

_...__..--- 

iiiiiiiiii3 

Figure 16-7. Receivables by Customer report created from the dialog 
box in Figure 16-6. 

Customer Payment History 

Quicken can also keep a record of how promptly each customer has paid 
each invoice. This is called a Customer Payment History. 

If keeping track of this is important to you, you must do two things: 

First, be sure you type the invoice issuance date in the Memo field for the 
transaction. 
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Second, do not delete paid invoices, as described above. Instead, follow 
this procedure for each paid invoice: 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

At the Check Register, go to the invoice that has just been paid. 
Change the amount of the invoice in the Check Register to zero. 

From the Edit Menu, choose Split Transaction. Quicken displays the 
Split Transaction dialog box. 

Type in a descriptive name, such as Invoice, in the Memo field, and 
the amount of the invoice in the Amount field. Quicken will be in 
adding machine mode, so a negative amount, totaling the transaction 
to zero, will be entered automatically. Type in a descriptive name, 
such as Payment, in the Memo field of the second line. 

Press the on-screen OK pushbutton on the Split Transaction dialog 
box. Quicken returns you to the Check Register. 

Mark the Cleared (C) column for the invoice transaction to show the 
invoice as paid. 

Change the date of the transaction to the date that payment was 
received. 

Note: This is why you must type the invoice issuance date in the 
Memo field. You will need to compare it later with the date in the 
Date column. 

Press the on-screen Accept pushbutton to record the transaction. 

By following this procedure, you will have a record of each paid invoice. 
A report like the one above will now show each customer’s payment 
history. 

Quicken tip: Using this method makes overdue invoices harder to spot in 
the Check Register. If you want to see them more easily, you should create 
a Transaction Report restricted to transactions that are not cleared. To do 
this: 

1. Choose Transaction Report from the Activities Menu. Quicken 
displays its Create Transaction Report dialog box. 

Fill out the Create Transaction Report dialog box as you normally 
would, only this time press the on-screen Not cleared (blank) button. 

Press the on-screen Start Report pushbutton to start the report. 

2. 

3. 
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Forecasting cash flow and cash position 
If you enter both your expected payments and your expected deposits into 
the Check Register, Quicken forecasts your cash flow. Forecasting cash 
flow predicts cash surpluses, helping you to figure out whether you can 
handle new expenses or invest the surplus for highest return. Forecasting 
also predicts coming cash deficits so you can slow your payables, borrow, 
or take action to generate more cash. 

Forecasting works best if, as in many businesses, your deposits are fairly 
predictable. If your deposits are unpredictable, forecasting will not work 
as well. 

Overview of cash flow forecasting 
Here’s an overview of cash flow forecasting. First, enter your expected 
payments into your regular checking account. Then make a copy of your 
checking account. In that copy, enter your expected deposits. The result- 
ing Check Register shows your cash flow from today out to as far as you 
can estimate expected payments and deposits. Quicken can produce 
several reports summarizing your cash position and cash flow. 

Keep this in mind: Do not enter expected deposits into your regular 
checking account. Doing so could lead you to overstate your checking 
account balance and write checks that bounce. Instead, follow the instruc- 
tions below to make a copy of your regular checking account and enter 
expected deposits into that copy. 

1. In your regular checking account, enter expected payments. Follow 
the instructions in the sections of this chapter entitled ”Accounts 
payable” and “Forecasting cash requirements.” 

Make a copy of your regular checking account. To do this, choose 
Copy from the File Menu. Quicken displays the Copy Current 
Account dialog box. 

Set the date range for today through the period you want to forecast. 
Do not check the Also Copy Prior Uncleared Transactions checkbox. 

Give this new account a name you’ve not used before, for example, 
Cashflow. Press the on-screen OK pushbutton. 

When the copying is complete, open the new account. Do not use your 
regular checking account. 

In the new account, enter expected deposits. You can enter each 
invoice for which you expect payment. Or you may find it easier to 
enter the total deposits you expect to make each day or each week. 

2. 

3. 

4. 

5. 

6. 
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Cash flow reports 

After entering expected payments and deposits as described above, you 
can create reports that view your future cash flow in three different ways: 
cash position by day, cash flow by week, and sources and uses of cash. 

Note: Quicken can forecast your cash flow as far into the future as you can 
predict deposits and payments. 

As you use these reports, keep in mind that “float” can cover temporary 
cash deficits. Float is the time it takes for a check you mail to reach your 
bank and get charged to your account. This can take anywhere from one 
to 10 or more business days. Most businesses don’t want to take a risk on 
float, preferring to make certain that there is never a cash deficit in their 
cash forecast. Knowing their cash position by day helps them to do this. 

Cash position by day 

Cash position by day is shown in the Check Register. If the balance 
changes to a negative, you have a cash deficit that may need attention. 

To print the future portion of the Check Register: 

1. 

2. 

3. 

4. 

5. 

6. 

Display the Check Register. 

From the File Menu choose Print Register. Quicken displays its Print 
To dialog box. Select the Page Setup you wish to use and press the on- 
screen OK pushbutton. 

Set the date range to cover from tomorrow forward. 

Give the report a descriptive title such as Cash Position by Day. 

Check the appropriate checkboxes if you want the transactions printed 
one per line and if you want to print splits detail. 

Press the on-screen OK pushbutton. 

Cash flow by week 
Cash Flow by Week is a report used by many businesses. To create such a 
report: 

1. From the Activities Menu choose Transaction Report. (See Chapter 
11, Reports.) Quicken displays its Create Transaction Report dialog 
box, as in Figure 16-8. 
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Create Transaction Report I Report title (optional): [RCCOUNTS PRYRBLE BY WEEK 1 
Restrict to transactions from: 1-1 through:118/31/891 
which are: Payments Q Deposits Q Either 
and whose payee matches (optional): 
and whose memo matches (optional) : 
and whose cleared status is: Not cleared B!E!2g(x or a) 8 Newly cleared (*I 

Subtotal by: Q Don't subtotal 
@ Week w Two weeks 

...................... ............... ........ 1.1 I show totals only 

Figure 16-8. Create Transaction Report dialog box set up for a 
Cash Flow by Week report. 

Type a descriptive title, such as Cash Flow Forecast by Week. 

Select the Date fields and set the range to cover from tomorrow 
forward. 

Since the report is based on weekly information, press the Week 
button in the Subtotal by section. 

When you have finished setting up the Transaction Report, press the 
on-screen Start Report pushbutton. 

A typical report appears in Figure 16-9. The balance is your cumulative 
cash position through each week. The report factors in your bank account 
balance as of the beginning of the report. A negative balance means you 
are out of cash as of that date. 
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CASH F W  FWECAST BY YEfK 
101 9/89 mr-h 10/31/89 

CASIFLW 
11/24/89 

OVERALL TOTAL 101 9/89 - lOl31/89 

TOTAL INCUE 
TOTAL EXPENSES 

NET TOTAL 

_______.... 

45,mo.m 

29.756.87 
-14,amm 

-142.87 
-522.36 
-932.16 

13,270.W 

IB,P~.DI 

25,mo.m 
-10,su.m 
-12,mo.m 

ie,mo.m 

16,158.m 

74,RIL.W 

-rm.m 
- 7 , m . m  

4,Mo.m 

M.m.m 

-m.m 
-1,674.m 

-1,724.W 

64.m.o 

=iiii-.= 

19,m.W 

68.75b.87 
~ ~ r n 2 . 1 ~  

19.m4.W 

Figure 16-9. Typical Cash Flow by Week report. 

For a more concise report, check the Show totals only checkbox of the 
Create Transaction Report dialog box. 
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Sources and uses of cash 
Sources and Uses of Cash is another report that is useful for understanding 
your business's cash flow. It shows where your cash is coming from and 
where it is going. It shows which are your largest sources of cash and 
which are your largest uses. You may want to direct more management 
attention to these sources and uses. You can get a Sources and Uses report 
for your historic cash flow or for your forecasted future cash flow. 

The report you create depends on the report you want to see. If you want 
to see the sources and uses totaled by @Category, select an @Category 
Report (or a Transaction Report, subtotaled by @Category). If you want to 
see the sources and uses totaled by payee, select a Transaction Report; 
then subtotal it by payee. Set the date range to cover the past up to today, 
or the future from tomorrow on. 
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Chapter 17 

Bookkeeping, Petty Cash, and Payroll 
Business Uses: u 

~ ~ 

Cash bookkeeping/Chart of accounts 

Reporting by job, property, client, or project 

Departmental bookkeeping 

IRS Form 1099 

Petty cash 

Business budgeting 

Asset and liability accounting 

Payroll 

The preceding chapter gave examples of Quicken’s many business uses, 
concentrating on accounts payable, accounts receivable, and cash flow. 
This chapter tells you how you can use Quicken for other routine business 
bookkeeping tasks. 

Cash bookkeeping/Chart of accounts 
Quicken can do the routine bookkeeping work for many businesses. ,Using 
Quicken eliminates bookkeeping errors. It has enabled many businesses to 
do more complete and accurate bookkeeping in much less time than they 
previously spent-and it produces finished reports that allow the account- 
ant for the business to do his or her job much faster. 

Quicken does all this without requiring double-entry accounting. Double- 
entry accounting software, as those who have tried it know, can be difficult 
to set up and rigid, and it may require in-depth knowledge of debit and 
credit accounting rules. 
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The process of using Quicken for bookkeeping includes three steps: 

1. Establish a chart of accounts in the form of a set of @Categories. 

2. Assign an @Category to each transaction. 

3. Produce reports. 

Establishing a chart of accounts 

To use Quicken for business bookkeeping, first establish a set of income 
and expense categories. This is often called a ”chart of accounts.” 
Quicken’s @Category feature allows you to enter your chart of accounts all 
at once, or ”on the fly” as you type in transactions (see Chapter 8, @Cutego- 
vies). 

You need not establish a rigid chart of accounts before you can use the 
program. Unlike many accounting programs, Quicken is flexible. You can 
add to or modify your chart of accounts at any time. You can also recate- 
gorize past transactions; for example, you can split a single @Category into 
two new @Categories. 

Here is a typical chart of accounts for a sole proprietorship as it appears in 
Quicken’s @Category List. This list of items is from the IRS Schedule C, 
Profit (or Loss) From Business or Profession-Sole Proprietorship. For 
ease of use, the @Category names are abbreviations. You can use numbers 
if you prefer. Quicken alphabetizes the list by @Category name, not by 
Description. In the list below, Other Income and Other Expenses begin 
with an (-1 (underline) so they show up last in reports. Quicken alphabet- 
izes the (-) (underline) character after all letters. 
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Chart of accounts list of @Categories and descriptions. 

@Category Description 

Ad 
Bad-Debt 
Bank-C harges 
Car 
COG-Labor 
COG-Matls 
COG-Other 
Commissions 
Depletion 
Dues&Pubs 
Emp-Benes 
Freight 
G-Sales 
Insurance 
Int-Paid 
L&Clean 
L&P-Fees 
Office 
Pension 
Rent 
Repairs 
Returns 
Supplies 
Taxes 
T& E 
Utilities 
Wages 
- Other-E 
- Other-I 

Advertising 
Bad Debt 
Bank Service Charge 
Car & Truck 
Cost of Goods-Labor 
Cost of Goods-Matls 
Cost of Goods-Other 
Commissions 
Depletion 
Dues & Publications 
Employee Benefits 
Freight 
Gross Sales 
Insurance 
Interest Paid 
Laundry & Cleaning 
Legal & Prof. Fees 
Office Expenses 
Pension & P. Share 
Rent 
Repairs 
Returns & Allowances 
Supplies 
Taxes 
Travel & Entertain. 
Utilities & Phone 
Wages & Job Credits 
Other Expenses 
Other Income 

Assigning transactions to @Categories 

To keep accurate books, you should assign every transaction to an @Cate- 
gory except the Opening Balance in the Check Register. 

Assigning a transaction to an @Category is easy. You can pick from a list 
of existing @Categories, or create a new @Category as you need it. 

To pick an existing @Category: 

1. When it’s time to assign an @Category, choose Recall @Category from 
the Quick Entry Menu. You can also press m+a. Quicken 
displays your existing @Category List. 
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@Categories Required 
checkbox. 

2. Select the @Category you want by highlighting it and then pressing the 
on-screen OK pushbutton. If you have a mouse, double-click on the 
@Category. Quicken enters that @Category for you. 

For more details on assigning @Categories, see Chapter 8. 

If you split a transaction: 

If you split a transaction, you can assign a @Category either to the full 
transaction or to each item in the split. Generally, you would not assign 
@Categories to both the full transaction and the split items. 

To require an @Category for each transaction: 

To make it easier for you to remember to categorize transactions, Quicken 
has a feature you can set that requires that every transaction be assigned to 
an @Category. To require an Category for your transactions: 

1. From the File Menu, choose Other Settings. Quicken displays its 
Other Settings dialog box, as in Figure 17-1. 

Beep when recording and Memorizing 
H Request confirnation (for exanple 

when changing the Check Register) 

new transacrions 
Require @Categor .in memo of all 

0 Extra message line on check (printed 
on check but not recorded) 

Days in advance to remind of postdated 
checks and scheduled groups (8-38) 

m l m m n  

Figure 17-1. Other Settings dialog box. 

Check the Require @Categories checkbox. 

Press the on-screen OK pushbutton to accept the new settings. 

Quicken now warns you if you try to record a transaction without 
assigning it to an @Category, but still permits you to do it. 

2. 

3. 

Producing reports 

There are two reports that businesses generally produce with Quicken: 
Income and Expenses by Category, and Transactions by Income and 
Expense Category. 
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Income and Expenses by Category Report 

Income and Expenses by Category is the report most often used by busi- 
nesses. For cash-based businesses, it is their entire profit and loss state- 
ment. For other businesses, it is much of their profit and loss statement. 

To create an Income and Expenses by Category Report: 

1. 

2. 

3. 

4. 

5. 

Choose @Category Report from the Activities Menu. Quicken 
displays the Create @Category Report dialog box, as shown in Figure 

Set the Report title and other fields as shown in Figure 17-2. 

In the Restrict to transactions from and through fields, type in the 
starting and ending dates for the transactions you want Quicken to 
include in the report. 

In the Subtotal by section, press the Month button. 

Press the on-screen Start Report pushbutton. Quicken produces a 
report. 

17-2. 

Create @Category Report 
Report title (optional): lIONTHLY Pill  STIITEIENT, 3RD QTR, 
Restrict to transactions from: 

which are: Q Payments Q Deposits Either 
and whose payee Matches (optional): 
and whose neno Matches (optional) : 
and whose cleared status is: 

I 
through: -1 

Not cleared 
8%hl[t!g(y or *) 8 Newly cleared (*I 

Q Half Month Q Year 
8 k%er 

l,m==J I 0 Select @Categories to include 
Figure 17-2. Creating an Income and Expenses by Category 
report. 

The resulting profit and loss statement should appear similar to the 
example in Figure 17-3. This example is for a business that categorizes its 
expenses using only a few @Categories. 

If the report shows a transaction identified by the words "Not Categorized 
Expenses," Quicken found some transactions that were not assigned to any 
@Category. For a list of these transactions, create a Transaction Report that 
you restrict to transactions without an @ in the Memo field. Do this by 
typing -..@.. in the memo matches field of the Create Transaction Report 
dialog box. 
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1 ST-aur: 
101 6/8V 

7t  1/89- 

C a t w r y  Descrlpt7m 7/89 8/89 9i8V 9130189 
..................................................................... 

IwccuE 
G I D ~ ~  52,978.86 36,262.55 6 7 , W . U  117.14.81 
other lneolc 121.43 125.64 125.75 372.82 

............................................. 
TOTAL INCWE 53,1W.25 3,388.19 8,027.15 157,115.63 

M0.m 6oo.m 3,u'o.m 

1.7ao.m r , m . m  1,iso.m 
2,932.05 2,462.27 2,871.90 
5 . 3 2 u a  5 , 3 2 4 . ~  5 , 3 2 4 . ~  
1.563.75 672.04 85b.M 

i i n r n f  1,265.97 983.76 1,563.W 
qY.77 397.51 u1s 33 

15,832.89 15,346.52 18.511.69 
3 , m . W  3,174.76 5,619.92 

34.4m.79 34,635.05 U,S%.lb 

728.93 6n.41 828.66 

................................. 

4.6co.m 
2,231.m 
8.m.m 
8.26.22 

15.97z.m 
2.69.19 
3,812.71 
1.285.61 

49.691.10 
12,715.11 

109.934.98 

~ jjiii iiiiiijjii = iiiiiii-.ii 
OVERALL TOTAL 18,659.50 1,753.14 27,128.01 47,580.65 

Figure 17-3. Typical Income and Expenses by Category report. 

Transactions by Income and Expense Category 

The Transactions by Income and Expense Category Report shows the 
"breakdown" of each income and expense category. Unlike the report 
above, it is a detailed report showing each transaction in each @Category. 
It also permits you to double-check that transactions were correctly 
categorized. 

To create a report of transactions by income and expense category: 

1. From the Activities Menu, choose Transaction Report. Quicken 
displays its Create Transaction Report dialog box. 

Select the Report title field, and give the report a descriptive title, such 
as INCOME & EXPENSE BY CATEGORY DETAIL. 

Select the from date and through date fields, and set the date range 
you want for the report. 

2. 

3. 
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4. 

5. 

In the Subtotal by section, press the @Category button. 

Press the on-screen Start Report pushbutton to produce the report. 

The first part of such a detailed report appears in Figure 17-4. 

INCCUE 8 EXPENSE 81 CATEGORY DETAIL 
9/ 1/89 lhrDuph 9 M / 8 9  

CHECKINS 
101 6/8V 

91 1 Deposit 
9/11 Deposit 
9/18 Deposit 
9/25 wit 

9/21 D w i f  

m i u  mhel in- 
m i u  INCCUE 

EXPENSES 

Adveitisiw 

9 1  9 1 5 a  cmtr.1 -11 
9/ 9 150s R.P. M n . 1 1 ~  
9/15 1547 c i ty  x b a y  D i i t .  
9/23 1572 Y.*rem -11 

TOTAL Adveitisiw 

Car 8 Truck 

9/15 
9/23 
9/23 

1542 
1 581 
1585 

" i n s f a  L r s i q  
s O l y n  y.b 

mllusk 011 u). 

m i u  01 L T W C ~  

mru EXPENSES 

WEULL TOTAL 

x 7,ou.m 
x i 7 , u r . w  
X 22.175.39 
x 2 1 . z 6 . m  

67,901.41 

-3.44n.m 

Figure 17-4. A detailed Income and Expense by Category Report. 
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Reporting by job, property, client, or project 
Quicken‘s flexibility allows you to categorize transactions in more than one 
way. You can assign each transaction to a chart of account code number 
and to a job number, property, project, client, or department code. Then 
Quicken can produce reports for each job, property, client, or department. 

In this way, Quicken can help in billing expenses to particular clients, 
tracking actual costs vs. estimates, segregating income and expenses by 
rental property, and tracking expenses by project. 

This capability makes Quicken valuable in medical, legal, consulting, and 
other professional service firms, as well as property management, job-shop 
manufacturing, construction, and similar businesses. 

Setting up for flexible reporting 

The process of using Quicken to create more flexible reporting options 
consists of three steps: 

1. Establish a set of @Categories and @Category prefixes suitable to your 
clients, projects, or business. 

2. Assign at least one @Category to each transaction. 

3. Produce reports. 

You establish @Categories and assign transactions to them as described 
earlier in this chapter. The only difference is that you assign each transac- 
tion (or if you have split transactions, each item in the split) to a prefixed 
@Category with the prefix indicating the job, property, client, etc. 

Prefixed @Categories 

A prefixed @Category is simply a descriptive phrase placed before an 
@Category-for example, Job 104 @Supplies. Here, Job 104 is the prefix for 
the @Category called Supplies. Using prefixed @Categories like this allows 
you to create a report showing all your supplies expenditures for all jobs, 
or just those relating to Job 104. You create the report by restricting it to 
transactions that include “Job 104” in the Memo field. 
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~~ 

Quicken tip: Unlike @Categories, which Quicken maintains in its @Cate- 
gory List, there is no lisf.for @Category prefixes. If you use @Category 
prefixes, you must be careful always to spell them consistently. For 
example, if you sometimes use the prefix Job 104 (a space between "Job  
and " 1 0 4 )  and sometimes the prefix Job104 (no space), and then ask 
Quicken to produce a report restricted to "Jobl04," the report will not 
contain any transactions prefixed with "Job 104." 

For example: managing a property 

This example shows how an owner of three office buildings might set 
Quicken up. Below is a list of the @Categories for his chart of accounts. 
The prefixes of the three buildings are (First Ave.), (N. Park), and (Oak 
Circle). The parentheses are part of the prefix. 

Example @Categories for property management. 

@Category Description 

Ads Advertising 
Commission Commissions 
Insurance Insurance 
Int-Paid Interest Paid 
Janitor Janitorial 
L&P-Fees Legal & Prof. Fees 
Late-Fees Late Payment Fees 
Other-Exp Other Expenses 
Rent Rent Received 
Repairs Repairs 
Taxes Taxes 
Utilities Utilities 

To produce an @Category Report for a single property: 

1. From the Activities Menu, choose @Category Report. Quicken 
displays its Create @Category Report dialog box as in Figure 17-5. 

Select the title field and type a title similar to CASH ACCOUNTING, 
FIRST AVE. BUILDING. 

2. 
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3. Select the from and through fields and set the date range to cover the 
time period you want. 

Create @Category Report I Report title (optional): ICWH IICCOUNTINC, FIRST RUE, BUILDING 1 
I Restrict to transactions from: through: 112/31/891 

which are: Q Payments Q Deposits dW Either 

and whose memo matches (optional) : 
and whose payee matches (optional): 

and whose cleared status is: Not cleared B&;:kF'(, or *I 8 Newly cleared (*I 
~ 

Don't subtotal Half month Q Year 
Week Month I Two weeks Quarter I 0 Select @Categories to include 

Figure 17-5. Creating an @Category Report using prefixed 
@Categories. 

4. Select the memo matches field. Type the prefix for the property whose 
report you want to see, using this format: 

. . (First Ave. ) . . 
This tells Quicken to include only those transactions that have the 
(First Ave.) prefix anywhere in the Memo field. Quicken will search for 
a keyword match. You can find out more about it in Chapter 11, 
Reports. 

Press the on-screen Start Report pushbutton to produce the report. 

The dialog box in Figure 17-5 produces a report like that in Figure 

5. 

17-6. 
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CAW KCWNTIU., F I R S T  AYE. BUILDIN6 
1/  1/89 Thrash 12/31/89 

lST-B1W( 
101 6/89 

1 , b s . m  
296,856.m 

29.3.5m.m 

545.85 

3,292.10 
202.841.60 
10,8%.5.3 
b,9x.m 

14.923.61 
25,8sb.m 
6,944.72 
8.M5.50 

1 , w . m  

m , 2 L U . a  

i.i..iiiiill 
18,218.72 

P.9.1 

Figure 17-6. Report created with @Category prefixes. 

Quicken can also produce a detailed report that itemizes the transactions in 
each @Category. To create such a report, choose Transaction Report from 
the Activities Menu, limit it to the First Ave. building as shown above, and 
subtotal by @Category. 

Departmental bookkeeping 
The most flexible way to segregate expenses by department is to use two 
@Categories, one for the chart of accounts code and one for the depart- 
ment. For example, @Printing @Mktg could signify a printing expense in 
the Marketing department. In reports, Quicken subtotals the printing 
expenses by department. 
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Another way to track departmental expenses is through the use of “combi- 
nation chart of accounts codes.” These are chart of accounts codes, usually 
numbers, that combine the department and the type of expense. 

Typically, such @Categories consist of four digits: two digits indicating the 
department, and two digits indicating the type of expense. For Quicken, 
the type of expense number must come first. For example, @50.. could 
stand for the Marketing department and @..25 could stand for printing. An 
expense coded with @5025 would represent printing for the Marketing 
department. 

You can control what Quicken reports on by limiting the report. You limit 
the report in the dialog box that appears when you choose one of the three 
Create Report commands. Continuing with the example above, typing 
..@50??.. in the memo matches field of the Create Report dialog box 
produces a report for the Marketing department alone. Typing ..@??25.. in 
the memo matches field produces a report of printing expenses for all 
departments. 

Quicken tip: A disadvantage of the numerical approach is that any 
@Category or Budget Reports you produce will have many lines, since 
each 4-digit @Category appears on its own line. 

IRS Form 1099 

Quicken makes it easy to produce IRS Form 1099, Miscellaneous Income. 
For a list of how much you’ve paid each payee: 

1. Choose Transaction Report from the Activities Menu. Quicken 
displays its Transaction Report dialog box. 

Select the from and through fields. Set the date range to cover the year 
for which you must produce the 1099. 

Check the Show totals only checkbox. 

Press the on-screen Start Report pushbutton to produce a report 
showing the appropriate 1099 totals. 

2. 

3. 

4. 

Remember that Quicken produces a report showing 1099 totals; it does not 
print 1099 forms. 
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Petty cash 
Many of America‘s largest corporations use Quicken to manage their petty 
cash accounts. At branch offices and at headquarters, Quicken keeps petty 
cash balanced and on track-and produces the reports that finance depart- 
ments require. Quicken’s Reconciliation Report is particularly useful for 
petty cash. 

Business budgeting 
Quicken can compare your actual business income and expenses with a 
budget you set up, by week, by month, by quarter, or by year. The method 
for doing this is explained in the “Budget Reports” section of Chapter 11. 

Asset and liability accounting 
You can also use Quicken to account for assets and liabilities, such as 
capital equipment and loan principal. Keep in mind that Quicken is not 
double-entry accounting software. You will still want your accountant to 
produce the asset and liability portions of your financial statements. But 
Quicken can help handle routine record keeping, especially for long-term 
assets and liabilities. 

The process of using Quicken to do this consists of three steps: 

1. Set up the asset or liability. 

2. Increase or decrease it over time. 

3. Produce reports. 

If you plan to do asset and liability accounting, you should not set Re- 
quired @Categories. If you have already set up Quicken to require @Cate- 
gories, you will need to change the setting: 

1. Choose Other Settings from the File Menu. 

2. Do not check the Require @Categories checkbox. 

3. Press the on-screen OK pushbutton to accept the new settings. 

Setting up an asset or liability 
Use a zero-amount transaction to enter the value of the asset or liability 
into Quicken without affecting your checking account balance (see Chapter 
9). 
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Set up special @Categories for each category of asset or liability. For 
example, begin each @Category with @AL: , such as @AL:Capital or 
@AL:Prin. "AL" is short for Asset/Liability. Setting up your @Categories 
this way enables you to restrict reports to include only assets and liabili- 
ties, or to exclude them. This keeps reports dealing with assets and 
liabilities separate from reports dealing with income and expenses. 

Two rules to remember: 

Assets (what you own) should have Payment balances. This means 
that you should type a zero in the Payment column before choosing 
Split Transaction from the Edit Menu to enter asset amounts in the 
Split Transaction dialog box. 

Liabilities (what you owe) should have Deposit balances. This means 
that you should type a zero in the Deposit column before choosing 
Split Transaction from the Edit Menu to enter liability amounts in the 
Split Transaction dialog box. 

Increasing or decreasing assets or liabilities 

Use @Categories as usual to add to or subtract from assets or liabilities. 
For example, Figure 17-7 shows a mortgage payment that decreases the 
loan principal due. 

I IA MTE 18/26/89 

One Thousand Eight Hundred Eight and BWl- WlLLlRS 
#doo!HE Downtown Mortgage Co, 

Figure 17-7. Split transaction decreasing the loan principal due. 
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Use a zero-amount transaction if you must increase or decrease an asset or 
liability and no cash is involved. For example, use zero-amount transac- 
tions when you depreciate assets, write off bad debts you were owed, etc. 

Reporting assets and liabilities 

Useful reports for reporting on assets and liabilities are the @Category 
Report and the Transaction Report, subtotaled by @Category. 

Three rules to remember when reporting assets and liabilities are: 

1. To report assets and liabilities, restrict the report by typing ..@ALL. in 
the memo matches field of the Create Report dialog box. On all other 
reports, exclude assets and liabilities by typing -..@AL.. in the memo 
matches field of the Create Report dialog box. 

To report the value of assets and liabilities, the date range must include 
the date of the transaction in which that asset or liability was first set 
up in Quicken. If the date range excludes this ”set up date,” your 
report reflects only changes to the account during the period covered 
by the date range, and Hot its value at the end of the period. 

On reports organized by @Categories, liabilities appear first in the 
group that ends with TOTAL INCOME. Assets appear last in the 
group that ends with TOTAL EXPENSES. That is because assets have 
Payment balances and liabilities have Deposit balances. 

2. 

3. 

Payroll 
While Quicken is not a complete payroll system, it can automate some of 
the most onerous payroll chores. Doing a payroll involves making calcula- 
tions, printing checks, tracking data for payroll taxes, and filling out 
payroll tax forms. Quicken prints checks and tracks all the deductions 
needed for payroll taxes, leaving you to do calculations and fill out payroll 
tax forms by hand. 

Quicken tip: Start all payroll @Categories with @P_. Then, when you set 
the criteria in the Create @Category Report dialog box, restrict the report 
to transactions whose memo matches ..@P-.. . This way your payroll 
reports contain only payroll-related @Categories. 
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Typical @Categories 
Here is a typical set of payroll @Categories. The first group consists of 
payroll categories that all businesses use. The second group consists of 
payroll categories that may or may not be required, depending on the laws 
of your state or locality. 

Payroll @Categories 

Group 1 

@ P-FICA FICA withholding 
@P-FedWH Fed. income tax withheld 
@P-Gross Gross compensation 
@P-FedWHDep Deposits of Fed. withheld 
@P-FUTADep Deposits of FUTA 

Group 2 

@ P-St W H 
@P-LoWH 
@P-SDI 
@P-SDIDep 
@P-STWHDep 
@P-Tips 
@P-Sep/lRA 
@P-Pension 
@P-Fringe 

State income tax withheld 
Local income tax withheld 
State disability tax WH 
Deposits of state disability 
Deposits of state WH 
Tip compensation 
SEP or IRA compensation 
Pension compensation 
Fringes treated as comp. 

To print payroll checks: 

1. Use a split transaction to list the deductions needed for each payroll 
check. 

2. Memorize the transaction without dollar amounts. Then recall the 
transaction and fill in the hours worked and dollar amounts for each 
employee. Make sure the split is in adding machine mode (see page 9- 
3 for details). 
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4 
D l T E  18/26/89 

- 
$ 911.32 PAY TO THE 

ORDER OF Joe RploYee 
Nine Hundred Eleven and 32/18- DOLLlRS 

3. Press the on-screen Accept pushbutton to record each transaction. As 
you do so, Quicken keeps track of all deductions for your payroll tax 
reporting. 

Now you can print the checks. If you print on voucher checks, the 
voucher shows all wage and deduction information that appears in the 
split. 

4. 

Figure 17-8 shows an example of a split transaction for a typical payroll 
check with the numbers filled in. 

l D D l  

Ending Balance: $18.385,48 

Figure 17-8. Split transaction for a typical payroll check. 

Once you have printed your payroll checks, you can use Quicken's Re- 
ports feature to get the numbers you need to fill in your payroll tax forms. 

Here are the Federal payroll tax forms showing which Quicken reports to 
run to get the information for each form. As you can see, Quicken gives 
you the difficult to calculate numbers. Note which reports you'll create to 
get information for each number. The forms are filled in for a typical 
business. If your business requires you to fill out more of the blanks, 
design your Quicken reports accordingly. Use the same procedure for 
your state and local tax forms. 
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3 Employer's tbntilulm numbn 
77-0034682 

4 Em&n s data I D n u m b  
31 1-3273-5 

I I 
2 Employer's name. address, and ZIPcode 

ACME CORPORATION 
721 MAIN STREET 
PECBIA, IL 60612 

ALICE RICHARDSON 
1223 FIRST AVENUE 
PEORIA, I L  60621 

\ 
@Category Report. Restrict to payee 
matches: name of employee. 

@Category Report. Restrict to payee matches: 
name of employee. Then manually check employee's 
gross compensation against the Social Security cap. 

Figure 17-9. W-2 Wage and Tax statement. 
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Transaction 
Report. Restrict to 
memo matches: 
..@P-Gross.. 
Subtotal by Payee. 
Then manually 
check each 
employee's gross 
compensation 
against the Social 
Security cap. 

\ 

/ 

@Category Report. 
Restrict to memo 
matches: ..@P-.. 

NOT STAPLE 
L td""rnrn I 

I 

Please return this entlre page with the accompanying Forms W-2 or W-2P to the Social 
Security Administration address for your state as listed below. 

Figure 17-10. W-3 Transmittal of Income and Tax Statements form. 
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Employer's Annual Federal 
Unemployment (FUTA) l a x  Return 940 

b For hp'"Wt R d h t l a  M Not*.. u 1. 
DLpl"rnL"t d,"*T.e.,"nl 
mt-l rl.rrnue*rnce 

/ 
. .  - , 

Transaction Report. 
Restrict to memo / matches: ..@P-Gross.. 
Subtotal by Payee. Then 
manually check each 
employee's gross com- 
pensation against the 
$7,000 cap. 

\ 
@Category Report. 
Restrict to memo 
matches: ..@P-.. 

/ 

Figure 17-1 1. Form 940, FUTA Tax Return. 
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/ 

Transaction Report. 
Restrict to memo 
matches: 
. .@P-G Toss.. 
Subtotal by Payee. 
Then manually check 
each employee's 
gross compensation 
against the Social 
Security cap. 

$ @Category Report. 
\ Restrict to memo 

matches ..@P-.. / 

@Category Report. 
Restrict to memo 

Subtotal by the frequency 
of your payrolls. Then 
manually add the FICA 
and FedWH @Categories 
for each period. 

/ matches: ..@P-F.. 

Figure 17-12. Form 941, Employer's Quarterly Federal Tax Return. 
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Appendix A: 

-- Questions and Answers uu 
I have a hard disk. How do I get the Billminder to show up when I 
boot? 

To activate the Billminder, reinstall Quicken as in Chapter 1. 

How do I turn the Billminder off? 

The AUTOEXEC.BAT file in the root directory of your hard disk controls 
and activates the Billminder. To remove the Billminder, type the following 
at a DOS prompt: 

COPY C:\AUTOEXEC.BAK C:\AUTOEXEC.BAT 

This restores your original AUTOEXEC.BAT file. If this does not work, use 
your word processing program to retrieve your AUTOEXEC.BAT file (it’s 
an ASCII file), and delete the BILLMIND line from it. 

How do I enter a negative opening balance? 

When you enter your starting balance, type a minus sign in front of the 
dollar amount you enter. 

How can I use Quicken on my hard disk and keep the data files on my 
floppy? 

Set up your bank account on a floppy disk by choosing New from the File 
Menu, and selecting the [A:] or [B:] floppy drive from the list. If you 
already have bank account transaction files on your hard disk (and they’re 
not too large to fit on a floppy!), choose Copy from the File Menu to copy 
your transactions to the floppy. Then choose Open from the File Menu to 
select the floppy disk drive and account. Later you can delete the transac- 
tion file left on your hard disk. 
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How do I move Quicken data that is on a floppy disk onto my hard 
disk? 

Choose Copy from the File Menu and copy the transaction data from the 
floppy to a file on your hard disk. 

Can I reprint a check after I have already printed it? 

Yes. Display the Check Register and type an asterisk (*) in the Check 
Number (NUM) column and record it. If the check has an address, display 
the check on the Write Checks screen, and type the address on the check, 
and then record it. 

Why didn’t the address print on the check that I just reprinted? 

Once you have told Quicken that all checks have printed correctly, 
Quicken deletes the address information. Follow the instructions in the 
immediately preceding question to reprint the check with its address. 

Why won’t Quicken copy the payee name into the address? 

Be sure the cursor is in the top line of the address field. Also be sure that 
the line is empty before typing ditto (”). 

I was printing and pressed the space bar to tell Quicken to pause. 
Why did my printer keep on printing? 

Your printer has a built-in “buffer” that stores up characters sent to it by 
the computer and allows it to keep on printing even though Quicken has 
told it to halt. If you want to stop printing immediately, turn your 
printer’s power switch to off. 

Why isn’t Quicken printing correctly on my printer? 

If you are having problems aligning your checks, see pages 4-10, ”Correct- 
ing printing problems,” to match the problem with the correct solution. 
For information about setting up your printer to print with Quicken, see 
page 4-6. 
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How can I print reports on a laser printer? 

Quicken can store six different page setups, so you can have one for 
checks, one for reports, one for compressed reports, etc. 

Important: when you type the following printer setups, remember that 
0 = zero, 0 = uppercase 0, 1 = the number one, and 1 = lowercase L. 

For printing reports: Set up Printer 1: 

Name it ”Reports” 
Lines = 6 6 
Columns = 8 0 
Before: \27E\27&10e66f 6D 
After: \27E 

Or, for compressed printing 
Lines = 66 
Columns = 1 3 2  
Before: \27E\27&10e66f6D\27 (s16.66H 
After: \27E 

Or, for landscape printing (sideways on page) 
Lines = 4 5 
Columns = 17 6 
Before: \27E\27&1loOe45f6D\279~16.66H 
After: \27E 

When printing my reports, the printing is too far to the left. 

Choose Page Setup from the File Menu and change the left margin value. 

Can I print checks with my laser printer? 

Intuit supplies checks specifically for laser printers (or you can tear the 
perforated strips from the sides of the checks and burst them into 3’s). 

Note: Do not print a sample check to help align the checks. In a laser 
printer, the checks will be aligned perfectly. 

If your laser printer is not compatible with the HP, check your printer 
manual for the correct control codes to achieve the settings above. 

In the Printer Setup dialog box, press the on-screen Yes pushbutton at 
Control Codes and type in the control codes. 
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If you have the HP LaserJetILaserJet PluslLaserJet Series 2: 

Important: when you type the following printer setups, remember 
that 
lowercase L. 

0 = zero, 0 = uppercase 0, 1 = the number one, and 1 = 

For printing checks: Set up Printer 2: 

Name it "Checks" 
Lines = 6 6 
Before: \ 2 7 E  \ 2 7 & 10 e 6 3 f 6D \ 2 7 &a 11 7 0 OV 
(for voucher checks replace center 6 3 with 4 2) 

After printing on all HI' printers: 
\27E 

When I do a report on @Categories, why do some transactions show 
up while others don't? 

You probably were not consistent when you assigned transactions to 
@Categories. Be sure each transaction has an @Category, and be sure you 
type in the @ sign immediately before the word you want to use as an 
@Category-for example, @Utilities. 

How do I change a memorized item? 

Choose Recall Transaction from the Quick Entry Menu, make the 
changes, then rememorize it by choosing Memorize Transaction from the 
Quick Entry Menu. 

If I set up a Transaction Group, must I always pay every one of those 
bills? 

No. Quicken gives you complete control. After you execute the group, 
you can delete or change any transaction. 

When I am reconciling my bank statement, how do I enter new trans- 
actions, and how do I tell Quicken that I have finished reconciling? 

To add transactions, press [Ctrl] + [Endl to go to the end of the Check 
Register; then type and record the transactions. Be sure to type an asterisk 
(*) in the Cleared (C) column. To finish reconciling, press the on-screen 
End Recon pushbutton. Quicken tells you if your account balances or not. 
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Why am I unable to run other programs by choosing Run from the 
File Menu? I get a message saying there is not enough memory. 

When you choose Run from the File Menu, you do not actually exit 
Quicken; Quicken remains in the computer’s memory-and other large 
programs don’t fit. Instead of choosing Run, exit Quicken and start the 
other program. 

What is a speedup file, and why does Quicken say that it is “recon- 
structing speedup file” when I go into my account? 

Quicken makes a special file that speeds access to different areas of your 
account. You need to exit Quicken by choosing Exit from the File Menu. 
If not, the speedup files are not saved and must be reconstructed each time. 
To save your speedup files, always exit Quicken by choosing Exit from the 
File Menu. 
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Quicken begins warning you when you are within approximately 50 
transactions of filling up your data disk. 

If you keep your data on a hard disk, this probably means that you will 
have to delete some unneeded files from the disk. 

Otherwise, or if you are keeping your data on a floppy disk, find a conven- 
ient stopping point in your work and follow the steps below to create a 
new copy of your account on a different disk, with the older transactions 
condensed into a single “Balance Forward” entry. 

1. 

2. 

3. 

4. 

5. 

Open the account you want to copy by selecting Open from the File 
Menu. 

Choose Copy from the File Menu. Quicken displays the Copy Cur- 
rent Account dialog box (Figure 13-4). The cursor is in the Copy 
transactions from field. 

Quicken defaults to the earliest date in the Check Register. However, 
you may not always want to copy all the data from your account. For 
example, you may not want to copy transactions from previous years. 
If you want to change the date, type in the earliest date from which 
you want Quicken to copy transactions. 

Move the cursor to the to date field. You can move the cursor to a new 
field by using JTabl or by clicking the field with the mouse. Type in 
the latest date through which you want Quicken to copy transactions. 
Quicken defaults to the last date there was a recorded transaction. 

Check the Also copy prior uncleared transactions checkbox to tell 
Quicken you want to copy uncleared transactions dated before the 
from date. This is useful for easily reconciling the new account. In 
general, you should leave this box checked. If you don’t want those 
transactions copied, click or press the space bar on the checkbox to 
uncheck it. 
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6. Move the cursor to the Copy to field and type in a name for the copied 
account. You must type in a different name for the copied account 
name if the two accounts are in the same directory. 

If you want Quicken to copy transactions to a different drive or 
directory, type the drive letter, along with the new name. For example, 
if you are copying CHECKING from drive [A:] to drive [B:], type in 
B:CHECKING in the Copy to field. Quicken will copy the account to 
the floppy in your [B:] drive. 

When you are satisfied with your settings, press the on-screen OK 
pushbutton. Quicken will copy the transactions selected. 

7. 

8. 

See Appendix C for information on the number of transactions that fit on 
different kinds of disks. 
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Technical Information 

Hard Disk Information 

Quicken is not copy protected, and has no special requirements for the 
location of its program and data files, so you may install it on your hard 
disk by simply copying all the files from the program disk into a directory 
on your hard disk. 

However, we recommend that you use the automatic hard disk install 
procedure provided. Please see the instructions in Chapter 1 for Install 
procedures. 

The INSTALL program does four things for hard disk users: 

1. It creates a subdirectory on your hard disk with the name that you 
provide. 

It copies the files from the Quicken disk(s) to the hard disk directory. 

It adds a new line to the end of your AUTOEXEC.BAT file containing 
the command to run the BILLMIND program, which checks whether 
you have any checks to print or Transaction Groups due. 

It modifies or creates a file called CONFIG.SYS to set BUFFERS=10 and 
FILES=10, if these parameters haven’t already been set. 

2. 

3. 

4. 

The changes to CONFIG.SYS should improve the performance of your 
system. The changes to your AUTOEXEC.BAT file allow Quicken t o  
remind you of bills that are due whenever you start up your computer. As 
a precaution, the HARDDISK procedure does not destroy your original 
AUTOEXEC.BAT. It renames it ”AUTOEXEC.BAK.” To remove Billmin- 
der, copy AUTOEXEC.BAK to AUTOEXECBAT. Or use your word 
processor to remove the ”Billmind” line from your AUTOEXEC.BAT file. 

For a list of Billminder options, type BILLMIND at the DOS prompt. 
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Capacity and memory usage 
Quicken's file structure permits a theoretical upper limit of 65,535 transac- 
tions. In practice, however, memory restrictions limit the number of 
transactions to a maximum of 40,000 to 50,000. A typical home user will 
generate from 200 to 1000 transactions per year. Small business users will 
typically have 300 to 3000 transactions per year. 

A regular 5-1/4 inch floppy disk has room for about 3000 transactions. A 
720K 3-1 /2 inch disk will hold about 6000. 

On a hard disk computer, the number of items you can work with depends 
mainly on the amount of memory you have. Your memory must be shared 
between DOS, Deskmate, and Quicken. The amount of memory required 
by DOS, Deskmate, and a printer driver depends on the kind of machine 
you have, as shown below: 

Memory Deskmate Deskmate 
Size in ROM not in ROM 
384K 191K 280K 
640K 199K 288K 

Note: These amounts may vary slightly depending on the versionof DOS 
and what kinds of system files you may be using. 

Quicken requires a minimum of about 180K, plus 9K per transaction. 
Thus, if you have a 640K machine without Deskmate in ROM, you will 
have room for (640K-288K-l80K)/9 or about 20,000 transactions. On a 
348K machine with Deskmate in ROM, you will have room for (384K- 
191K-l80K)/9 or 1,500 transactions. Quicken will not run on a 384K ma- 
chine without ROM. 

The maximum number of memorized transactions and @Categories 
depends on the memory you have. They share the same space, so the 
fewer of one you have, the more of the other will fit. 

Typical Maximum Numbers 

Pc's RAM Memory Memorized Trans. @Categories 

640K, DM in ROM 350 
640K, DM not in ROM 225 
384K, DM in ROM 90 

1200 
800 
300 

The amount of RAM installed in your PC can also affect the length and 
complexity of reports you are able to generate. If you request a long and 
complex report, you may see a message indicating that you do not have 
enough memory to generate the report. If so, try again with a narrower 
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date range, or restrict the report to fewer transactions. Or subtotal so there 
are fewer subtotals. If possible, unload any memory-resident programs 
that may be occupying RAM. Alternatively, you may wish to add addi- 
tional RAM to your PC. 

Files 
When you use Quicken, it creates the following files: 

In the directory where you keep Q.PDM: 

Q . CNF Configuration/setup information. 

In the work directory or directories where you keep your data: 

Q . D IR 
<acct name>. QCH 
<acctname> . QIX 
<acctname> . QML 

List of account descriptions/check due dates. 
Data file (1 for each account). 
Index to data file (1 for each account). 
Memorized List file (1 for each account). 

Note: The index file ("speedup file") is dispensable: if it is erased or 
becomes unsynchronized with the data file (for example, if you turn off the 
computer before leaving Quicken), Quicken automatically regenerates it 
when it is needed. 

Memorized list files are self-contained, so you can use the .QML file for 
one account with a different account simply by copying the file. 

Using Quicken on a Floppy System 

If you want to reduce disk swapping, you can do so at the cost of limiting 
the amount of space available for accounts. 

Start by following the instructions in Chapter 1 to make a copy of your 
Quicken program using the INSTALL procedure. Next, remove the 
following files from the disk(s) created by the INSTALL procedure: 

Q .  HLP 
unused printer drivers 

The printer drivers are the files that begin with the prefix "DMPD." 

The extra disk space can now be used for your accounts. 
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@Category A specific way of classifying your transactions so that Quicken 
can produce reports on various aspects of your finances. 

Account In Quicken, the term "account" refers to a bank account- 
checking, money market, or savings. 

Accounts payable Outstanding bills that are to be paid in the future. 

Accounts receivable Outstanding invoices for which payment has not 
been received. 

ASCII American Standard Code for Information Interchange. Set of 
standard character codes used by many computers. When you "print to 
disk," Quicken puts the data onto the disk in ASCII format so it can be 
read by other programs. 

Assets Things you own, such as cash, stocks, real estate, and furniture. 

Backup A spare copy of a disk to be used in case of the accidental loss or 
destruction of the original disk. Quicken will help you make a backup copy 
of your data disk. 

Balance The difference between payments and deposits in an account (or 
the amount of money in your account). Quicken calculates your balance 
each time you record a transaction and displays your balance on the Write 
Checks and Check Register screens. 

Bank account See Account. 

Budget A report comparing planned income and expense with actual 
income and expense. 

Character Any letter, numeral, punctuation mark, or other symbol (such 
as a dollar sign or asterisk) that a computer can read, write, and record. 
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Characters per inch Also called "pitch." The number of characters in an 
inch. Most printers print at either 10 or 12 characters per inch. 

Checkbox A box that indicates if a setting is active. An X in the box turns 
the setting on, removing the X turns it off. 

Cleared item Any transaction (payment or deposit) that has been proc- 
essed by the bank. Cleared items appear on your monthly bank statement. 
When you balance your account, you mark cleared items in the Cleared (C) 
column of the Check Register. 

Click Briefly depressing the left-hand button of the mouse once. Clicking 
selects an object on screen or "presses" an on-screen graphic button. See 
also Mouse. 

Confirmations The messages that Quicken presents to be sure it knows 
what you want, such as when you change an existing transaction. 

Control codes Codes that can be sent to the printer to control various 
aspects of printing, such as letter quality, draft, or pitch. Consult the 
printer's manual for its list of control codes. 

Credit See Deposit. 

Current balance The amount of money that is in a Quicken account as of 
today. This balance does not reflect postdated items. 

Cursor A small, blinking underline on the video monitor. The characters 
you type appear just above the cursor. 

Data disk A floppy disk that contains data. The data disk you use with 
Quicken contains all the transactions you record in the Check Register and 
in the Memorized Transactions List. 

Debit See Payment. 

Deposit Any transaction that is added to your account. Deposits include 
interest earned and checks. Deposits are also called "credits." 

Dialog box A pop-up screen that requests informationfrom the user in 
order to proceed. The box can contain simple Yes/No questions or re- 
sponse fields that need to be filled in. 

Directory A file created to organize the stored files on a disk. 

Disk A flat, flexible platter coated with magnetic material, enclosed in a 
protective envelope. A disk stores software programs and data. A disk is 
also called a diskette or floppy disk. 
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Disk drive A device that reads and records data on a disk. Typically 
named by a letter such as drive A or C. 

DOS Disk Operating System. A software program provided by your 
computer manufacturer. It contains data that operates the computer 
system and controls all access to data. 

DOS filename The name given to a file of data that is stored on a disk. 
The name can be up to eight characters long and can include letters, 
numbers, and some special characters such as a hyphen. 

DOS prompt A symbol on the screen that indicates the computer is ready 
to receive instructions. Typically A> or C>. 

Drag Depressing the left-hand mouse button and keeping it depressed 
while you move the mouse. 

Drive The mechanism that reads and writes data to and from the disk. 

EGA Enhanced graphics adapter. A special kind of color monitor. 

Ending balance 1) The amount of money in a Quicken account shown at 
the end of the Check Register. The ending balance does include postdated 
items. 2) The amount of money the bank had in your account on the last 
day of the period covered by the statement. 

Error message A note that appears on the screen to indicate a data-entry 
or software problem and the solution. 

Exact match Searching for transactions that exactly match a specific word 
or phrase, no more, no less. 

Floppy disk See Disk. 

Format To prepare a disk to accept data. 

Function keys The keys labeled F1 through F10 above or on the left of the 
keyboard. 

Group A set that contains one or more transactions. See also Transaction 
Group. 

Hard disk Special kind of disk drive that is faster and has much larger 
storage capacity than a floppy disk. 

Keyword match Searching for transactions that contain a particular word 
or phrase. 
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Liabilities Debts you owe, such as the amount you owe on credit cards 
and loans on your house or automobile. 

Memorized Transaction A transaction that Quicken has saved in a 
special list called the Memorized Transaction List. Transactions on this list 
can be revised. This is useful for transactions you enter on a recurring 
basis, such as rent and utilities bills. 

Memory The temporary storage area in the computer where programs 
and data reside while the program is running. 

Menu A list of available activities and corresponding numbers. To 
perform an activity, type the number that corresponds to the activity. 

Menu bar The section under the title bar which contains menu titles and 
their corresponding function keys. Pressing these function key pushbut- 
tons displays their corresponding menu options. 

Message line An optional line that is printed on the check, but is not 
recorded in the Check Register. For example, the message line is a conven- 
ient way to get a credit card account number printed on the check. 

Monitor A display screen that resembles a television. A monitor is also 
called a video monitor, screen, cathode ray tube (CRT), or display. 

Mouse Hand-operated pointing device that you move around the desk- 
top. A graphic pointer on the computer screen follows the motion of the 
mouse. 

Net worth The amount remaining after liabilities are subtracted from 
assets. 

Overall total The amount remaining after payments are subtracted from 
deposits. Quicken calculates and displays the overall or net total in many 
reports. 

Pathname A drive designator such as A: or C: or a drive and directory 
specification such as C:\DESK or C:\PERSONAL\MYDATA. 

Payment Transactions that are subtracted from your account. Payments 
include service charges and automatic teller machine withdrawals. Pay- 
ments are also called "debits." 

Petty cash A cash fund for small miscellaneous expenses. 

Port The connector on the computer used to attach the cable from an 
external device, such as a printer. Each port has a name. Quicken comes 
adjusted to print to a parallel printer connected to lptl. 
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Postdate To date a transaction with a date in the future. Postdating is 
used to write a check that you intend to print and pay at a future date. 

Print to disk Creates an ASCII file that you can read into your word 
processing or other program. 

Printer control codes See Control codes. 

Prompt See DOS prompt. 

Push button A screen element that, when pressed, causes some immediate 
action or continues an action. 

Reconcile See Balance. 

Reconciliation Register A shortened version of the Quicken Check 
Register, along with the Reconciliation Summary used while reconciling. 

Record To save the check or transaction in the Check Register to become a 
permanent part of your records. 

Scroll bar Graphic object on screen that controls the portion of the 
Check Register or the check that Quicken displays. By clicking the scroll 
bar, you can move forward or backward through the Check Register or 
unprinted checks. 

Split To allocate a payment or deposit to more than one category or 
payee. For example, to split a mortgage payment into interest, principal, 
insurance, and taxes. 

System A collection of interconnected hardware and software that 
operates as a unit. 

Title bar The top section of the screen that displays the date and time, the 
DeskMate program you’re using, and the file you’re using with that 
program. 

Transaction Group A group of recurring transactions that the user pays 
or adds to an account at the same time. An example could be the phone, 
electric, and mortgage bills that all are paid at the beginning of each 
month. 

Uncleared item A transaction that has not been processed or cleared by 
the bank. 

Voucher checks A business check that has an attached voucher page that 
allows room for more descriptive memos or itemized breakdown of the 
payment. 
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Write-protect tab A gummed label used to cover the notch in the side of a 
disk envelope to prevent the computer from accidentally writing to and 
erasing data from a disk. 

Zero-amount transaction A split transaction with a zero dollar amount. 
This is useful to assign amounts to @Categories without affecting the 
balance in the checking account. 
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~ 

_ _ ~  
Quicken Transfer UtilityTM 

Quicken checks-convenient and competitively priced 
____- 

Window Envelopes and Forms SaversrM 
~- 

The next few pages describe other Intuit products. 

These products work integrally with Quicken. They complete your 
Quicken system by providing extra convenience, flexibility, and power. 

Look for more information enclosed in the Quicken package. Or choose 
Order Supplies from the Activities Menu . 

Quicken Transfer UtilityTM 

Quicken transfer Utility provides custom Quicken reports and more. 

Have a paper financial report you’d like Quicken to update for you every 
month? Ever want a report that Quicken can’t give you? Want to combine 
data from several Quicken bank accounts? Want to analyze your finances 
using Lotus? 

Now you can do all of these with the Quicken Transfer Utility. This 
program transfers data from Quicken’s Check Register to spreadsheets in 
Lotus 1-2-3, Symphony, or campatible programs. It consolidates Quicken 
account data from several accounts into a Lotus spreadsheet as well. 
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Custom reports 

The Quicken Transfer Utility makes producing reports that meet your 
exact needs fast and easy. 

You set up any report format you want in a Lotus or compatible spread- 
sheet. The Quicken Transfer Utility then reads your spreadsheet to learn 
which cells you want filled in and with what data. It then retrieves the 
needed data from Quicken. It fills in the right cells in your spreadsheet 
and recalculates your spreadsheet, all in 5 to 10 seconds, without data 
entry. 

You have total control over the report. You select which @Categories, 
which payees, which memos, and which dates are displayed. You select 
exactly where each is displayed. Use logical OR to combine different kinds 
of transactions (“display here any utilities, phone, or repair expenses”). 
Use logical AND to show intersections (”display here only expenses that 
are for subcontractors, for client 232, and for March). 

. 

You can even spread individual transactions while retaining transaction 
detail. For example, if you set up @Categories for your chart of accounts, 
the Quicken Transfer Utility can spread each transaction to an account in a 
format similar to that used in One-Write accounting systems. 

Ideal for custom profit and loss statements, job and client costing, custom 
budgets with subcategories, and much more. 

Export to Lotus 

The Quicken Transfer Utility also exports Quicken Check Register data 
directly into 1-2-3 and Symphony spreadsheets. Transactions appear one 
per line in standard Lotus data base format. 

In just 5 to 10 seconds your financial records are ready for Lotus’s power- 
ful sorting, reporting, and analysis. 

Consolidating accounts 

The Quicken Transfer Utility will also combine data from any number of 
Quicken bank accounts into one spreadsheet. It’s great for consolidating 
your finances into one report. 
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Memo ry-residen t option 

The Quicken Transfer Utility can be ”memory resident,” like Sidekick@, if 
you want. 

In memory-resident mode, the Quicken Transfer Utility waits in the 
background out of the way. Then when you need it, just push one ”hot 
key” and zap, it’s ready to use. So you can transfer without leaving or 
reloading Lotus and without waiting. 

Compatibility 

Requires Lotus 1-2-3 release 1A or higher, Symphony release 1.0 or higher, 
or compatible spreadsheet program such as SuperCalc40 or VP Planner@. 
Runs on any computer that runs these spreadsheets. 

Try it FREE for 30 days 

If you’re not completely satisfied, return the Quicken Transfer Utility for a 
full, no-questions-asked refund. Call today. Call 800-624-8742 (in Califor- 
nia call 800-468-8481). Or use the order form enclosed in the Quicken 
package. If you need more order forms, Quicken will print them for you. 
Choose Order Supplies from the Activities Menu. 

Quicken checks-convenient and competitively priced 

Quicken checks save time and clerical work every month. And they’re 
easy to load in any printer, thanks to Quicken’s patented self-alignment 
system and Forms Saver. By the second or third session, you’ll be 
loading your printer quickly-even if you don’t find it easy to load your 
printer today. 

Bank-approved and universally compatible 

Quicken checks are approved by banks, savings and loans, credit unions, 
and brokers across the U.S. and Canada; you don’t need permission from 
your bank to use Quicken checks. They are accepted everywhere your 
checks are accepted now. We guarantee it, or we’ll refund your money. 
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Quicken checks are continuous form, so they fit all printers. This includes 
all letter quality printers, and all tractor-feed and friction-feed printers; 
they also work very well on laser printers. Only Quicken checks are 
designed to fit Quicken. 

Wide selection 

You have a full range of check choices: 

Multiple colors. 

Regular, voucher, or laser-printer checks. Voucher checks give you a 
check-sized voucher for invoice or payroll information. 

Free standard logos or your own custom logo (optional). 
One-part, two-part, or three-part checks. Two- and three-part checks 
give you carbonless copies of each check. 
Quantities from 250 to 50,000 or more. 

See the samples enclosed in the Quicken package. 

Of course, Quicken checks are custom printed with all the information 
included on your current checks. This includes your name, address, and 
any other information printed on your current checks. They have all 
required bank information including the bank numbers, name, and branch. 

Low prices 

We’ve worked hard to make our prices low. 

So don’t waste another day writing checks by hand. Order today and 
Quicken checks will be in your hands within three weeks. 

How to order checks 

Use the order form enclosed in the Quicken package. If you need more 
order forms, Quicken will print them for you. Select Order Supplies from 
the Activities Menu. 

Call if you need any information about checks. Call 800-624-8742 (in 
California call 800-468-8481 ). 
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Window Envelopes and Forms SaversTM make 
paying bills even more convenient 

Quicken Window Envelopes 

Window envelopes save even more time by eliminating addressing of 
envelopes. All you do is sign the check, drop it in the envelope, and you’re 
done. 

Each envelope has two windows. One shows the mailing address; the 
other shows the return address printed on the check. 

Quicken window envelopes are the only ones designed to be 100% com- 
patible with Quicken checks. They show the addresses clearly but hide the 
rest of the check. 

Quicken Forms Savers 
Some printers cannot print on the first check loaded in the printer. Simply 
attach a Forms Saver to your checks before loading them into your printer, 
and you’ll never waste another check. The Forms Saver safely guides the 
checks through, enabling the printer to print on the first check and elimi- 
nating wasted checks. Each Forms Saver can be reused up to 50 times. 
Forms Savers work with any other form or plain paper, too. 

How to order Window Envelopes and Forms Savers 

For fastest service, call today. Call 800-624-8742 (in California call 800-468- 
8481). Or use the order form enclosed in the Quicken package. If you need 
more order forms, Quicken will print them for you. Choose Order 
Supplies from the Activities Menu. 
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categorizing transactions, 8-61 

changing @Category names 
and descriptions, 8-11 

deleting, 8-10 
home @Categories, 15-3/15-4 
overview of, 8-2/8-3 
recalling, 8-6/8-7 
requiring @Categories in all 

transactions, 8-12, 17-4 
setting up, 8-3/84 
typing an @Category into the 

Memo field, 8-8 
typical list, 15-3/15-4 

deleting @Categories from, 

printing, 8-12 

15-6, 17-3/17-4 

categories, 8-9/8-10 

8-8 

@Category List 

8-10 

@Category Reports, 11 -121 11-17, 
15-6/15-7 

A 
Accelerator keys, 2-3,12-4 
Account, defined, 2-1 
Account activities, 13-1 /13-9 
Accounts payable 

postdating checks, 16-2/16-3 
reports, 16-3/16-6 
using postdating for, 10-5 

Accounts payable reports 
accounts payable by supplier, 

accounts payable by week, 16-4 
cash requirements by day, 16-3 

Customer Payment History, 

16-5 / 16-6 

Accounts receivable 

16-1 3/ 16-1 4 

entering new invoices, 16-81 

entering paid invoices, 16-10 

overdue invoices, 16-1 1 
receivables aged by week, 

receivables by customers, 

16-9 

Accounts receivable reports 

16-1 1 / 16-12 

16-12/16-13 
Asset and liability accounting, 

Automatic teller machine (ATM) 
transactions, 5-1,5-3 

17-1 31 17-1 5 

Backing up a bank account, 13-51 

Balance, changing, 5-12/5-13 
Bank accounts 

backing up, 13-5/13-6 
changing where Quicken looks 

for data, 13-3/13-5 
copying, 13-71 13-8 
deleting, 13-8/13-9 
renaming, 13-9 
restoring, 13-7 
Select Bank Account list, 13-3 
selecting, 13-21 13-3 
setting up, 2-1/2-3, 13-1/13-2 

Billminder'", 1-4,7-2/7-3, 10-31 

Bookkeeping 

13-6 

10-4 

cash 17-1/17-7 
departmental, 17-11 /17-12 

assigning transactions to 
@Categories, 15-5/15-6 

cash management, 15-10 
creating @Category Reports, 

Budgeting 

15-6/15-7 
creating Budget Reports, 15-8/ 

15-9 

establishing budget categories, 
15-3 

Budget Reports, 15-8/15-9 
adding or changing budget 

amounts, 11-22/11-23 
Household Budget Report, 

how to create, 11-19/11-22 

accounts payable, 16-2/16-6 
asset and liability accounting, 

bookkeeping, petty cash, and 
payroll, 17-1 /17-22 

business budgeting, 17-13 
forecasting cash flow and cash 

forecasting cash requirements, 

IRS Form 1099,17-12 
payables, receivables, and cash 

payroll, 17-151 17-21 
petty cash, 17-13 
reporting by job, property, 

11-18 

Business uses of Quicken 

17-1 31 17-15 

position, 16-151 16-19 

16-71 16-8 

flow, 16-1/16-19 

client, or project, 17-8/17-11 

C 
Cash, accounting for, 15-2/15-3 
Cash bookkeeping, 17-1 /17-7 

assigning transactions to 
@Categories, 17-3/17-4 

establishing a chart of ac- 
counts, 17-2/ 17-3 

Income and Expenses by Cate- 
gory Report, 17-5 

Transactions by Income and 
Expense Report, 17-6/17-7 

Cash flow forecasting, 16-15 
Cash flow reports 

cash flow by week, 16-16/16-18 
cash position by day, 16-16 
sources and uses of cash, 16-19 

Quicken User Manual index-1 



Chapter 1. Getting Started 

Cash management, 15-10 
Cash requirements, forecasting, 

Categorizing transactions, 8-6/84 
Changing a drive or directory, 

Changing settings, 14-1 /14-13 
changing Other Settings, 

DeskMate settings, 14-2/14-6 
Quicken Page Setup, 14-6/ 

16-7/16-8 

13-4 

14-11/14-13 

14-11 
Chart of accounts 

Check formats, 4-3 
Checking account fees and inter- 

est, 5-1,5-3 
Check Register 

establishing, 17-2/17-3 

adding postdated transactions 

as record of all transactions, 5-1 
changing the balance, 5-12/ 

deleting checks, 3-9 
displaying, 5-2,5-3 
moving around, 3-8,5-2/5-3 
organization of transactions, 

printing, 5-13 /5-14 
reviewing, 3-7/3-8,5-7/5-11 
revising, 5-11 /5-12 
typing deposits into, 5-5/5-6 
typing payments into, 5-6/5-7 
using, 5-1 /5-15 

adding memos, 3-5 
deleting, 3-8/3-9 
filling out, 3-3/3-5 
formats, 4-3 
handwritten, 5-1,5-3,5-7 
incorrectly printed, 4-9 
ordering, 4-1,4-3/4-4 
positioning in printer, 4-6/44 
postdated, 4-9 
printing, 4-4/4-5’4-8/4-9 
printing additional message 

on, 3-5 
printing problems, 4-10/4-11 
recording, 3-6 
reviewing and changing, 3-6/ 

sample, 4-6/4-7 
writing checks, 3-1 /3-10 
See also Quicken checks 

to, 5-3/5-7’10-5 

5-1 3 

5-4/5-5 

Checks 

3-8 

Click, defined, 1-6 

Combination chart of accounts 

Copying bank accounts, 13-7/13-8 
Correcting mistakes, 3-5/3-6 
Credit cards, 15-2 
Customer Payment History, 

codes, 17-12 

16-1 3/  16-1 4 

D 
Date, how to change, 3-3 
Departmental bookkeeping, 

Deposits, entering into Check Reg- 
ister, 5-1,5-3,5-5/5-6, 

DeskMa te 
changing settings, 14-1, 14-21 

installing Quicken from the 

mouse terms, 1-6 
Quicken key operations and 

terms, 1-6/1-9 
what it is, 1-3 

Double-click, 1-6 
Drag, defined, 1-6 

1 7-1 1 / 1 7-1 2 

14-6 

DeskMate Desktop, 1-3/1-5 

E 
Electronic transfers, 5-1 
Employee business expenses/ 

Form 2106,15-12 
Exact matches, 11-10/ 11-1 1 
Exiting Quicken, 1-10 

F 
Find feature, 5-8/5-10,5-11 
Forecasting cash flow and cash po- 

cash flow by week, 16-16/16-18 
cash flow reports, 16-16 
cash position by day, 16-16 
sources and uses of cash, 16-19 

Forecasting cash requirements, 

Form 1040,15-11 
Form 1099,17-12 
Form 2106,15-12 

sition, 16-1 5/ 16-1 9 

16-71 16-8 

G 
Glossary, D-1 /D-6 
Go to Date feature, 5-10/5-11 

H 
Handwritten checks, 5-1,5-3,5-7 
Hard disk information, C-1 
Help key, 1-12 
Home business/Schedule C, 15-12 
Home uses of Quicken, 15-1/15-13 

budgeting, 15-3 / 15-1 0 
cash management, 15-10 
cash, 15-2/15-3 
credit cards, 15-2 
employee business expenses/ 

home business/Schedule C, 

personal income taxes/Form 

rental property/Schedule E, 

tracking assets and liabilities, 

Household Budget Report, 11-18 

Form 2106,15-12 

15-12 

1040,15-11 

15-12 

15-13 

I 
Income taxes. See Personal income 

taxes/Form 1040 
Interest-bearing checking ac- 

counts, maximizing inter- 
est, 15-10 

K 
Key word matches, 11-10/11-11 

L 
Lotus 81-2-3-8,15-1, 16-1 

M 
Memorized transactions 

changing, 6-8/6-9 
deleting, 6-9 
entering receivables, 16-9 
memorizing checks at the 

recalling, 6-5,6-6/6-8 
transaction types, 6-6/6-8 

Memorized Transactions List 
assigning a transaction to more 

than one group, 7-5 
making changes in, 6-8 
printing, 6-10 
recalling a memorized transac- 

Write Checks screen, 6-7 

tion, 6-6,6-7 
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Memorizing transactions, 6-1 /6-10 

recurring transactions, 6 3 / 6 4 ,  
how to, 6-2 

6-5 
Memos 

adding, 305 
adding to transactions, 5-6 

Mistakes, correcting, 3-5/36 
Mouse settings, changing, 14-2/ 

Mouse terms, 1-6 
14-3 

Nonproportional fonts, use in 
wide reports, 11-4 

0 
Overwriting, 13-7 

Page Setup 
entering control codes, 14-9 
printing width, 14-10/14-11 
to create, 14-7/14-9 

Payments, typing in Check Regis- 
ter, 5-6/5-7 

Payroll 
@Categories, 17-15/17-16 
Federal tax forms, 17-18/17-21 
printing payroll checks, 17-16/ 

Personal income taxes/Form 1040, 

Personalized Quicken checks, 4-3 
Point, defined, 1-6 
Positioning checks in printer, 4-6/ 

Postdated checks, 4-9 

17-17 

15-11 

4-8 

printing, 10-2/10-3 
writing, 10-2 

Postdated transactions 
adding to the Check Register, 

10-5 
Postdating checks, 10-1 /10-6, 

16-2/ 16-3 
adding postdated transactions 

to the Check Register, 10-5 
reminders of transactions 

coming due, 10-3/10-4 
use for accounts payable, 10-5 

Print Checks feature, 4-4/4-5 
Printer settings in Quicken, 14-4/ 

14-5 

Printer setup for printing checks, 

Printing 
4-6 

checks, 4-1 /4-11 
to a file, 5-14 
to a printer, 5-13 

Printing problems 
and solutions, 4-1 1 
stopping printer, 4-10 

Pull-down menus, 1-10/1-11,2-3/ 
2-5 

Q 
Quicken 

and the DeskMate environ- 

beginning to use, 2-1 /2-5 
business uses, 16-1/16-19, 

ment, 1-6/1-9 

17-1 / 17-22 
capacity and memory usage, 

C-2/C-3 
changing Other Settings, 

changing settings, 14-1 /14-13 
changing where Quicken looks 

creating a Quicken menu, 1-4 
exiting, 1-10 
files, C-3 
formats, 4-3 
frequently used keys, 2-5 
home uses of, 15-1 /15-13 
installation from the DeskMate 

Desktop, 1-3/1-5 
installing Quicken alone, 1-5/ 

key operations and terms, 1-6/ 

Page Setup, 14-6/14-11 
pull-down menus, 1-10/1-11, 

reminder system, 7-2/7-3 
reports, 11-1 /11-23 
use on a floppy system, C-3 

Quicken checks, 1-2,4-2/4-3 
Quicken Transfer Utility, 15-1, 

14-11/14-13 

for data, 13-3/13-5 

1-6 

1-9 

2-3/2-5 

16-1 

R 
Recalling memorized transactions, 

Reconciliation Register, 12-2, 12-5 
Reconciliation Report, how to 

6-6/64 

print, 12-6 

Reconciling your account, 12-1 / 

how to begin, 12-2/12-5 
how to end, 12-10 
if your account balances, 12-51 

if your account doesn’t bal- 

12-11 

12-6 

ance, 12-6/12-11 
Recording checks, 3-6 
Rental property/Schedule E, 15-12 
Reporting by job, property, client, 

prefixed @Categories, 17-81 

setting up for flexible report- 

or project 

17-11 

ing, 17-8 
Reports 

@Category Reports, 11-2 
Budget Reports, 11 -2 
Transaction Reports, 11-2 
wide reports, 11-2/11-4 

Restoring an account, 13-7 

S 
Sample checks, printing of, 4-6/ 

4-7 
Scroll bar, 1-9/1-10 
Scrolling keys, 5-8 
Selection box, 5-2 
Settings, changing. See Changing 

Split Transaction dialog box, 3-5 
Split transactions 

assigning transactions to 

categorizing items in, 8-8 
changing, 9-4/95 
credit card purchases, 15-2 
defined, 9-1 
deleting, 9-5 
entering receivables, 16-9 
how to split a transaction, 9-2/ 

reviewing, 9-4 
selecting Split Transaction 

use for extra memo room, 9-7 
using Split Transaction feature 

as adding machine, 9-3/9-4 
zero-amount transactions, 9-6/ 

9-7 

tions to, 8-9/8-10 

settings 

@Categories, 15-5,17-4 

9-3 

feature, 9-2/9-3 

Subcategories: assigning transac- 

Supplies, ordering, 4-3/4-4 
Symphony@, 15-1,16-1 
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T 
Tandy, 1-3 
Today Line, 10-5 
Transaction Groups 

changing, 7-7 
defined, 7-1 
deleting, 7-8/7-9 
executing, 7-6/7-7 
printing checks in, 7-7 
Quicken’s reminder system, 

setting up, 7-3/7-5 
use to reduce keystrokes, 16-8 

Transaction Reports 
budgeting, 15-10 
how to create, 11-6/11-10 

7-2 / 7-3 

Transactions, changing, 5-11 /5-12. 

Transfer Utility, 15-1,16-1 
See also Split transactions 

U 
Uncategorized transactions, 11-7 
Unprinted checks 

finding, 5-1 1 
reviewing, 3-7,343 

W 
Wide reports, 11-2/11-4 
Write Checks screen, 3-1 /3-2 

deleting checks, 3-9 
displayed, 3-2 
reviewing unprinted checks, 

3-7,3-8 
Writing checks, 3-1 /3-10 

Zero-amount transactions 
how to use, 9-6/9-7 
in reports, 11-7/11-10 

Index-4 Quicken User Manual 







As a Quicken owner, you're eligible 
for special offers f rom Intuit. You'll 
be using these four attached cou- 
pons as your proof of ownership of 
Quicken Version 2 / DeskMate'". 

When Intuit announces a special 
offer, just return the specified 
coupon. Each announcement will 
specify the exact coupon number 
(1, 2, 3, or 4) required. 

: I SPECIAL OFFER COUPON 
Quicken Version 2 / DeskMate'" 

Use this coupon to qualify for Intuit's 
special offer to Quicken owners. The offer 

coupon is requested to qualify. The speci- 
fied original coupon must be returned. A 
copy or facsimile is not acceptable. 

I 

1 
1 
I 
I announcement indicates which specific ' ' 
I 
L I I I I I I I I I I I I I I I I I I I I I  
e i i i i i i i i i i i i i i i i i i I I I  

If requested, please fill out your 
name, address and any other 
information on the 
coupon's reverse side. 

I 
I 
1 
1 
1 
I 
I 
I 
I 
1 
a 

SPECIAL OFFER COUPON 
Quicken Version 2 / DeskMate'" 

Use this coupon to qualify for Intuit's 
special offer to Quicken owners. The offer 
announcement indicates which specific 
coupon is requested to qualify. The speci- 
fied original coupon must be returned. A 
copy or facsimile is not acceptable. 

; I SPECIAL OFFER COUPON 
Quicken Version 2 / DeskMate'" 1 

1 
1 

1 
I 
I 
I 

m 
Use this coupon to qualify for Intuit's 
special offer to Quicken owners. The offer 
announcement indicates which specific 
coupon is requested to qualify. The speci- 
fied original coupon must be returned. A 
copy or facsimile is not acceptable. 

: I SPECIAL OFFER COUPON " 
1 
1 
1 
I 
I 
I 
I 
1 

Quicken Version 2 / DeskMate'" 

Use this coupon to qualify for Intuit's 
special offer to Quicken owners. The offer 
announcement indicates which specific 
coupon is requested to qualify. The speci- 
fied original coupon must be returned. A 
copy or facsimile is not acceptable. 

II 

I. 

I. 
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Quicken is truly easy-to-use software that automates routine financial tasks for homes and small businesses. 

Quicken is vastly faster than working by hand, and gives you financial organization you cannot get by hand. Compared to other financial software, Quicken i!: 
far faster and more flexible.With Quicken, you can forget financial hassles. 

Great Reviews 
“It’s more than good-it’s indispensable. Home and small business 
checking software used to be too expensive, too hard to use, and too rigid, 
and it took too long to use. 

Ken Landls, A+ Magazlne 
“Many (financial) products p 
onlv after a areat deal of labor. Quicken is a wonderful exceotion.. . .I can’t 

rsthe bills you pay, prints checks to pay them, and 
ur check register and balance automatically Quicken 

ill batch payments and deposits you regularly make together, and print 
checks for all of them in one step.Quicken even reminds you when 
you have bills to pay And Quicken rapidly reconciles your records to you1 
bank statement. 

changed all that:’ 

e than they deliver or deliver 

seem to sayenough good thingsabout this program: 

“Absolutely the best small accounting program madel’ 

Quicken for Business 

‘ 

Tsx Recontkeping 
Quicken automatically keeps track of your tax-related transactions. At 
tax time, Quicken gives you itemized reports by tax categoty so you can 
quickly complete Schedules A, B, C, & Eand Forms 1040,2l06,1099, 
940,94f,W-2 and W-3,and Canadiantaxfoms. 

Richard Katz, UCLA PC Users Newsletter 

Bob Schwabach, Universal Press Syndicate 

Finaneiai Reponin# 
Quicken will organize your checking, money market, and savings 
accounts, along with your cash and credit card accounts in no time. 
Detailed reports give you instant access to the information you need to 
stay on top of your finances: expense reports, profg and loss statements, 
a complete reconciliation report, and much more. Quicken’s flexible 
reporting abilican sori and subtotal by payee,expense category, or 
date so you can tailor each report to meet your needs. 

Budaeting 
Quicken tracks income and expenses,and creates budget reports auto- 
matically. Like all Quicken reports, budget reports can cover anytime 

Quicken has special features for businessesThe manual has separate 
chapters for business users covering: 

payables 
receivables 
cash flow forecasting 
payroll 
job, client, and property bookkeeping 
petty cash control 

Quicken is used by muntants,doctors, consultants, 
service firms, non-profit organizations, and many 0th 

Instantly finds any transaction by date,check number, amount, payee. 

Unlimited number of transactions (limited only by disk capacity) 
Dollar amounts to $9,999,999.99 
Prints regular checks and voucher checks (ideal for payroll) 
Automatic reconcihation feature pinpoints and fixes errors 
Automatic setup, data saving,and data backup 
Exports data and reports in ASCII. Also exports in Lotus” 1-2-37 

Automatically addresses checks for mailing in window envelopes 
Mensive help screens 
Illustrated, easy-bread manual shows dozens of sample uses 
Free customer support at (415) 322-0590 

Hardware Compatibiiity 
Tandy 1000 SL with 384K RAM or IBM (PC,xT, AT, PS/2),Tandy, and 
compatible computers with 512K RAM, DOS 2.11 or higher, one or more 
3Mrr0r5%”floppydiskdriv~or hard diskWorkswi$all monitors 
(monochrome m 

or memo 

Symphony” format with optional Transfer Utility (see details inside) 

Hercules or compatible graphics card). 
I1 pr ional. 

innP vni ir 

Cat No 25-1.1141 
i FOR 

PC-Compatible 
now 

512K RAM or Tandy lOOOSL 
1 

Quality Soihvare Sold b Rad0 Shack 
A Divislon of Tandy Corp , d Worth. TX 76102 
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a m  New Users 
Ll LI Important Information 

DeskMate messages and what they mean 

installing Quicken from the DeskMate Desktop 

Information for Tandy 1OOOSL and 1000TL computers 

This supplement contains important information not contained in the 
Quicken User's Manual. Take a moment to glance it over before you 
begin using Quicken and DeskMate. In particular, the first section of 
this supplement describes several common DeskMate messages, with an 
explanation of what they mean and what to do about them. The next 
section gives more detailed instructions than the manual contains for 
installing Quicken from the DeskMate Desktop. And the last section 
contains information specific to Tandy lOOOSL and lOOOTL users. 

A reminder: Quicken comes on two 5 1/4-disks and one 3 1/2-inch disk. 
The 3 1/2-inch Quicken disk contains all the information for both 
Program Disk 1 and Program Disk 2 and should be used when prompted 
for either of those disks. 

DeskMate messages and what they mean 
Some of the messages you may see while running Quicken are not 
displayed by Quicken, but come from the DeskMate system itself. If 
you are an experienced DeskMate user, these messages may be familiar 
to you, but if you are new to DeskMate you will find this summary 
helpful. Most of these messages appear in a dialog box similar to the 
one shown in Figure 1. 

Messages 

"Could not f i n d  new application on floppy disk" 
This message can appear when you install Quicken from the k k M a t e  
Desktop. Follow the instructions on "Installing Quicken from the 
DeskMate Desktop" in the next section if you get this message. 

"Unable to locate f i l e  DMSETUP.ACC" 
This file is the DeskMate setup program. It is located on one of your 
DeskMate disks, or, if you don't have DeskMate, a copy of the file is on 
Quicken Program Disk 2. Insert Quicken Program Disk 2 and press 
Enter. 



Unable to locate file D M S E T U P X C  
Press Enter to search entire systen, 
or Esc to cancel systen search, 

d ....................... 

Figure 1. Typical DeskMate message. 

"Unable to locate file DESKTOP.PDM" 
This file is the program that displays the DeskMate Desktop. Insert the 
disk you started DeskMate with (labeled "DeskMate--Desk.exe, Video 
Drivers") and press Enter. 

"Unable to locate file DMCSR.CFG" 
This file contains DeskMate configuration information, such as your 
mouse and printer settings, and is located on the disk you started 
DeskMate with. Insert that disk and press Enter. If you do not have 
DeskMate, insert your Quicken Working Disk 1 and press Enter. 

"Unable to locate file Q.PDM" 
This file is the Quicken program file. Insert Quicken Program Disk 1 
in drive A and press Enter. If you have installed Quicken onto your 
hard disk and get this message, it is because Quicken is not in the 
current directory when you try to start Quicken. Press Esc twice to 
return to the DeskMate Desktop. Then change the current directory to 
where Quicken is by choosing Change from the Directory Menu. 
Then restart Quicken as before. 

"DeskMate product already running" 
This message appears if you try to start Quicken from the DeskMate 
Desktop with Quicken Program Disk 2 in the drive. If you have already 
installed Quicken, insert your Quicken Working Disk 1 in drive A and 
then restart Quicken. If you have not yet installed Quicken, follow the 
instructions on "Installing Quicken from the DeskMate Desktop" in the 
next section. (Even if you don't have a hard disk you need to install 
Quicken.) 



Wnable t o  l o c a t e  f i l e  DMVDQ.RES" 
This message appears only after exiting Quicken improperly, such as if 
the power fails while you are in Quicken. If you get this message, press 
Esc twice to exit from DeskMate. Insert Quicken Program Disk 2 and 
at the DOS prompt (usually, A> or C>), type A:QVID AUTO and 
press the Enter key. Now start DeskMate as usual. 

Vnab le  t o  l o c a t e  f i l e  DMVDT16.RRS" 
This message is displayed on Tandy lOOOSL or 1OOOTL computers if 
you attempt to run Quicken from the DOS prompt (usually, A> or C>) 
instead of from the DeskMate Desktop. See the section on "Information 
for Tandy lOOOSL and looOTL computers" at the end of this supplement 
for more information. 

Installing Quicken from the DeskMate Desktop 
If you have trouble installing Quicken from the DeskMate Desk 
following the directions on pages 1-3 and 1-4 of the Quicken Use!% 
Manual, here are more detailed instructions. It is important that you 
follow these steps precisely. 

NOTE: Follow these instructions only if you have DeskMate software 
from Tandy. If you don't, follow the instructions on page 1-5 of the 
Quicken User's Manual. 

1. If there are Quicken disks in any of your floppy disk drives, remove 
them. Then restart your computer by turning the power off and back 
on again. 

2. Start DeskMate as usual (on some models of Tandy computen 
restarting your computer also restarts DeskMate automatically). 

3. At the DeskMate Desktop, select Change from the Directory 
Menu. The Change Directory dialog box appears. Type A:\ in 
the Path field and press Enter. [If the message "Critical Error'' 
appears, it's because you did not type a backslash 0) after the A:. 
hess Esc to cancel the message and then repeat this step.] 

4. After the drive access light on drive A goes off, insert the original 
Quicken Program Disk 1 in drive A. Select Install from the 
Desktop Menu. 

5. If the message "Could not find new application on floppy disk" 
appears, press Enter. Then select Run from the File Menu. The 
Run File dialog box appears. Type INSTALL in the Program 
field and press Enter. Follow the directions that appear on the 
screen for installing Quicken onto floppies or onto a hard disk. 



OR 

If the Display Menu dialog box appears, select a size and shape for 
the Quicken display menu and press Enter. You'll then select a 
location for the menu on the Desktop using the arrow keys or your 
mouse. When the menu is positioned where you want it, press 
Enter. (If your Desktop has no room for another display menu, 
Install will skip this step. If you later have room and want to add a 
Quicken display menu, select Display from the Desktop Menu. 
You don't need to install Quicken again.) 

6. In a few seconds Quicken's Install program will begin. Follow the 
on-screen instructions to install Quicken onto floppy disks or onto 
your hard disk. Note that if you cancel Install before completing, 
you will need to restart Install beginning with step 1 above. 

7. If you have installed Quicken onto your hard disk in a directory other 
than the directory DeskMate is in, you should set Quicken's start-up 
directory. To set Quicken's start-up directory: 

0 At the Desktop, select Redefine from the Desktop Menu. The 
Redefine Menu list box will appear. 

0 Select QUICKEN and press Enter. The Redefine Menu dialog 
box will appear. 

0 In the Start-up directory field type the directory in which 
Quicken was installed. Then press Enter. 

Information for Tandy lOOOSL and lOOOTL 
computers 
Tandy 1OOOSL and Tandy lOOOTL computers come with DeskMate and 
the DeskMate Desktop built in. To install or run Quicken on these 
computers you must be at the DedcMate Desktop which you can do by 
either restarting your computer by turning the power off and back on 
again, or, at the DOS prompt (usually A> or C>), by typing C:DESK 
and pressing Enter. (See the previous section on "Installing Quicken 
from the DeskMate Desktop.") 

Special note to Tandy 1 OOOSL users: Depending on your computer's 
memory and video configuration, the Run option on Quicken's File 
Menu may or may not be supported. If Run is not supported, it will 
always be grayed out when you display Quicken's File Menu. 
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TIPS & TECHNIQUES 

To get started please read Chapter 1. If you are installing Quicken from the DeskMate Desktop, 
follow the detailed step-by-step instructions on pages 1-3 through 1-5. If you are installing 
Quicken alone from Dos, instructions can be found on page 1-5. 

On-screen pushbuttons, like the OK or Cancel pushbuttons, can be "pressed by clicking on the 
pushbutton with the mouse. Or, if you are a keyboard user,(TUI) to move the cursor to the push- 
button and press the @. 

@ is the Help key. Whenever you have a question, press @ for on-screen tips and instructions. 

Pulldown menus, like the File Menu, can be opened with the mouse by clicking on the menu 
button. Once the menu is opened, continue to hold down the mouse button and drag the pointer to 
the menu option you wish to use. If you are using the keyboard, press the function key to open the 
menu, like the @ for the File Menu. Once the menu is open, use Q and @ to highlight the menu 
option you wish to use and then press I.....). For more information, see chapters 1 and 2. 

Use the Check Register to add transactions not involving printed checks to your Quicken account, 
such as ATM withdrawals, deposits, and checks written by hand. For more information on the 
Check Register, see Chapter 5. 

Move rapidly through the Check Register by pressing (CTRL) + (Po, (CTRL) + @ ,@, or @. 
You can also click on the scroll bar or drag the elevator to quickly get to the location you want to in 
the Check Register. For more information on the Check Register, see Chapter 5. 

Select a different bank account to use by choosing Open from the File Menu. Quicken will 
display the Select Bank Account to Open dialog box. Highlight the name of the account you want 
to select by clicking on it with the mouse or by using Q and Q and then pressing I.....). For more 
information on accounts, see Chapter 13. 

Select a different data disk, directory, or drive by choosing Open from the File Menu. Quicken 
will display the Select Bank Account to Open dialog box (just like selecting a different bank 
account). Use Q and @ or click with the mouse to highlight the name of the drive or directory 
you wish to use and press I.....) . If the account you want to use is not listed, select [A:], [B:], or [..I 
to have Quicken search a different drive or directory. Now select the desired bank account, as 
described above. For more information on changing disks or directories, see Chapter 13. 

Recurring transactions (like rent and car payments), can be memorized and recalled to save you 
time. Type the transaction at the Write Checks screen or in the Check Register, just as you would 
any transaction. Once the transaction is filled out, choose Memorize Transaction from the Quick 
Entry Menu, or press CCTRL) + Q to memorize the transaction. The next time you pay the bill or 
enter the deposit, type the first few letters of the payee and choose Recall Transaction from the 
Quick Entry Menu, or press (CTRL) + a. Quicken will display its Memorized Transactions List, 
with the highlight bar on the transaction that starts with the letters you typed. If you are not at the 
transaction you want, use Q and 
tion you want to use. Press (EHTER) and the transaction will automatically be entered for you. For 
more information on memorized transactions, see Chapter 6. 

or click with the mouse to highlight the name of the transac- 

@Categories are designed to make reporting easier. To categorize income and expenses, type an @ 
sign right before any category name you want in the Memo field, for example, @utilities or @1001. 
For more information on @Categories, see Chapter 8. 



Accelerator keys give you quick access to many menu commands and pushbuttons. An accelera- 
tor key is typically a (CTRL) or (...)key combination. To use accelerator keys, hold down (CTRL) or a while you press the other key indicated. For example, pressing (CTRL) + Q will get you to the 
Write Checks screen from the Check Register or Reports screens without having to pulldown the 
Activities Menu. 

Changing date or check numbers is easy; place the cursor anywhere in the Date field or in the 
Num column and press Q or 
chapters 3 and 5. 

to increase or decrease the numbers. For more information, see 

Save time typing an address by typing a quote (’ or ’9 in the first address line of a check. Quicken 
will copy the payee to the top line of the address. For more information on writing checks, see 
Chapter 3. 

Reviewing checks that have been written, but not yet printed is easy. At the Write Checks screen, 
click on the scroll bar with the mouse to flip through the checks. Or, press (pp.p) or (....) to move 
back or forward one check at a time. Press (CTRL) + (END) to go back to the blank check. You can 
change or delete any of the checks while you review them. For more information on checks, see 
Chapter 3. 

Reprinting a check (even after you’ve told Quicken it printed correctly) can be done by locating 
the transaction in the Check Register and changing the check number in the Num column to *****. 
Quicken recognizes any transaction in the Check Register with ***** in the Num column as a check 
waiting to be printed. For more information on printing checks, see Chapter 4. 

Finding items in the Check Register can be done by choosing Find from the Search Menu, or by 
pressing (CTRL) + Q. For more information on the Find feature, see Chapter 5. 

Limiting reports to specific type of transactions can be done at the Create Report dialog box. For 
example, to create a report based only on transactions with the word “tax” in the Memo field, type 
..tax.. in the memo matches field of the Create Report dialog box. For a report listing all items 
which don‘t have @Categories, type -..@.. in the memo matches field of the Create Report dialog 
box. For more information on Reports, see Chapter 11. 

Post-dated checks can be individually selected for printing. Go to the Check Register and change 
the date of the post-dated check you want to print to today’s date. Now the check is ready to print. 
For more information on post-dated checks, see Chapter 10. 

Additional memo information can be added to your checks by choosing Split Transaction from 
the Edit Menu, or by pressing (CTRL) + @. Once the split has been opened, type your comments in 
the Memo column. When you are done, press the on-screen OK pushbutton. For more informa- 
tion on splitting transactions, see Chapter 9. 

The BillmindeP can be changed if Quicken is reminding you too early or too late about upcom- 
ing bills to pay. Choose Other Settings from the File Menu. Quicken will display the Other 
Settings dialog box. For more information on The Billminder, see Chapter 10. 
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$19.95 
Have a paper financial report you'd like Quicken 
to update for you every month? Ever want a 
report that Quicken can't give you? Want to 
combine data from several Quicken bank ac- 
counts? Want to analyze your finances using 
Lotus? 

Now do all of these with the Quicken Transfer 
Utility. The Utility transfers data from Qu'cken's 

consolidates data from different Quicken 
accounts into a single Lotus spreadsheet, too. 

Check egister to s readsheets in Lotus Q 
1-2-3 8 '  , Symphony 5 , or compatible programs. It 

Custom Reports 
The Transfer Utility uses new technology to 
produce totally customized reports. It actually 
learns your spreadsheets to produce custom 
reports in seconds without typing. 

That's right. You set up the report format you 
want in a Lotus or compatible spreadsheet. The 
Transfer Utility then reads your spreadsheet to 
learn which cells you want filled in and with 
what data. It then retrieves the needed data from 
Quicken and fi l ls in the right cells on your 
spreadsheet. All in 5 to 10 seconds, without 
data entry. 

Now you can produce custom expense reports, 
Profit 8, Loss statements, job and client costing, 
custom budgets with subcategories, and much 
more. You tailor the layout to your needs. 

You have total control over the report. You 
select which @Catgories, which payees, which 
memos, and which dates are displayed. You 
select exactly where each is displayed. Use 
logical OR to combine different kinds of transac- 
tions ("display here any utilities, phone, or repair 
expenses"). Use logical AND to show intersec- 
tions ("display here only expenses that are for 
subcontractors, for client 232, and for March"). 

The Transfer Utility also exports Quicken Check 
Register data directly into 1-2-3 and Symphony 
spreadsheets. Transactions appear one per line 
in standard Lotus data base format. 

The Utility wi l l  also produce a "spread" report, 
like one-write systems. It shows each transac- 
tion and how it spreads into each income/ 
expense category Each transaction appears in 
its own row and each income/expense category 
appears in its own column. 

Export tu m s  

-~ 

In just 5 to 10 seconds your financial records are 
ready for Lotus's powerful sorting, reporting, and 
analysis. 

Consolidating Accounts 
The Utility wil l also combine data from any 
number of Quicken bank accounts into one 
Lotus spreadsheet. Great for consolidating your 
finances into one report. 

Memory Resident Option 
The Transfer tility can be "memory resident," 

is included free. 

In memory resident mode, the Transfer Utility 
waits in the background out of the way. Then 
when you need it, just push one "hot key" and 
zap, it's ready to use So you can transfer 
without leaving or reloading Lotus and without 
waiting. 

Only $19.95 

Try It Free For 30 Days 
If you're not completely satisfied, return it for a 
full, no-questions-asked refund. 

Call today. Call 800-624-8742 (In CA call 800- 
468-8481). Or use the order form enclosed in 
the Quicken package If you need more order 
forms, Quicken wil l print them for you. Select 
Order Supplies from the Activities menu in 
Write Checks. 

like Sidekick 8" if you want. This special option 

Compatibility 
Requires Lotus 1-2-3 release 1A or higher, Sym- 
phony release 1.0 or higher, or compatible 
spreadsheet program such as SuperCalc4 or VP 
Planner. Runs on any computer that runs these 
soreadsheets. 



NOW, EASE TAX PREPARATION HASSLES WITH 
QUICKEN'S LINK TO LEADING TAX SOFTWARE 

For 1989 (tax year 1988), both J.K. 
Lasser Your Income Tax'" and 
Turbolax@ link with Quickenm IBM 
Version 2.0 to make tax preparation 
easier and more accurate. These tax 
software programs transfer tax informa- 
tion from your Quicken records to the 
tax forms. 

You don't need anything extra to take 
advantage of this new link with 
Quicken. Just one of these leading tax 
software programs and Quicken IBM 
Version 2.0 contained in this package. 
Instructions on how to transfer data is 
included in the user's manual of the tax 
software products. 

With this link you'll have one of the 
easiest tax seasons ever. Both J.K. 
Lasser Your Income l a x  and 
Turbolax are high I y regarded, 
popular tax preparation software. 
They've proven their ability to make 
tax preparation easier, more organized, 
and less frustration. 

The link with Quicken means: 

You can quickly complete tax 
forms from your Quicken records. 
This link allows you to transfer tax 
related category totals from your 
Quicken records to tax forms. 

You can accurately complete tax 
forms from your Quicken records. 
This link assures that category 
totals are accurately transferred to 
tax forms with no chance of 
m is-typ i ng . 

This tax link is yet another way we 
continue to strive to end financial 
hassles for our users. 
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Save Even More Time With Intuit Supplies 

Dear Quicken User: 

Congratulations on your choice of Quicken, the worlds best selling financial software! 

Quicken is the perfect tool for saving time and effort on routine financial tasks. To take full 
advantage of Quicken’s time savings capability, you’ll want checks that work with Quicken and your 
computer. 

Having Quicken print checks saves you the time and drudgery of handwriting them plus gives your 
checks a professional image. After all, you wouldn’t use a word processor to edit a letter and then 
hand write it rather than print it out, would you? 

If you’re wondering if it’s “okay” to order your checks from someone other than your bank, the 
answer is definitely yes! You may order your checks anywhere you like. Intuit checks meet or 
exceed banking standards, are pre-approved for all American and Canadian banks, and are printed 
by a leading computer check printer that banks also use. 

By ordering through Intuit you always get checks that work perfectly with Quicken. Our checks w!l 
work with YQLC~ printer and will be accepted by your bank (see our 3-Point Guarantee below). 

We recognize how important your order for checks is. We triple check all orders for accuracy, 
provide fast, no hassle service, and guarantee satisfaction. 

Order your checks today so you can take full advantage of Quicken. 

Sincerely, 

v for Intuit 

INTUIT’S 3-POINT GUARP ““5 
We guarantee that: 
1. Your bank will accept your Quicken checks. 
2. Quicken checks will work with your printer. 
3. You must be satisfied with your supplies order. 

If any of the above conditions are not met, please call us right away. 
We will replace your order, or refund your money, at your option. 
Call the appropriate number below. 

Check Order Questions 1-800-624-8742 
Printer Questions and Technical Support 1-41 5-322-0590 
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Now Laser Checks come in two styles! 
Choose either new payrollivoucher checks o 

standard checks. Supplied on flat 8-112" by 11" 
sheets to fit your printer's paper tray. (1) New 
8-1 12" by 1 1 " PayrollNoucher Checks In addition 
to PayrolliVoucher stub, bottom stub provides a 
record of each check. (2) Regular 3-112" by 
8-112" Business Checks. 1 hree perforated 
checks per sheet. For HP(''LaserJet Series II 



Quicken Quickchecks! 
Free Express Shipping of Your Checks 
Order our Quickchecks Kit, and we'll include free express 
shipping of our checks. Checks are rushed to you so you can 
stop handwriting checks fast. Plus you'll get 500 window en- 
velopes that will eliminate the need for addressing. 
It includes our most popular items: 500 1 -part blue checks and 
500 envelopes. You can choose either standard ($92.90) or 
wallet size ($83.90). 
See inside order form on how to order our QuicKhecks Kif. 

5 EASY STEPS TO ORDER CHECKS 
Please read this before filling out the Order Form. If you have additional questions, call 

1-800-624-8742 

that we know which style, quantrty and color 

/CHECKORDERso)(LY I 

Indhted, 1001 will be used. 



For Check or Deposit Slips Orders: READ THIS FIRST mwr@ 
-: For each check order, enclose an actual check from the checking account with VOID written on it (deposit slips are not included with check 
Orders). : For each deposit slip order, enclose an actual deposit slip from the checking account (a check on the account cannot be 
s u b s t i t u t d v p ) .  We will print your checks or deposit slips with the same name, address, and bank information as on the checkor deposit slip 
you provide. You may make changes to this information by CLEARLY writing in changes. If no changes are made, we will print EXACTLY the same name, 
address, and bankinformation as submitted. If you do not have the needed checkor deposit slip, your bankwill gladly provide you with a"MICR Specification 
Sheet" which can be used to print your order. I 

ORDERED BY - 
Name Quickchecks Offer 

Check or Money Order enclosed (Payable to Intuit) 

Credit Card Number 

Name on Credit Card 

YES! I would like to make my 
bill paying faster and easier. 

The Quicken Quickchecks Kit includes 500 1 -part blue 
checks and 500 envelopes. Choose from either the 
standard size or the wallet size checks. 
To order Quickchecks simply complete sections 1 & 2 on 
the order form then fill in the amount on section 3 for the 
Quickchecks Kit you select. Be sure to include a sample 
check for each kit ordered. Allow 2 weeks for delivery. 
Checks and envelopes are sent separately. 

No substitutions. 

Catalog prices good through 11/30/90 

no stamng number i&ted, 1001 will be used. 

EXPRESS SHIPPING h HANDUNG CHARGES Subtotal 

CustomLogo Charge ($%each) 
s\ or Prw&..Md 

$ 20.00-$ 4999 $ 400  
$ 50.00-$10599 t 9 0 0  

$160.00 - $21999 
$220.00 - 5299.99 $30.00 

$106.00 - $159.99 $ 13.00 
$17.00 Discount (if applicable) 

$300 00 OT more call for pnce 

'Exp~ess shipping (UPS Blue) required to Hawaii and Puerto Rim Foreign customers call (41 5) 3220590 for shipping 
amount CANADIAN CUSTOMERS, please call (416) 449-1230 and ask for Customer SENICE Your c k k s  wdl be printed 
in Canada. 

Sales Tax (CA residents Only) 

7% for Sank Clara and Alameda munties, 6 5% for Cantra Costa, San Mateo, San 
Francisco. Santa Cruz. and Los Angeles wunth?s, 6% elsewhere in California 

I 

OPTIONAL EXPRESS SHIPPING & HANDLING 
(All prices include regular shipping) 

TAXES 

FAX your order form to us with credit card information and a sample check 
for each account (use "Detail" or "Fine" mode). Camera-ready artwOrkcan not 
be faxed. Order will be shipped UPS Ground unless Express Shipping is indicated. 
Intuit FAX number is: (415) 322-1597 

NEED CHECKS 
RIGHT AWAY? ORDER TOTAL 

STATIONERY AND RETURN ADDRESS STAMP PERSONALIZATION 

Address 

City ' State Zip - 
Phone Number**( ) 

"Phmn Nwb.n ml nub.  lrngmmd on enmksea un(an pu spamh$Irrlcp. omme 

STATIONERY AND RETURN ADDRESS STAMP PERSONALIZATION 

Name item : 1 1  

City State Zip - 



INTUIT LOGO SERVICES 
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We offer two options for printing your logo on your checks: 
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Standard Logos - Standard logos can be printed for FREE on your Quicken 
checks, If we have a standard logo that matches the one on the check you send 
in. If we have no close match, the checks will be printed without a logo. Simply 
check the "Standard" box on the Order Form (bank logos and background designs 
are not considered standard logos). 

Custom Logos - We will print your custom logo on your check for the one-time 
set-up fee of $35. Enclose Black 8, White CAMERA-READY artwork with your 
order. If touch-up, typesetting, or rearrangement is required, additional charges 
may be incurred. (If extra charges are necessary, we will call for approval before 
proceeding). Check the "Custom" box on the Order Form. Custom logo orders 
are not accepted by FAX. 

INFORMATION FOR CANADIAN QUICKEN USERS 

For checks printed in Canada, call 800-268-5779 (or call 416-752-6470). Ask for 
Quicken checks to get information on check prices and styles. 

Or you may order any item in this catalog directly from Intuit in the US. You will 
need to: . 

. 

. 

Pay in US. funds or by credit card. 
Choose delivery via Express Shipping 
(see Order Form for extra cost). 
Place postage on your reply envelope. 

You will be billed for customs and duties (about 22%) when your order is deliv- 
ered. 

checks sooner than this, here's how you can speed II~ your order: 
FAX your order to us. Select ExpressShipping. check and deposit 
(41 5-322-1 597) Use "De- This reducesshipping time orders cannot be taken o 
tail" or "Fine" mode. Avoid to two or three days ver- the telephone. We 
delay by including credit sus up to a week and a half an actual sample in 
card payment information for regular shipping. to assure correct s 

of the magnetic a and a sample check for 
each account (logo aflwork Have Questions? code at the bottom 
cannot be accepted by Call our toll-free number check or deposit sli 
FAX). Faxing your order (1 -800-624-8742). Sorry, 
saves mail time of three or 





Slashes time needed 
sheets on IBM PC's! 

Create any report 
spreadsheet and the 
automatically update 
seconds, it transfers your Quicken dat 
directly into Lotus .WKS or .WK 
generate analyses and reports. 
ends up In the right cells autom 
No typing! Requires 
1A or higher, Symphony'! or any compat- 
ible spreadsheet program such as 
QuattroTM, SuperCalc4: or VP Plann 

Select Transfer Utility version to 

ADDRESS STAMPS 
Give vow hand a heber! 

FORMS SAVERS 
Some tractor-feed printers 

can't print on the first check, so 
you always waste it. Reusable 
Forms Savers solve this problem 

No more wasted checks! 

Made of heavy, durable paper, 
each may be reused up to 50 
times. Available in sets of 5. 

item I No. Price 
Forms Savers (set of 5) 7897 $4 95 



money back, with no questions asked! Quicken 
checks are pre-approved by all financial 
institutions. They are printed to the exact 
specifications of the American and Canadian 
Banking Associations. You may use them with 
total confidence. 

A. Yes. Your check number is printed with 
magnetic ink at the bottom of your checks so 
that it can be read electronically by your bank. 
Without it, your bank may be unable to "stop 
payment" on a check or produce a complete 
monthly bank statement. Quicken's patented 

the frustration of missing check numbers. 

Quicken checks work with my 

A. 
Quicken checks are about the lowest priced in 
the industry, starting at under $30. It does cost 

Quicken checks are inexpensive. In fac 

would be a bargain at twice the price 

Q. How do I write checks away from Q. Are Quicken checks guar 
home? A. Absolutely! We guarantee 

next time you use Quicken, just enter these 
checks in your Quicken check register. Both 
Quicken and your bank can easily handle tw 
sets of checking numbers. Just order your 
Quicken checks with numbers considerably 
higher than the number range of your current 
checks. 

5-322-0590 (8:30 a.m. - 4:30 p.m. PST 

How do I speed up delivery of my 

der to us at 41 5-322-1 597 and 
And select "Express 
rder Form and save an 



IO. zw 
lue 976 270 $3795 $5395 $6995 $995" 

nveloDe 438 $1995 $2995 $4995 $8395 

'Requires IBM Quicken Version 3 or Macintosh 1.5 

Order Form. To request extra catalogs, or for additional information, call 1-800-62 
8742 (7:OO a.m. to 500 p.m. PST). 

If you need another Order Form, your Quicken program can print one for you immedi- 
ately. Here's how: 

IBWand DeskMateWuicken? Go to the Check Register and select the 
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